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Single Sign-on 4.8

Citrix Single sign-on provides password security and single sign-on access to Windows, Web,
and terminal emulator applications running in the Citrix environment as well as applications
running on the desktop. Users authenticate once and Single sign-on does the rest,
automatically logging on to password-protected information systems, enforcing password
policies, monitoring all password-related events, and even automating user tasks, including
password changes.

In This Section
Single Sign-on Installation and Upgrade Install or upgrade to Single sign-on 4.8.

Single Sign-on Administration Create and manage application definitions,
password policies, user configurations and
other Single sign-on actions.

Account Self-Service Deploy Account Self-Service without other
Single sign-on features.

Single sign-on Provisioning Software
Development Kit (SDK)

Create your own provisioning client for use
with Password Manager.

For issues fixed in Single sign-on 4.8, go to: http://support.citrix.com/article/CTX124164.

Can’t find what you’re looking for? If you’re looking for documentation for previously
released versions of this product, go to the Citrix Knowledge Center.

http://support.citrix.com/article/CTX124164
http://support.citrix.com
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Single Sign-on Installation and Upgrade

Single sign-on provides password security and single sign-on access to Windows, Web, and
terminal emulator applications running in the Citrix environment as well as applications
running on the desktop. Users authenticate once and Single sign-on does the rest,
automatically logging on to password-protected information systems, enforcing password
policies, monitoring all password-related events, and even automating user tasks, including
password changes.
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Introducing Citrix Single Sign-on

The following topics provide an overview for each Single sign-on component. The
requirements necessary for installing and running Single sign-on are identified. When
necessary, installation instructions are provided for required software.
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Identifying the Four Key Components of
Single Sign-on

The main components of Single sign-on are:

• The central store

• The Single sign-on component of the Delivery Services Console

• The Single sign-on plug-in

• The Single sign-on Service (optional)
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Managing User and Administrative Data
with the Central Store

The central store is a centralized repository used by Single sign-on to store and manage user
and administrative data. User data includes user credentials, security question answers,
and other user-focused data. Administrative data includes password policies, application
definitions, security questions, and other wider-ranging data. When a user signs on, Single
sign-on compares that user’s credentials to those stored in the central store. As the user
opens password-protected applications or Web pages, the appropriate credentials are
drawn from the central store.
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Managing the User Experience with the
Single Sign-on Component of the Delivery
Services Console

The Single sign-on component of the Delivery Services Console is the command center of
Single sign-on. From the console, you manage the users’ Single sign-on experience. Here,
you configure how Single sign-on works, which features are deployed, which security
measures are used, and other important password-related settings.

The component has four main items, or nodes, in the left pane. By selecting a node, tasks
specific to that node appear. These nodes are:

• User Configurations

These configurations allow you to tailor particular settings for your users based on their
geographic locations or business roles. The settings of the other three nodes are used to
create user configurations.

• Application Definitions

These definitions provide the information necessary for the Single sign-on plug-in to
supply user credentials to applications, and to detect error conditions if they occur.
You can use the application definition templates supplied with Single sign-on to speed
this process or create your own customized definitions for applications that cannot use
these templates. Additional templates are located at:

http://www.citrix.com/passwordmanager/gettingstarted

• Password Policies

Password policies control password length and the type and variety of characters used
in both user-defined and automatically-generated passwords. Password policies also
allow you to identify characters to exclude from use in passwords and whether or not
previous passwords can be reused. Creating password policies consistent with your
company’s security policies ensures that password security is appropriately managed by
Single sign-on.

• Identity Verification

The security questions you create provide an added layer of security to the Single
sign-on plug-in by protecting against user impersonation, unauthorized password
changes, and unauthorized account unlocking. Users who enroll and answer your
security questions can then verify their identity by providing the same answers when
challenged. Once verified, the users can perform self-service tasks to their account,
such as resetting their primary password or unlocking their user account. The security
questions can also be used for key recovery.

http://www.citrix.com/passwordmanager/gettingstarted
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Interacting with the User with the Single
Sign-on Plug-in

The Single sign-on plug-in submits the appropriate credentials to the applications running
on the user’s client device, enforces password policies, provides self-service functionality,
and enables users to manage their credentials with the Logon Manager.

In addition, the Single sign-on plug-in provides users with a wide array of features. Which
features the users actually receive is determined by the administrative settings you make in
their user configurations.

Single sign-on plug-in features include:

• Notification area icon

The Single sign-on notification area icon provides access to the Logon Manager and
other Single sign-on functionality such as security question registration, pausing, and
online help.

• Logon Manager

The Logon Manager provides a user interface where credentials can be created, viewed,
edited, and deleted. Users can also conduct security question registration and access
online help.

The File menu provides the user with much of the available access:

• New Logon allows users to add new Windows-, Web-, or terminal emulator-based
application credentials to Single sign-on.

• Copy provides a duplicate set of the selected credentials that the user can then
edit to create multiple sets of credentials for single applications.

• Delete removes users’ credentials for the selected application from Logon Manager.

• Properties gives the user access to properties associated with the credentials for
the specified application. From there, the user can change the password, user ID,
and other logon information.

Other commands you can give users access to include:

• Reveal Passwords from the View menu allows the user to display the passwords of
the applications listed in Logon Manager.

Important: Password policy settings for revealing passwords override this
command. If you do not want users to reveal the password for an application, be
sure to set the password policy to prevent this.

• Security Question Registration from the Tools menu gives the user the option to
restart the Security Question Registration wizard and provide new answers to the
security questions.



• Account Association from the Tools menu allows the user to create an association
between accounts on different domains. By using this feature, the user’s
credentials are synchronized, with password changes carried across domains.

• Automated new logon setup

Users can set up new logon credentials quickly using the New Logon wizard. Single
sign-on detects when an application or Web site requests logon information. If the
user’s credentials are not already stored in Single sign-on, the New Logon wizard
automatically appears, offering to store them.

• User mobility

Single sign-on supports remote and mobile users. By obtaining a license before
disconnecting, remote users can access their credentials when they are disconnected
from the corporate network. Mobile users can move from one computer to another and
multiple users can securely share one workstation.

Important: Locally installed instances of the Single sign-on plug-in do not require a
separate license for users who have access to hosted applications in a Citrix XenApp,
Platinum Edition environment.

Interacting with the User with the Single Sign-on Plug-in
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Providing Additional Features with the
Single Sign-on Service

The Single sign-on Service runs on a Web server that provides the foundation for optional
features included in this release. Install the Single sign-on Service if you plan to implement
at least one of the following modules:

• Self-Service, which allows users to reset their Windows passwords and unlock their
Windows accounts

• Data Integrity, which protects data from being compromised while in transit from the
central store to the Single sign-on plug-in

• Key Management, which provides users with the capability to recover their secondary
credentials when their primary password changes, either with automatic key recovery
or after answering security questions with question-based authentication

• Provisioning, which allows you to use the Single sign-on component of the Delivery
Services Console to add, remove, or update Single sign-on user data and credential
information

• Credential Synchronization, which synchronizes user credentials among domains using a
Web service

If you are not implementing the modules mentioned above, do not install the Single sign-on
Service.
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New Features in Single Sign-on 4.8

Web Application Compatibility
• Dynamic Web Page Support

Single sign-on now recognizes and responds when Web pages refresh through Javascript
or similar technology.

• Sendkeys Functionality for Web

Single sign-on now supports Sendkeys for Web applications without the use of the
Redirect to Windows application feature.

Administrator Experience
• The new Web page selector highlights Web pages in Windows Internet Explorer as you

select them to ensure you choose the desired Web page.

• Advanced Matching now features simplified, clearer Web elements, using highlights to
connect the selected elements with the contents of the Web page.

• The Define form action process for Web application definitions now resembles the
process used for Windows application definitions.

• New action editor is now similar to the one used with Windows application definitions.

• The Form Definition Wizard now can adjust as Web page refresh or reload, or you
navigate to a new page.

• The Data Integrity certificate expiration date can now be seen in the Single sign-on
Properties display in the Delivery Services Console, enabling you to create a new
certificate before the existing one expires.

• Single sign-on 4.8 contains a modified administrative data migration feature to cleanly
move data from one central store to another.

End User Experience
Users will no longer see a progress bar telling them the Single sign-on plug-in is starting.
That information is now contained in a tooltip visible when users roll over the Single sign-on
plug-in notification tray icon. As always, users can begin working while the plug-in is
starting.



Active Directory Central Store
• Single sign-on Active Directory central stores now support read-only domain controllers.

• When configured to use a specific writable domain controller, Single sign-on can read
from other closer domain controllers to avoid latency. Single sign-on continues to write
to the specified writable domain controller.

Security
In new deployments, Single sign-on 4.8 offers the Advanced Encryption Standard (AES) to
encrypt the central store as an alternative to Triple DES.

Other New Functionality
• Windows 7 and Windows Server 2008 R2 support.

• Single sign-on Service for V4.8 runs on 64-bit servers.

• SIngle sign-on plug-in can be installed and upgraded through Citrix Receiver.

New Features in Single Sign-on 4.8
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Licensing Requirements

Install the license server and add licenses before installing Single sign-on.

To run this release, you must have the license server (Version 11.5) that is available from
the Licensing folder in the installation media. If you are running an earlier version of the
license server, you must upgrade your license server to Version 11.5.
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Single Sign-on in Disconnected Mode

If you have users who work disconnected from the license server for extended periods of
time, such as mobile users with laptops, you must specify a disconnected mode period for
these users. The disconnected mode period is specified as part of the licensing settings in
the user configuration. The disconnected mode period specifies two aspects of licensing
behavior:

• The amount of time the user can be disconnected from the license server without
entering the licensing grace period. When the disconnected mode period expires, the
users employing the associated user configuration lapse into the 30 day licensing grace
period.

• The amount of time until a checked out license which is being used in disconnected
mode is returned to the pool of available licenses on the license server, regardless of
whether or not the product reconnects to the license server. If a license is checked out
and the disconnected mode associated with that license expires before the license is
checked in, the license server automatically checks the license back in so the license is
available again. For example, if a laptop running Single sign-on is lost and never
reconnects with your organization’s network, the license server automatically checks
the license back in at the end of the disconnected mode period.

When you set the disconnected mode, you are actually specifying how long you want to
wait until the license is returned to the pool of available licenses.

Consider setting long disconnected mode periods for users who do not connect to your
organization’s network regularly, such as sales personnel who work remotely. However,
keep in mind you cannot retrieve any checked out licenses, even from lost or broken
equipment, for the duration of this period.

Important: Locally installed instances of the Single sign-on plug-in do not require a
separate license for users who have access to hosted applications in a Citrix XenApp,
Platinum Edition environment.
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Managing a Mixed License Type
Environment

Depending on your Single sign-on environment and enterprise needs, you might have
purchased named user and concurrent user Single sign-on licenses. For example, you might
create user configurations based on the named user license model for mobile users who use
the Single sign-on plug-in through a desktop computer and laptop computer. You might also
create user configurations based on the concurrent user license model for Hot Desktop
users.

In some cases, all of your named user licenses might be in use, making Single sign-on
unavailable for some users. If so, you can use any available concurrent user licenses in your
user configuration to be consumed offline.

Important: Locally installed instances of the Single sign-on plug-in do not require a
separate license for users who have access to hosted applications in a Citrix XenApp,
Platinum Edition environment.
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To employ available concurrent user
licenses to be used offline

1. Create a user configuration.

2. On the Configure Licensing page of the User Configuration Wizard, select Concurrent
User Licensing (Enterprise and Platinum Edition Only).

3. Select Allow license to be consumed for offline use and set the amount of time the
license can be checked out from the license server.

4. Finish setting the user configuration.

For users associated with this user configuration, the license model is the same as a named
user license—it can be consumed by users who might occasionally work remotely and be
offline for periods of time. Concurrent user licenses are then consumed on a per-user basis.

Important: Locally installed instances of the Single sign-on plug-in do not require a
separate license for users who have access to hosted applications in a Citrix XenApp,
Platinum Edition environment.
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Single Sign-on System Software
Requirements

Computers in your Single sign-on environment require the following system software.

Software Component Required by Available from...

Microsoft Windows Installer
3.0 or later (automatically
included during Autorun
installation)

All • Support folder on the
Single sign-on installation
media

• http://www.microsoft.co
m

Microsoft .NET Framework
3.5 Service Pack
1(automatically included
during Autorun installation)

• Single sign-on Service

• Single sign-on
component of the
Delivery Services
Console

• Application Definition
Tool

Support folder on the Single
sign-on installation media

Microsoft Internet Explorer
Version 6.0, 7.0, or 8.0
(non-protected mode)

Users accessing Single
sign-on-enabled Web
applications

http://www.microsoft.com

ASP.NET Single sign-on Service http://www.asp.net/

• For 32-bit computers:
Microsoft Visual C++
2005 Redistributable
Package (x86) Service
Pack 1

• vc80_vcredist_x86.e
xe

• For 64-bit computers:
Microsoft Visual C++
2005 Redistributable
Package (x64)Service
Pack 1

• vc80_vcredist_x86.e
xe

• vc80_vcredist_x64.e
xe

Single sign-on console
component, service, or
plug-in—When installing
the console component,
service, or plug-in from a
command prompt onto a
Windows Vista, Windows
Server 2008, or Windows
Server 2008 R2 computer

Support folder on the Single
sign-on installation media

http://www.microsoft.com
http://www.microsoft.com
http://www.microsoft.com
http://www.asp.net/


• For 32-bit computers:
Microsoft Visual C++
2008 Redistributable
Package (x86) Service
Pack 1

• vc90_vcredist_x86.e
xe

• For 64-bit computers:
Microsoft Visual C++
2008 Redistributable
Package (x86) Service
Pack 1

• vc90_vcredist_x86.e
xe

• vc90_vcredist_x64.e
xe

Single sign-on console
component, service, or
plug-in—When installing
the console component,
service, or plug-in from a
command prompt onto a
Windows Vista, Windows
Server 2008, or Windows
Server 2008 R2 computer

Support folder on the Single
sign-on installation media

Microsoft Primary
Interoperability Assemblies

• vs90_piaredist.exe

Single sign-on console
component—When
installing the console
component from a
command prompt onto a
Windows Vista, Windows
Server 2008, or Windows
Server 2008 R2 computer

Support folder on the Single
sign-on installation media

Internet Explorer Enhanced
Security Configuration

Single sign-on
plug-in—Disable Internet
Explorer Enhanced
Security Configuration
when installing the
plug-in onto a Windows
Server 2003, Windows
Server 2008, or Windows
Server 2008 R2 computer.
If left enabled, the
plug-in does not respond
to Web application
definitions.
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Single Sign-on Software Requirements

Single sign-on
Component

Supported Environment or Microsoft Windows
Operating System

Hardware
Requirements

Central store • Active Directory

• NTFS File Share

30KB disk space
per user

Single sign-on
component of the
Delivery Services
Console

• Microsoft Windows 7—32-bit and 64-bit

• Microsoft Windows Vista (Business Edition,
Ultimate Edition, Enterprise
Edition)—32-bit and 64-bit

• Microsoft Windows XP Professional, Service
Pack 2—32-bit

• Microsoft Windows XP Professional x64
Edition—64-bit

• Microsoft Windows Server 2008 R2—64-bit

• Microsoft Windows Server 2008 (Standard
Edition, Enterprise Edition, Datacenter
Edition)—32-bit and 64-bit

• Microsoft Windows Server 2003 R2
(Standard Edition, Enterprise Edition,
Datacenter Edition)—32-bit and 64-bit

• Microsoft Windows Server 2003 with
Service Pack 2 (Standard Edition,
Enterprise Edition, Datacenter
Edition)—32-bit and 64-bit

• 64MB RAM

• 60MB disk
space



Plug-in • Microsoft Windows 7—32-bit and 64-bit

• Microsoft Windows Vista (Business Edition,
Ultimate Edition, Enterprise
Edition)—32-bit and 64-bit

• Microsoft Windows XP Professional, Service
Pack 2—32-bit

• Microsoft Windows XP Professional x64
Edition—64-bit

• Microsoft Windows XP Embedded

• Microsoft Windows Server 2008 R2—64-bit

• Microsoft Windows Server 2008 (Standard
Edition, Enterprise Edition, Datacenter
Edition)—32-bit and 64-bit

• Microsoft Windows Server 2003 R2
(Standard Edition, Enterprise Edition,
Datacenter Edition)—32-bit and 64-bit

• Microsoft Windows Server 2003 with
Service Pack 2 (Standard Edition,
Enterprise Edition, Datacenter
Edition)—32-bit and 64-bit

• 10MB RAM

• 25MB disk
space (if
optional
features are
not
installed)

• 35MB disk
space (if
optional
features are
installed)

Service • Microsoft Windows Server 2008 R2—64-bit

• Microsoft Windows Server 2008 (Standard
Edition, Enterprise Edition, Datacenter
Edition)—32-bit

• Microsoft Windows Server 2003 R2
(Standard Edition, Enterprise Edition,
Datacenter Edition)—32-bit

• Microsoft Windows Server 2003 with
Service Pack 2 (Standard Edition,
Enterprise Edition, Datacenter
Edition)—32-bit

• 128MB RAM

• 30MB disk
space

Application
Definition Tool

Same as plug-in Same as plug-in

Note: Single sign-on is not supported on Microsoft Windows XP Home Edition.

Hot Desktop is supported only on:

• Microsoft Windows XP Professional, Service Pack 2—32-bit

• Microsoft Windows XP Embedded

Hot Desktop is not supported on 64-bit operating systems or any server operating systems.

Single Sign-on Software Requirements
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Setting Security and Accounts Prior to
Installing Single Sign-on Service

Before you install the Single sign-on Service, ensure that the appropriate accounts and
components are available to support the service. Also, because the service uses secure
HTTP (HTTPS), the service requires a server authentication certificate for Secure Sockets
Layer (SSL) communication with the console and plug-in.

Obtaining and Installing a Server Authentication
Certificate

Before you install the Single sign-on Service, obtain a server authentication certificate for
SSL communication from a certificate authority (CA) or, if you have an existing public key
infrastructure (PKI), download your own certificate to the server running the service.

An SSL certificate is necessary to ensure secure communication from the service to the
console and plug-in, and to guarantee that the plug-in and console are communicating with
the correct service server.

• Because this certificate is used for SSL communication, the certificate common name
must match the service server’s fully qualified domain name (FQDN). Specify a
minimum key size of 1024.

• Install the certificate in your local computer certificate store and establish the
appropriate trust relationships for the Single sign-on component of the Delivery Services
Console and the plug-in.

• Install this certificate on the computers running the Single sign-on component of the
Delivery Services Console, the Single sign-on Service, and the plug-in.

• In a load balancing or clustered service environment, you can use one certificate for
multiple service servers if the common name of the SSL certificate uses a wildcard
(typically an asterisk character) in it. For example, you can use an SSL certificate with
a common name of server*.mycompanysname.com for an environment with servers
named server1.mycompanysname.com, server2.mycompanysname.com, and
server3.mycompanysname.com. You could also use an SSL certificate with a common
name of *.mycompanysname.com in this case, where the common name does not match
the server FQDN.

Important: If you obtain your certificate from an authority that is not trusted by default
(such as a certificate authority installed in your company), install the root authority
certificate to your local computer’s trusted root certificate store to establish the trust
relationship.

If users are experiencing SSL failures, it is most likely because the server certificate is not
trusted. Refer to the Microsoft Web site for instructions about extracting and deploying CA
root certificates.



The signing and validation certificates created during Single sign-on installation are not
related to the SSL certificate.

Accounts Required for Service Modules
The Single sign-on Service can require up to three system account types to read and write
data as it operates in your environment. The number and type of accounts required depend
on the service modules you use. The table shows the accounts required by each module of
the service. In cases where different modules require the same type of account, you can
use the same account for multiple modules or you can specify different customized
accounts for each module.

Module Accounts Required

Service Data Proxy Self-Service

Data Integrity Yes No No

Key Management Yes Yes No

Provisioning Yes Yes No

Self-Service Yes Yes Yes

Credential
Synchronization

Yes No No

Service Account Requirements
On the server running the Single sign-on Service, use the existing Network Service or Local
Service accounts

You cannot specify a local user account as the service account in this version of Single
sign-on. You can specify the built-in Local Service account.

If you choose to create a domain account as the service account, you must register a
service principal name for this domain account and the service computer in Active Directory
by using the setspn.exe utility. if using a domain user account, the account should be
assigned "Logon as services" rights. The computer running the service needs to be trusted
for delegation.

See the Microsoft Web site for more information about service principal names.

Data Proxy Account Requirements
On the server running the Single sign-on Service, create a domain administrator account
with the following settings, to be used for data proxy communication with the service.

The account requires read and write access to the central store. The account requirements
depend on the central store type you are implementing.

Central Store Type Account Description

Setting Security and Accounts Prior to Installing Single Sign-on Service
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NTFS Network Share The account:

• Requires read and write access to the central store.

• Is a member of the domain.

After you create the central store:

• Grant the account Full Control sharing permissions to
the CITRIXSYNC$ share.

• Grant the account Full Control permissions to the
CITRIXSYNC folder and its subfolders: CentralStoreRoot
folder and People folder

• Grant the account Full Control permissions to all file
objects within the CITRIXSYNC folder and its subfolders

• Ensure that the Authenticated Users group has the right
to create folders inside the People folder.

Active Directory The account:

• Requires read and write access to the central store.

• Is a member of the domain administrator group.

Self-Service Requirements
If you are using the Self-Service Password Reset or Self-Service Account Unlock features of
the Account Self-Service Module, use an account that is a member of the domain
administrators group.

Setting Security and Accounts Prior to Installing Single Sign-on Service
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Accounts Required to Install and Use
Single Sign-on

Installing and Using the Single Sign-on Service
The user installing the service and running the Service Configuration wizard must be a
member of the domain (a Domain User) and a member of the local Administrators group on
the service computer (add a domain user account to the local Administrators group).

Installing and Using the Single Sign-on Component of
the Delivery Services Console and the Application
Definition Tool

The user installing the console component, performing a discovery and configuration
operation, and using the console component must be a domain administrator and a member
of the local Administrators group on the console computer. This user account must have
read and write access to the central store. A non-administrator user account can be
assigned the right to manage the console component and its related functions through
Active Directory delegation or constrained delegation.

Installing and Using the Single Sign-on Plug-in
The user installing the plug-in must be a member of the domain (a domain user) and a
member of the local Administrators group on the user device.

The user running the plug-in must be a member of the domain (a domain user).
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Installing the Java Runtime Environment

Single sign-on supports the Java Runtime Environment (JRE), Versions 1.4.x, 5 (1.5.x), and 6
(1.6.x). Download the current supported version from the Sun Microsystems Web site
(http://java.sun.com).

If You Install or Upgrade the JRE after Installing the
Single Sign-on Components

If you install or upgrade the JRE after installing the Single sign-on component of the
Delivery Services Console, Application Definition Tool, or plug-in, associate the current JRE
with the Single sign-on component.

1. In the Control Panel, go to the Programs area and select the Single sign-on component.

2. Click Change.

3. In the setup dialog, select Repair.

Troubleshooting a Java-Related Error Message When
Installing or Uninstalling the Plug-in

You might see the following error message when you attempt to install or uninstall the
plug-in:

"Citrix Single sign-on has detected that one or more Java software programs or files are
currently in use. Please close all programs and stop all Java-related services before
continuing. "

Typically, this error occurs if you are installing the plug-in on a computer also running a
Web server service such as Apache Tomcat or Apache HTTP server. Also, this error might be
seen if you are installing the plug-in on a XenApp server with a License Management
Console installed.

In this case, perform the following steps:

1. Stop the service.

2. Install or uninstall the plug-in.

3. Restart the service.

http://java.sun.com
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Planning Your Single Sign-on
Environment

Before installing Single sign-on, you should plan your environment. This includes
determining the type of central store to use, the single sign-on-enabled applications in your
enterprise, which Single sign-on features to use, and establishing password policies.

A Single sign-on environment can include the following:

• Shared network folders or Active Directory containing the central store.

• One or more computers running the Single sign-on component of the Delivery Services
Console.

• User computers running the Single sign-on plug-in.

• A dedicated server hosting the Single sign-on service with one or more feature modules
installed on it.

• Citrix XenApp environment hosting the Single sign-on plug-in.

• Authentication devices such as smart cards.

• Single sign-on features such as Hot Desktop and key management.
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Identifying the Four Key Components of
Single Sign-on

The main components of Single sign-on are:

• The central store

• The Single sign-on component of the Delivery Services Console

• The Single sign-on plug-in

• The Single sign-on Service (optional)
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Central Store Types

Single sign-on uses a repository known as the central store to store and retrieve information
about your users and your environment. Single sign-on relies on the data in the central
store to perform all default and configured single sign-on functions. You can create a
central store automatically as part of the Single sign-on installation process or manually by
using the central store setup utilities.

The central store contains user data and administrative data:

• User data in the central store includes user secondary credentials, security questions
and answers, service-related data (for example, provisioned data, question-based
authentication data, key recovery enrollment, and so on), and user Windows registry
data associated with Single sign-on.

• Administrative data in the central store includes application definitions, password
policies, security questions, and other settings made through the console for Single
sign-on features and components.

The central store basically enables the plug-in software running on a user computer or
computer running Citrix XenApp to communicate with the central store and services, and to
provide user credentials to applications to which the user is granted access.

The plug-in software maintains a local store on the user computer. The local store contains
only the user’s secondary credentials, key recovery information, and security questions and
answers (if applicable). It synchronizes with the central store to allow users to roam
throughout the enterprise and always have access to saved user credentials.

The central store can be one of the following types:

• Active Directory

The central store uses the Active Directory environment and objects to store and
update Single sign-on data.

• NTFS network share

The central store uses a Windows network file share to store the Single sign-on data.

If necessary, you can migrate users from one central store type to another.
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Choosing an Active Directory Central
Store

Choosing to use Active Directory as your central store enables you to leverage the
convenience of your existing Active Directory user authentication and object
administration. For example, you can apply user-specific settings to any level in a
domain—domain, organizational unit, group, or user.

Two new classes and two attributes are added to the Active Directory schema when you
create an Active Directory central store:

Class Description

citrix-SSOConfig Describes the object containing data for the plug-in software
settings, synchronization state, and the application definitions
and the first-time plug-in software use behavior.This class
includes the following attributes: citrix-SSOConfigData - contains
the actual data and citrix-SSOConfigType - specifies the data
type

citrix-SSOSecret Describes the secret data object used to authenticate a Single
sign-on user. This class includes the following attribute:
citrix-SSOSecretData - contains encrypted credential data for an
application and Account Self-Service password reset data

Note: See the CitrixMPMSchema.xml file in the \Tools folder on the installation media for
more information about these classes and attributes.

In general, choose Active Directory as your central store if you:

• Can successfully extend your Active Directory schema without affecting your enterprise

• Already implement best practices for Active Directory backup and restore as
recommended by Microsoft (although this is not a requirement)

• Prefer the high availability that is built in to Active Directory to be extended to the
central store data

Advantages of an Active Directory Central Store
The following are advantages of using an Active Directory central store:

• Active Directory includes built-in failover and redundancy, so additional measures for
disaster recovery are not needed

• Active Directory replication helps to distribute central store administrative and user
data across your enterprise

• No additional hardware is needed when using an Active Directory central store



Active Directory Central Store Considerations
Consider the following before using an Active Directory central store:

• You must extend your schema when using an Active Directory central store, which
requires careful planning and implementation. Extending the schema affects the entire
forest.

• You might want to extend the schema and create your Active Directory central store
during non-peak usage hours. Your Active Directory replication cycle latency affects
how quickly these changes are copied to all domain controllers in the forest.

• Inter-site replication of central store data across large enterprises using WANs requires
you to configure replication correctly to reduce latency. (However, intra-site
replication typically introduces less latency.)

Choosing an Active Directory Central Store

39



40

Choosing an NTFS Network Share

Choosing to use an NTFS network share as your central store enables you to leverage the
convenience of your existing Active Directory user authentication and tree structure
without having to extend the Active Directory schema. For example, you can apply
user-specific settings to any level in a domain—domain, organizational unit, group, or user.

Important: Use a hidden share for the central store in this case.

Single sign-on creates a shared folder named CITRIXSYNC with two subfolders named People
and CentralStoreRoot.

The People folder contains a subfolder for each user and includes the appropriate read and
write permission properties for the user. The CentralStoreRoot folder contains
administrative data.

Advantages of an NTFS Network Share
The following are advantages of using an NTFS network share:

• You can emulate the look and feel of an Active Directory central store without having
to extend your Active Directory schema. Yet you can take advantage of your existing
Active Directory hierarchy or groups.

Note: Associating user configurations to groups is supported only in Active Directory
domains that use Active Directory authentication.

• User data is always up-to-date, because it is stored in a central location and avoids any
data replication latency associated with Active Directory.

• You can load balance your shares among multiple computers that can each host an NTFS
network share for higher availability.

• NTFS network share helps reduce the authentication task workload from your Active
Directory environment.

• Single sign-on enables you to migrate your NTFS shared folder central store to an Active
Directory central store if you decide later to implement an Active Directory central
store.

NTFS Network Share Considerations
Consider the following before using an NTFS network share:

• You might need additional hardware to host the central store.

• You need to back up central store files and folders (including their related permissions)
regularly. Ensure that you also maintain and implement disaster recovery plans where



you replicate files and folders for site recovery.

• Your enterprise network topology might require users (and the Single sign-on plug-in
software) to transfer user data across one or more WAN links. In this case, consider
implementing the Distributed File System technology included as part of Microsoft
Windows Server 2003 and 2008. The Microsoft Web site http://support.microsoft.com
describes the Distributed File System technology in detail.

Choosing an NTFS Network Share
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Using Account Association with Multiple
Central Stores and User Account
Credentials in a Multiple Domain
Enterprise

Administrators can create multiple central stores in enterprises that contain multiple
domains. In fact, you can use more than one type of central store in these environments.
For example, you can associate user configurations with an NTFS network share central
store in one domain and an Active Directory central store in another domain.

Because companies might maintain multiple Windows domains, users might also have more
than one Windows account. Single sign-on includes a feature known as Account Association
to allow a user to log on to any application from one or more Windows accounts. Because
Single sign-on typically binds user credentials to a single account, the credential
information is not synchronized automatically among multiple accounts that a user owns.

However, administrators can configure Account Association to synchronize user credentials
by using the Credential Synchronization Module. Users with Account Association configured
have access to all applications from any of their accounts in their Single sign-on
environment. When user credentials are changed, added, or removed from one account,
the credentials are synchronized automatically with each of the user’s associated accounts.

Without Account Association, users with multiple Windows accounts are forced to manually
change their logon information separately from each Windows account.



43

Advantages of Using Account Association

• Account Association can help increase productivity and reduce support calls by
synchronizing user credentials to help reduce logon maintenance or failures.

• Accounts can be synchronized across different central store types. That is, a user
account configured to use Active Directory as the central store can synchronize with an
associated user account that is configured to use an NTFS network share.

• Accounts can also be synchronized across different user configuration associations. For
example, a user configuration can be associated with an Active Directory hierarchy (OU
or user) in one domain and associated with an Active Directory group in another
domain.

• Accounts can also be synchronized across different user configuration associations in
the same domain and within the same central store.

• Trust relationships between domain controllers are not necessary to use Account
Association.

Consider the following before configuring Account Association:

• Account Association is not compatible with smart cards when smart cards are used as
the primary authentication mechanism to log on to Windows.

Note: The user configuration in each domain might have different password policies
that might block access to a resource, but Account Association synchronizes user
credentials only, not user configuration policies. Consider how you compose password
policies in your enterprise.

• Each associated domain account must use Single sign-on.

• Application definition names must be the same in each user configuration for the
Account Association feature to synchronize credentials.

• User credentials are shared only for applications specified in application definitions
created by the Single sign-on administrator.

• As part of the Single sign-on Service, the Credential Synchronization Module is a Web
service available through a secure HTTP connection, so this module must be accessible
from all computers in your enterprise using Account Association.
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Password Policies

Password policies are rules that control how passwords are created, submitted, and
managed. The Single sign-on installation includes two standard password policies named
Default and Domain, which cannot be deleted. You can copy these policies and make
modifications to suit your enterprise policies and regulations.

Default Password Policy
Single sign-on applies the Default policy to password-enabled applications used in your
enterprise (except for those that require user domain credentials). This policy is applied to
any application that is not defined by an administrator (by using the application definition
feature in the console) or any application that is not part of an application group.

When a user adds credentials to the Logon Manager for an application that does not have a
corresponding application definition, Single sign-on applies the Default policy to manage
that application.

Domain Password Policy
Typically, an administrator creates an application group and selects the Domain policy to be
applied to the applications in that group. Single sign-on then applies the Domain policy to
those applications that require the user’s domain credentials for access. The Domain policy
can be modified or copied to reflect your enterprise’s Active Directory or NT domain
policies for user accounts.

If you want an application group to be treated as a domain password sharing group, you
must apply the Domain policy to that application group. An application group is a collection
of defined applications associated with one or more user configurations, including the
policy to manage the applications.

Custom Password Policies
You can create password policies as needed: you can apply one policy for your domain
sharing group, create individual policies to apply to individual groups of applications to
secure them further, and so on.

When creating a custom password policy or modifying existing policies, ensure that your
enterprise requirements and application requirements match. For example, if you create a
policy that does not at least match an application’s requirements, your users might not be
able to authenticate to that application.

In general, password policies can specify restrictions such as the following:

• A minimum and maximum number of characters for a password



• Alphabetical and numerical character usage

• Number of times a character can be repeated

• Excluding or requiring which characters or special characters can be used

• Whether or not users can view their stored passwords

• How many times users can try entering their password correctly

• Password expiration parameters

• Password history and password exceptions

Password Policies
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Password Policy Considerations

Consider the following before establishing password policies:

• Consider your security requirements in the context of ease-of-use for your users. Overly
restrictive passwords might be hard for users to create, implement, or recall.

• Because Single sign-on is secure by design, the Default password policy defines the
minimum level of password security recommended by Citrix for securing most single
sign-on enabled applications. You can modify these settings according to your
enterprise policies and regulations.

• Because Single sign-on applies the Default password policy to user-added applications,
ensure that you configure the Default policy to be as broad as needed to accept
passwords for those applications for which you allow passwords to be stored.

• When users change their passwords, Single sign-on can be configured through a user
configuration setting to check the old password against the new password. This helps
prevent users from reusing passwords for the same application twice in a row.

• Users might have a single password that is used for multiple applications (in a suite of
products, for example). This scheme is known as password sharing, where the same
authentication authority is used for the applications.

While the other credentials for those applications (such as user name and custom fields)
might be different, the user’s password is the same. In this case, create an application
group that is a password sharing group to ensure that the plug-in software manages the
password for all applications in the group as a single entity. When the password is
changed in one of the applications, the plug-in software ensures that the password
change is reflected in the stored credentials for all applications in the group.

• Domain password sharing groups differ from other password sharing groups because the
user’s domain password is used as the master password for the application group. When
the user changes the domain password, the plug-in software ensures that the change is
reflected in the credentials for all other applications in the group. Only the domain
password can be changed; users cannot initiate password changes on any of the other
applications in the group unless the administrator removes the application from the
domain password sharing group.
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Default Settings for the Default and
Domain Password Policies

The following table describes the settings, as installed, for the Default and Domain
password policies.

Default and Domain Password Policy Options Default Setting

Basic Password Rules  

  Minimum password length 8

  Maximum password length 20

  Maximum number of times
a character can occur

6

  Maximum number of times
the same character can
occur sequentially

4

Alphabetic Character Rules  

  Allow lowercase characters Yes

  Password can begin with a
lowercase alphabetic
character

Yes

  Password can end with a
lowercase alphabetic
character

Yes

  Minimum number of
lowercase alphabetic
characters required

0

  Allow uppercase characters Yes

  Password can begin with an
uppercase alphabetic
character

Yes

  Password can end with an
uppercase alphabetic
character

Yes

  Minimum number of
uppercase alphabetic
characters required

0

Numeric Character Rules  

  Allow numeric characters Yes

  Password can begin with a
numeric character

Yes



  Password can end with a
numeric character

Yes

  Minimum number of
numeric characters
required

0

  Maximum numbers of
numeric characters allowed

20

Special Character Rules  

  Allow special characters No

  Password can begin with a
special character

Yes

  Password can end with a
special character

Yes

  Minimum number of special
characters required

0

  Maximum number of special
characters allowed

20

  Allow special characters list !@#$^&*( )_+= [ ] \ | ,?

Exclusion Rules  

  Exclude the following list of
characters or character
groups from passwords

Optional setting

  Do not allow application
user name in password

No

  Do not allow portions of
application user name in
password

No

  Number of characters in
portions (the character
groups that can be taken
from the application user
name)

3

  Do not allow Windows user
name in password

No

  Do not allow portions of
Windows user name in
password

No

  Number of characters in
portions (the character
groups that can be taken
from the Windows user
name)

3

Password History and Expiration  

  New password must not be
the same as previous
password

No

Default Settings for the Default and Domain Password Policies
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  Number of previous
passwords remembered

1

  Use the password
expiration settings
associated with the
application definitions

No

  Number of days until
password expires

42

  Number of days to warn
user before password
expires

14

Logon Preferences  

  Allow user to reveal
password for applications

No

  Force user to
re-authenticate before
submitting application
credentials

No

  Number of logon retries 3

  Time limit for number of
retries (in seconds)

120 seconds

Password Change Wizard  

  Allow users to choose a
system-generated password
or create their own
password

Yes

  Only allow users to create
their own password

No

  Only allow users to choose
a system-generated
password

No

  Generate a password and
submit it to the application
without displaying the
Password Change Wizard

No

Default Settings for the Default and Domain Password Policies
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Types of Applications Supported by
Single Sign-on

As the Single sign-on administrator, you can create an application definition or modify an
application definition template for each application that you want Single sign-on to manage
for your users. You create application definitions by using the console or the stand-alone
Application Definition Tool that can be installed on non-console workstations.

You can also allow users to add their credentials to Single sign-on for any of their
client-side applications that it detects, according to settings in user configurations. The
plug-in software can detect and respond to logon changes for most applications, including
the following application types:

Application Types Description

Windows 32-bit Windows applications (including Java
applications) such as Microsoft Outlook, Lotus
Notes, SAP, or any password-enabled Windows
application

Web Web applications (including Java applets and SAP)
accessed through Microsoft Internet Explorer

Terminal Emulator Applications that you access through a
HLLAPI-compliant terminal emulator. (Single sign-on
does not support 64-bit terminal emulator
sorftware.)

The plug-in software responds according to application definitions that you create from
scratch or copy from existing templates. An application definition:

• Enables the plug-in software to recognize and respond to applications and the forms
used by the applications to process user credentials

• Consists of a set of identifiers that establish parameters to accomplish this recognition
and response

Within each definition, you create logon and password-related forms required by the
application to enable access. The application definition wizards can help you create a
definition if you open the application; the wizards can detect the forms and fields of most
applications by using Single sign-on’s window-matching capabilities.

Tip: Single sign-on includes default application definition templates for a variety of Citrix
applications or application features. Additional templates are available by searching the
Citrix Support Web site.
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Collect Information About Each
Application in Advance

Before you create a definition, collect the following information about each Single sign-on
(SSO) enabled application in your enterprise. You can also start the application to allow the
Application Definition wizard or tool to detect some of this information.

• Application executable name and, optionally, its path.

You can supply a path for the application for added security, ensuring the user is
running the specific application qualified for your enterprise.

• Individual user credential fields required for each application, such as user name,
password, and other fields (for example, domain name or secondary password).

• Other credential-related fields in the form, including these password change fields:
Logon, Change Password, Change Password Success (optional), Change Password Failure
(optional).

• Password sharing application requirements.

You might also need to know which applications share the same authentication
authority and might be part of a password sharing group. Password sharing groups
enable Single sign-on to manage multiple credentials for applications that use the same
method of authentication. Also, you can apply the same password policy to application
groups.

• Information associated with terminal emulation applications.

Information such as terminal emulator session short names is required by High-Level
Language Application Programming Interface (HLLAPI) compliant terminal emulators.



52

Smart Cards

Citrix has tested smart cards that meet Standard 7816 of the International Organization for
Standardization (ISO) for cards with electrical contacts (known as a contact card) that
interface with a computer system through a device called a smart card reader. The reader
can be connected to the host computer by the serial, USB, or PC Card (PCMCIA) port.

Citrix supports the use of PC/SC-based cryptographic smart cards. These cards include
support for cryptographic operations such as digital signatures and encryption.
Cryptographic cards are designed to allow secure storage of private keys such as those used
in Public Key Infrastructure (PKI) security systems.

These cards perform the actual cryptographic functions on the smart card itself, meaning
the private keys never leave the card. In addition, smart cards provide two-factor
authentication for increased security: the card and the user’s pin number. When these
items are used together, the cardholder can be proven to be the rightful owner of the
smart card.

Smart Card Software Requirements
Consult your smart card vendor or integrator to determine detailed configuration
requirements for your specific smart card implementation. The following components are
required on the server or client:

• PC/SC software

• Cryptographic Service Provider (CSP) software

• Smart card reader software drivers

Your Windows server and client operating systems might already include PC/SC, CSP, or
smart card reader drivers. See your smart card vendor for information about whether these
software components are supported or must be replaced with vendor-specific software.

To use smart cards in a Windows Server 2008 or Windows Vista environment, your central
store must be created with or updated by a Single sign-on 4.5 (formerly Password Manager)
or later console and Microsoft Data Protection API (requires roaming profiles) must be
selected in your user configurations.
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Requiring Identity Verification

Depending on user configuration settings, you might require users to verify their identities
when the following events occur:

• Users change their authentication types; for example, a user might switch between
smart card and password authentication (you can create a user configuration that
requires initial verification only when switching between authentication types)

• An administrator changes a user’s primary password

• Users reset their primary password using Account Self-Service

• Users unlock their domain account using Account Self-Service

• Users change their primary password on a device that does not have the plug-in
software installed and then log on to a device where the plug-in software is installed

Single Sign-on can be configured to verify the user's identity to ensure that the user is
authorized to use Single Sign-on. You can select one of two identity verification methods:

Method Description

Previous Password In this case, users verify their identities by entering
their previous primary password.

Security questions (also known as
question-based authentication)

In this case, you create a questionnaire that
contains as many questions and question groups as
you want to make available to users. You can use
the default questions Single Sign-on provides or
create your own.

Caution: When previous password is the only identity verification method available to
your users, users who forget their previous primary password are locked out. An
administrator must then use the Single Sign-on component task Reset User Data to enable
the users to reenroll. An administrator might also need to reset the passwords in the
user’s applications.
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Verifying User Identity by Using Security
Questions (Question-Based
Authentication)

Single sign-on enables you to use question-based authentication to verify user identity.
Single sign-on includes four questions (in English, French, German, Japanese, and Spanish)
that you can use for this purpose.

You can use question-based authentication:

• As part of a user’s Security Question Registration during the first-time plug-in software
enrollment

• After enrollment, if you configured Account Self-Service to allow users to change their
primary credentials or unlock their accounts

When users change their primary passwords, you can confirm your users’ identities by
prompting them to answer security questions in the form of a questionnaire you create.
This questionnaire appears the first time your users launch the plug-in software. Users
answer the required number of security questions and can be prompted to reenter this
information at specific password change events.

If you choose not to set up security questions, users are prompted for their previous
primary password when they first log on and when they change their primary password. You
can also allow users to choose the method they prefer to use when authenticating (previous
passwords or security questions).
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Recovering or Unlocking User Credentials
Automatically

Important: Automatic key management is not as secure as other key recovery
mechanisms such as security questions and previous password.

You can configure Single sign-on to bypass identity verification and retrieve user credentials
(that is, encryption keys associated with the user data) automatically by installing the
Single sign-on Service and using the Key Management Module.

The basic workflow to use automatic key management is as follows:

1. Install the Citrix Single sign-on Service with the Key Management Module.

2. Create or edit user configurations and select the key recovery method that allows
automatic key management without identity verification. This option is available as
part of the Secondary Data Protection property in the user configuration.
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Planning Your Single Sign-on Plug-in
User Configurations

A user configuration is a unique collection of settings, password policies, and applications
that you apply to users associated with an Active Directory hierarchy (organizational unit or
an individual user) or Active Directory group (except for distribution groups and Domain
Local groups in Active Directory mixed mode, which are not supported). A user
configuration enables you to control the behavior and appearance of the plug-in software
for users.

User configurations set your user information, application definitions, password policies,
and identity verification methods. You must also specify license information (license server
and license type) in each user configuration. Therefore, your users cannot use the plug-in
software until you establish their user configuration settings.

Before you create your user configurations, ensure that you already created or defined the
following:

• Your central store

• Optional service modules

• Application definitions

• Password policies

• Security questions (optional)

User configurations consist of the following:

• Users associated with an Active Directory domain hierarchy (organizational unit or
individual user) or group.

• Data protection methods.

• Application definitions you created, which you can combine into an application group
when you create a user configuration.

• Password policies associated with any application groups. (While creating a user
configuration, you can create one or more application groups to associate with a user
configuration. You can also add an application group to a user configuration after you
create the user configuration.)

• Self-service features (account unlock and password reset) and key management options
(use of previous passwords, security questions you create for your users, and automatic
key management).

• Settings for options such as Hot Desktop, credential provisioning, and application
support.



Associating user configurations to groups is supported only in Active Directory domains that
use Active Directory authentication.

Consider the following when planning your Single sign-on plug-in user environment:

• If you need to apply the same user configuration settings to a different group of users,
duplicate the user configuration in the console and modify the settings accordingly.

• How you organize your Single sign-on user environment might affect how user
configurations operate. That is, you associate user configurations in your Single sign-on
environment with an Active Directory hierarchy (OU or users) or an Active Directory
group. If you use both (hierarchy and group) and a user is located in both containers,
the user configuration associated with the hierarchy takes precedence and is the one
used. This scheme is considered a mixed environment.

• The user configuration information maintained in the central store takes precedence
over information stored in the local store (that is, user data stored on a user’s
computer). The local store user data is mostly used when the central store is not
available or offline.

Planning Your Single Sign-on Plug-in User Configurations
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Enabling the Sharing of the Same
Resources or Workstation Among Many
Users (Hot Desktop)

The Hot Desktop feature allows users to share workstations efficiently and securely. With
Hot Desktop, you get the convenience of fast user switching in addition to single sign-on
capability through Single sign-on.

Before you can implement Hot Desktop, however, you must:

• Create Hot Desktop-related user configurations

• Configure a Hot Desktop shared account

• Edit the scripts that define what applications run on Hot Desktop devices and their start
up and shut down behavior

Hot Desktop functionality is not installed by default; you can select it during the initial
installation of the plug-in software. You can also upgrade existing deployments to use Hot
Desktop.

If you deploy Hot Desktop in an environment where users log on with smart cards and your
selected smart card key source is DPAPI with Profile, do not select Prompt user to enter the
previous password as the only key recovery method for those users. Users in such an
environment cannot enter the correct previous password and, consequently, are
irretrievably locked out of the system. To avoid this problem, select the automatic key
management option or make question-based authentication available as an option.

Controlling Applications with Hot Desktop
With Hot Desktop, users can authenticate quickly using their Windows account credentials
or smart card strong authenticator. As the administrator, you can configure Hot Desktop to
launch applications in the Hot Desktop environment so your users do not have to search for
and wait for their applications to launch.

You can also configure Hot Desktop to help ensure that all applications terminate properly,
leaving behind a clean environment for the next user session.

The Hot Desktop User Experience
When the shared account logs on, it places the device into “fast user switch” mode, which
causes a standard Windows authentication prompt to appear on the screen. The shared
account remains logged on regardless of Hot Desktop user activity.



When users authenticate, they do not log on to Hot Desktop in the traditional sense.
Instead, Hot Desktop uses their Windows credentials to start a Hot Desktop session. Because
users are not truly logging on but rather authenticating, time-consuming events normally
associated with logging on, such as applying group policy, initializing printers, and so on, do
not occur. This creates the “fast-switch” users experience when running Hot Desktop. A
user can start a session, perform any job-related tasks, and end the session so the next user
can enter the system and do the same. The switch from user to user occurs quickly and
efficiently.

The Single sign-on plug-in software launches when the Hot Desktop session starts. After the
session is established, Hot Desktop accesses the user’s Windows account credentials to
launch applications using the standard shell interface. Typically, these lightweight client
applications prompt users for their credentials, which can be supplied by the plug-in
software using settings associated with their Windows account.

Enabling the Sharing of the Same Resources or Workstation Among Many Users (Hot Desktop)
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Selecting Optional Single Sign-on Service
Features

The Single sign-on Service is a Web service that uses Secure Sockets Layer (SSL) to encrypt
the data shared by the Single sign-on Service, the console, and the plug-in software. It uses
a dedicated Web server to host the optional features included in Single sign-on.

Install the Single sign-on Service if you plan to implement one or more of the following
modules:

• Key Management, which allows users to log on to the network and have immediate
access to applications managed by Single sign-on without needing to verify their
identities through question-based authentication

• Data Integrity, which digitally signs data before it is transmitted from the central store
to the plug-in software

• Provisioning, which allows you to use the console to add, remove, or update credential
information for your users

• Self-Service, which allows users to reset their Active Directory passwords and unlock
their accounts

• Credential Synchronization, which allows users to synchronize their credentials among
different accounts (also known as Account Association)

Important: The server that hosts the Single sign-on Service contains highly sensitive
user-related information. Citrix recommends that you use a dedicated server and that
you place the server in a physically secure location.
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Enabling Service Modules: Key
Management

With Key Management, users log on to the network and have immediate access to
applications managed by Single sign-on without using question-based authentication (this
scheme is also known as automatic key management). When users change their primary
passwords, the plug-in software detects these changes and recovers the users’ encryption
keys using the Single sign-on Service.

This automatic key management provides users with the easiest and fastest access to their
applications. However, automatic key management does not protect against access by an
unauthorized user or administrator impersonating a user because there is no “user secret”
to protect the user’s network password. To help prevent this potential problem, implement
automatic key management in combination with the Account Self-Service Module and
question-based authentication.

Automatic key management uses key splitting (the process of dividing a private key into
two parts) to help reduce security threats.

Important: Depending on the security policy your organization implements, system
administrators might be able to access passwords for applications managed by Single
sign-on. Check your organization’s security policy before allowing Single sign-on to handle
passwords that users want to keep completely private. Clearing automatic key
management features in the Data Protection Methods setting in the user configuration
can also help prevent this unauthorized access.
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Enabling Service Modules: Data Integrity

Install the Data Integrity Module if you want to ensure that data transmitted among the
Single sign-on components is provided by a trusted and authorized source. This module is
optional and is designed for users who have non-trusted networks.

The Data Integrity Module contains the public and private key files used for signing the
data. It utilizes RSA public key cryptography to ensure that the plug-in software obtains
configuration data provided by an authorized source only. The Data Integrity Module never
distributes its private key.

After the console signs the data, the console sends both the data and the signature to the
central store. The plug-in software receives the data and signature from the central store
during synchronization. The plug-in software then contacts the Single sign-on Service to
obtain a copy of the public key it needs to verify the signature it received from the central
store.

If the plug-in software is configured to use the Data Integrity Module, it never accepts
configuration data that failed the data integrity check. If a check fails, the plug-in software
logs the event and displays an error message telling users to contact their administrator
directly. The plug-in software then defaults to previous configurations or returns to an
offline state.

If you already implement a security framework that protects data in transit, such as IPsec
(Internet Protocol Security) or SMB (Server Message Block) signing, you do not need to
install the Data Integrity Module.
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Enabling Service Modules: Provisioning

Provisioning (also known as credential provisioning) adds to the flexibility and functionality
of Single sign-on within your organization’s environment by allowing you to automate a
number of time-consuming processes. Whether you are rolling out a new installation of
Single sign-on, adding several hundred new users and new applications, or clearing out
unneeded information, credential provisioning gives you the ability to complete these tasks
quickly.

For example, you can use credential provisioning to add all the user names and passwords
for all of your applications to the central store. Doing so eliminates the need for first-time
users of the plug-in software to go through the process of Initial Credential Setup.
Additionally, if you plan to roll out new software to your users, create an application
definition for the application and use credential provisioning to add the credentials for all
users who will use the application.

Using credential provisioning, you can:

• Add, modify, and delete credentials in the central store

• Reset user credential information

• Remove users and their application credentials from Single sign-on

Credential provisioning is achieved by using information about your environment to create a
template that you can use to add, remove, or change credential information in your central
store. Credential provisioning is processed as part of the Single sign-on Service.
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Enabling Service Modules: Self-Service

Note: You can use the Account Self-Service feature only in an Active Directory
environment to allow your users to reset their primary password or unlock their Windows
domain accounts.

You can configure the self-service features of Single sign-on to allow your users to reset
their primary password or unlock their Windows domain accounts without intervention by
administrative or help desk staff. Depending on your needs, you can implement one or both
of the self-service password reset and account unlock features securely in your Single
sign-on environment.

Self-Service Password Reset allows users who forgot their primary password to reset their
password and unlock their own accounts. Account Unlock allows your users to unlock their
domain accounts when a lockout event occurs.

These account features are protected by Question-Based Authentication to help ensure that
your users are authorized to reset their passwords or unlock their accounts.

With Account Self-Service enabled, users must enroll, a process that requires them to
answer the security questions you create and select. These security questions are then
presented to users when they need to reset their password or unlock their account. When
the questions are answered correctly, users are allowed to reset their password or unlock
their account.

You can also use Account Self-Service with Web Interface. Web Interface is a component of
Citrix XenApp that allows users to access their published applications by clicking links on a
Web page.

Note: Account Self-Service does not support user principal name (UPN) logons, such as
username@domain.com.
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Enabling Service Modules: Credential
Synchronization (Account Association)

Account Association allows a user to log on to any application from one or more Windows
accounts. Because Single sign-on typically binds user credentials to a single account, the
credential information is not automatically synchronized among multiple accounts that a
user owns. However, administrators can configure Account Association to synchronize user
credentials. Users with Account Association configured have access to all applications from
any of their accounts in their Single sign-on environment. When user credentials are
changed, added, or removed from one account, the credentials are automatically
synchronized with each of the user’s associated accounts.
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Single Sign-on Plug-in Software
Deployment Scenarios

How you decide to implement Single sign-on depends on how users access applications in
your enterprise. For example, if you are running a XenApp environment, you can publish the
Single sign-on plug-in software on each server in your farm that is currently hosting
applications requiring authentication. Users access these applications through their Citrix
connections.

If users run applications locally on their workstations, laptops, handheld computers, or
other client devices, the plug-in software is installed on these devices. The plug-in software
in this case provides credentials and access to applications running locally on the client
device.

You can also implement the plug-in software in a mixed environment, with local
applications and applications published on computers running XenApp. The locally-installed
plug-in software provides credentials to the applications installed on the client device and
the XenApp-based plug-in software provides credentials to the published applications.

If you are also running Access Gateway Advanced Edition, applications are available from
XenApp through a Web browser.

Single sign-on can be used with the following:

• Access Gateway Advanced Edition

• Citrix XenApp features such as:

• Citrix online plug-in

• Citrix offline plug-in

• Web Interface

Requirements When Planning to Run Single Sign-on
in a XenApp Environment

Do the following when planning to run Single sign-on in a XenApp environment:

• When you use Single sign-on in a XenApp environment, you must install the plug-in
software on each server that publishes applications that require authentication. The
plug-in software provides credentials for published applications only.

• Install the console on a desktop or server that is not a member of the server farm. This
desktop or server should run the same operating system as each server on which the
applications are published or the same operating system of each server where the
plug-in software will be installed. Use this console to create user configurations to



control the plug-in software behavior.

• Users access the published applications in the server farm through ICA connections
using a client. When a user tries to connect to a published application that requires
credentials, the plug-in software recognizes the request for authentication sent by the
XenApp server. The plug-in software determines the application type (Windows, Web,
or terminal emulator) and retrieves the appropriate credentials from the local
credential store in the user’s profile.

Single Sign-on Plug-in Software Deployment Scenarios
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Planning for Multiple Primary
Authentication and User Credential
Protection

When you create or edit a user configuration, you can select user credential protection
methods depending on the authentication schemes you use in your enterprise.

The following user configuration property pages enable you to tune the Single sign-on
plug-in software behavior and credential data protection method used when users
implement one or more primary authentication methods.

Data Protection Methods Page
The user configuration Data Protection Methods properties page enables you to select single
or multiple primary authentication data protection methods. Additionally, you can also
regulate administrator access to user credential data to help prevent administrators from
impersonating a user and gaining unauthorized access to user information.

Secondary Data Protection Page
For added security when users change their primary authentication (for example, a domain
password is changed or smart card is replaced), the user configuration Secondary Data
Protection properties page enables you to require users to reauthenticate and verify their
identities before unlocking their application credentials.

Security Versus Usability
Two key questions to ask when deciding which options to choose on these two user
configuration property pages is:

• Which authentication types are used in my environment for the users I am administering
in this user configuration?

• How can I balance security requirements for the enterprise and usability for all users?

Consider also that the following choices are not mutually exclusive and that you can use a
mix of them in your enterprise (that is, multiple primary authentication). Your decision is
ultimately based on your need for security versus ease-of-use for your enterprise users.



User Impersonation
If you want to disallow administrator access to user credentials, select Yes for the Do you
need to regulate account administrator access to user data? option. Credentials are
protected against administrators seeking to impersonate a user and to gain access to user
information.

Yes is the default setting for the Data Protection Methods page. With this configuration, the
account or other administrator does not have access to user passwords or user data. This
setting helps prevent an administrator from impersonating a user. The administrator cannot
log on as the user with this default setting and possibly access data located in the user local
credential store.

The Yes setting disables the use of the Microsoft Data Protection API option on this page
and the Do not prompt users; restore primary data protection automatically option on the
following Secondary Data Protection page. Smart cards and roaming profiles are not allowed
in this case, and credentials are not restored automatically upon a password change
without authentication or verification.

Select No if you want to allow use of all the multiple authentication features available from
this page and the Secondary Data Protection page (including the ability to restore
credentials automatically without reauthentication or identity verification).

User Name and Password
The simplest implementation is the default setting for the Data Protection Methods page: a
password-only environment. The default setting lets your users employ their user name and
password while protecting their credentials against unauthorized access by administrators.

Important: The security of this setting choice depends on the relative strength of your
domain password policy. The stronger (or more complex) the password requirement, the
more secure this choice is.

Option Description

Do you need to regulate account
administrator access to user data?

See User Impersonation.

Users authentication data Selected. A user secret is used to access and
help protect user data. In this case, the user
secret is a password. Password security can be
derived from the user’s typed domain
password or a one-time password from token,
proximity, or biometric devices.

Planning for Multiple Primary Authentication and User Credential Protection 
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Smart Cards with Certificates and User Authentication
Data

Use Smart Cards Certificate and Users' authentication data if you combine smart cards with
embedded certificates or digital signatures and user authentication data in your enterprise.
Combining smart cards with a user name and password for authentication is the most secure
choice for protecting user authentication data.

Select the Smart Card Certificate option if you use smart cards with Hot Desktop.

To use smart cards in a Windows Server 2008 or Windows Vista environment, your central
store must be created with or updated by a Single sign-on 4.5 (formerly Password Manager)
or later console and Microsoft Data Protection API (requires roaming profiles) must be
selected in your user configurations.

Option Description

Do you need to regulate account
administrator access to user data?

See User Impersonation.

Users' authentication data Selected.

A user secret is used to access and help
protect user data. In this case, the user
secret is a password.

Password security can be derived from the
user’s typed domain password or a one-time
password from token, proximity, or
biometric devices.

Smart Card Certificate Selected.

In this case, the user secret is protected by
the encryption and decryption provided by
the card’s security certificate.

Smart Cards with PINs
If you use smart cards that do not support security certificates as the primary authenticator
in a Windows domain or you do not use roaming profiles, use the Allow Smart Card PINs
option. When you select this option, the encryption keys used to protect secondary
credentials are derived from the smart card PIN.

Consider enforcing the use of a strong PIN. In some enterprises, smart card PINs are
four-digit numbers that do not provide as strong a level of protection as, for example, an
eight-character password and might be more vulnerable to attack. Use the PIN as password
option only if your organization enforces a smart card PIN policy that requires a mixture of
letters and numbers, and requires a minimum length of eight characters.

Option Description

Planning for Multiple Primary Authentication and User Credential Protection 
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Do you need to regulate account
administrator access to user data?

See User Impersonation.

Users authentication data Selected. A user secret is used to access
and help protect user data. In this case, the
user secret is a personal identification
number (PIN).

Allow Smart Card PINs Selected. Allow the Smart Card PIN to be
used as the user secret for protection. Use
this only if your enterprise or environment
has a “strong PIN” policy

This option is supported by Version 4.1 of the Single sign-on (formerly Password Manager)
plug-in if you select Use data protection as in Single sign-on 4.1 and previous versions and
PIN as password, if you plan to use legacy plug-ins.

Roaming Profiles (Microsoft DPAPI)
Select No in response to Do you need to regulate account administrator access to user data?
to enable the use of the roaming profiles and Microsoft Data Protection API in your
environment. This option is the next-most secure option after smart cards with certificates
and user authentication data.

Select this option if you are using roaming profiles implementing a Kerberos network
authentication protocol for users. This option works only if roaming profiles are available. If
you are storing roaming profiles on workstations, you must select this option.

Single sign-on derives the encryption keys that protect secondary credentials from the
user’s primary password. However, if a user uses a smart card for primary authentication, a
primary password does not exist and cannot be used. In this case, the best plug-in option is
Microsoft Data Protection API. This option uses the Microsoft DPAPI to derive encryption
keys and protect secondary credentials. This encryption mechanism uses the user’s
Windows or domain credentials to derive the encryption keys.

If users employ passwords to access their computers and a Kerberos network authentication
protocol to access XenApp servers, select:

• No in response to Do you need to regulate account administrator access to user data?

• Users authentication data

• Microsoft Data Protection API

This method also allows the use of user credentials and smart cards to log on.

To use smart cards in a Windows Server 2008 or Windows Vista environment, your central
store must be created with or updated by a Single sign-on 4.5 (formerly Password Manager)
or later console and Microsoft Data Protection API (requires roaming profiles) must be
selected in your user configurations.

This method is supported by Version 4.1 of the Single sign-on plug-in and is supported on
Windows XP and Windows 2003 Server platforms. Select Use data protection as in Single
sign-on 4.1 and previous versions and DPAPI with Profile if you plan to use legacy plug-ins.

Planning for Multiple Primary Authentication and User Credential Protection 
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Blank Passwords
Allowing the use of a blank password should be considered a special case and should only be
used in low security environments that require extreme ease of use. One scenario is when a
common workstation is placed on a factory floor and is accessed by many users. You can
still use Single sign-on to control access to applications but the user credentials to access
the workstation include a blank password.

Important: If you do not select this option and a blank password is allowed in your
environment, the plug-in software does not derive a user secret or otherwise perform any
data protection with the blank password.

Option Description

Do you need to regulate account
administrator access to user data?

See User Impersonation.

Users authentication data Selected.

A user secret is used to access and help
protect user data. In this case, the user
secret is a password.

Allow protection using blank passwords Selected.

When you select this option and the plug-in
software detects that the user has a blank
password, a user secret for data protection is
derived from the user ID.

Planning for Multiple Primary Authentication and User Credential Protection 
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Installing Single Sign-on

This section describes the installation of the Single sign-on components. It begins by
presenting the standard installation order and installation configurations. Instructions are
then provided for creating a central store in an Active Directory or NTFS network share.
Installation and configuration of the Single sign-on console component, service, and plug-in
are provided, followed by a description of the multi-domain service feature.
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Installation Order

The suggested installation order of Single sign-on is:

1. Create your central store.

2. Install the Delivery Services Console on one or more computers in your environment.

3. Install the Single sign-on Service if you want to use one or more of the following
modules:

• Key management

• Self-service

• Provisioning

• Credential synchronization

• Data integrity

If you decide to install the Data Integrity Module at a later date or after installing
the Delivery Services Console and the Single sign-on plug-in, you must digitally sign
your existing central store data with the data signing tool CtxSignData.exe. (This
tool is available after you install the Data Integrity Module.) Conversely, if you
uninstall the Data Integrity Module, you must unsign your central store data.

4. Install the Application Definition Tool on one or more computers in your environment
when you need to create application definitions only.

5. Install the Single sign-on plug-in on each user computer in your environment or on the
server running XenApp.
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Single Sign-on Component Installation
Configurations

Install the Delivery Services Console, Single sign-on Service, and Single sign-on plug-in in
any of the following combinations or scenarios:

• The service and console on the same computer.

• The plug-in on any computer or user device in your environment for access to
locally-installed SSO-enabled applications.

• The console and Application Definition Tool on any computer in your environment.

• For testing purposes only, the console and the plug-in on the same computer to verify
that changes you make at the console are reflected on the plug-in.

• The plug-in in a XenApp environment. In this case, the plug-in submits or provides
credentials for XenApp-published applications only (not applications installed locally on
the user workstation or client device).

These installation combinations are not recommended and are not supported:

• Do not install the service and the plug-in on the same computer.

• Do not install Single sign-on on a domain controller. Installation of the plug-in or
service, console, or creation of an NTFS network share central store on a domain
controller is not supported.

Important: The server(s) that hosts the Single sign-on Service and NTFS central store
contains highly sensitive user-related information. Use a dedicated server and place that
server in a physically secure location.
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To create a central store

The following procedures assume that the installation media is loaded on the computer that
you chose to host the central store and that the XenApp autorun screen appears.

1. From the XenApp autorun, click Manually install components > Server Components >
Miscellaneous > Single sign-on.

2. Click Central Store.

3. Select a central store type. For NTFS network share:

a. Click NTFS network share. The central store is created as
%SystemDrive%\CITRIXSYNC.

For Active Directory:

a. Click Step 1: Extend Active Directory. The Active Directory schema is extended.

b. Click Step 2: Create Central Store.

Important: Ensure the current server is part of the Active Directory domain and that
the current user is a member of the Schema Administrators group and Domain
Administrators group. Ensure that the Active Directory Schema Master is configured
to allow updates. Also, if the server you are extending the Active Directory schema
from is not the domain controller, ensure the Microsoft Windows utility Ldifde.exe is
installed on it before beginning this step. The utility can be found on the Windows
installation media or at the Microsoft Web site (http://www.microsoft.com). You will
not be able to complete this process if Ldifde.exe is not installed.

http://www.microsoft.com
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Installing the Single Sign-on Console
Component

The Single sign-on console component can be installed into the Delivery Services Console
automatically or through a manual component installation. The Single sign-on component is
included with both the automatic and manual installations of the Delivery Services Console.

Important: If you have not created your central store, you will need to do so before
successfully completing the Configure and run discovery wizard and using Single sign-on.

To automatically install the Single Sign-on console
component

The Single sign-on console component is included in the automatic installation of the
Delivery Services Console.

1. From the XenApp autorun, click Install XenApp Server.

2. Click Add server roles.

3. Follow the onscreen instructions through to installation.

Note: Options for installing Single sign-on Service and Single sign-on plug-in appear
during this process. Since these components frequently are installed on separate
computers, they are not discussed here.

4. Configure XenApp by following the onscreen instructions.

5. Click Start > All Programs > Citrix > Management Consoles > XenApp Management and
follow the onscreen directions for the Configure and run discovery wizard.

To manually install the Single Sign-on console
component

The Single sign-on console component is automatically included in the components
manually installed by this process.

1. From the XenApp autorun, click Manually install components > Common Components >
Management Consoles.

2. Follow the onscreen instructions for the Citrix Delivery Services Console Installation
wizard.
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Installing and Configuring the Service
Modules

After you install the Single sign-on Service, the Service Configuration wizard runs so that
you can configure and enable the service.

The installation and configuration workflow is as follows:

The following procedures assume that the installation media is loaded on the computer that
you chose to host the Single sign-on Service modules and that the XenApp autorun screen
appears.

To install the service modules
1. From the XenApp autorun, click Manually install components > Server Components >

Miscellaneous > Single sign-on > Single sign-on Service.

2. Follow the onscreen instructions for the Citrix Single sign-on service 4.8 Installation
Wizard. The Service Configuration wizard starts.

To configure the service modules
The Service Configuration wizard starts when service module installation completes. You
can start the wizard at a later time by clicking Start > All Programs > Citrix > Password
Manager > Service Configuration.

Follow the onscreen directions for the Service Configuration wizard . Use the following
information on the specified wizard pages.

• On the Configuration service page:

Connection Setting Specify the port number for the service connection. The
default port is 443.

SSL Certificate Select the SSL certificate installed on the service
computer to use for communication with client devices.

Select the Display Long Name check box to show the
LDAP informationConnection Setting contained in the
certificate.



Virtual host name Use default value is selected by default if the SSL
certificate name and virtual host name match. The
virtual host name must match the SSL certificate name.

The virtual host is the machine name visible to users
when the certificate was created and might not be the
actual machine name. For example, the certificate
name might include a wildcard (asterisk character) or
upper- or lowercase domain name that does not match
the certificate domain name case.

This setting is useful in a load-balanced or clustered
service environment.

Account Credentials Select the local computer account to use for the
service. Typically, you can select the Network Service
account.

• On the Configure domains page:

1. Select the check box next to each domain to which you want to enable service
support.

2. Select one or more domains and click Properties to open the Edit Configuration
dialog box.

3. If you created an Active Directory central store, click Domain Controller and select
the correct domain controller from the list.

4. Click Data Proxy Account and type the user name, password, and domain of the
data proxy account used to communicate with the central store.

5. If you installed the Self Service module, click Self-Service Features Account and
type the credentials for this feature.

6. Click OK to close the Edit Configuration dialog box.

Important: If the service is running in a Windows Server 2008 or Windows Server
2008 R2 environment with an NTFS central store, you must use
CtxFileSyncPrep.exe to add the data proxy account as an administrator to the
central store. Type:

CtxFileSyncPrep [/Admin:accountname]

If the service is running in a Windows Server 2008 or Windows Server 2008 R2
environment with an Active Directory central store, you also must add the data
proxy account as an administrator to the central store. Suggestions about how to do
this are on the Citrix Web site (http://support.citrix.com/article/ctx107690)

Single Sign-on Service Port Number
The default Single sign-on Service port number is 443. When you configure the Single
sign-on Service, you can use any other available port on the server running the service if
port 443 is already in use.

 Installing and Configuring the Service Modules
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This port number is used by Single sign-on to access each service module you install.

• If you install one or more service modules later, make sure that you use the port
number that you specified when you first installed the service.

• The service cannot run on multiple ports; if you specify the wrong port, Single sign-on
might later display “cannot communicate or connect with the Single sign-on service”
type error messages.

• Also remember to specify the correct service port number when using the Data Integrity
Signing Tool at the command prompt.

 Installing and Configuring the Service Modules
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Installing and Configuring the Single
Sign-on Plug-in

The Single sign-on plug-in runs on a computer running Citrix XenApp. The plug-in provides
credentials and access to published applications.

The Single sign-on plug-in is also designed to run on user devices: desktop and laptop
computers, handheld computers, and other devices. In this case, the plug-in software
provides credentials and access to applications running locally on the user device.

Note: For testing purposes, you can install the console and plug-in on the same computer
so that you can verify that changes you make at the console are reflected on the plug-in.

Users can use the plug-in to access local applications even when they are not connected to
a network. User credentials are synchronized when users reconnect to your enterprise
network.

When you install the plug-in using the autorun option on the XenApp installation media, the
installation software detects your operating system and installs the appropriate plug-in.
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Installation Scenarios

The following table shows some environments and schemes for installation:

Environment Scheme

Citrix XenApp and Citrix Access
Gateway

XenApp and Access Gateway provide applications
that users access through their Web browsers.

Install Single sign-on plug-in on each server
running XenApp.

Mixed Environment Users access published applications as well as
other local applications.

Install Single sign-on plug-in on each server
running XenApp and on each desktop.

Local Installation Users access applications installed on their local
devices.

Install Single sign-on plug-in on a local user
device.

Software Image for Network
Installation

Create an installation image to be made available
on your network.

Single Sign-on Plug-in Considerations
• If you are performing a fresh installation of multiple Citrix products that includes Single

sign-on, install the Single sign-on plug-in last.

• When you configure or change the location of the license server or any other parameter
related to licensing, the changes are not applied to any Single sign-on plug-in software
that is in use within your environment. You must shut down and restart the plug-in to
apply the changes.

• This does not apply to computers using Windows Vista, Windows Server 2008, or
Windows Server 2008 R2: You must restart the device after you install the Single sign-on
plug-in so that the GINA DLL can be installed.
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To install the Single Sign-on plug-in on a
local device

The following procedures assume that the XenApp installation media is loaded on the
computer where you chose to install the Single sign-on plug-in and that the autorun screen
appears.

1. From the XenApp autorun, click Manually install components > Server Components >
Miscellaneous > Single sign-on > Single sign-on Plug-in.

2. Follow the onscreen instructions for the Single sign-on plug-in installation wizard.

To create a Single Sign-on plug-in image for network
installation

You can install an image of the Single sign-on plug-in on a network share using a utility
available from the installation media. The utility creates an installation image of plug-in
that contains your custom parameters. The following procedures assume that the XenApp
installation media is loaded and that the autorun screen appears.

Important: If you create an image from a 32-bit computer, this image can be installed on
32-bit computers only. If you create an image from a 64-bit computer, this image can be
installed on 64-bit computers only.

1. From the XenApp autorun, click Manually install components > Server Components >
Miscellaneous > Single sign-on > Single sign-on Plug-in installation image.

2. Follow the onscreen instructions for the Single sign-on plug-in installation wizard. The
plug-in image file is saved in the location you specified in the wizard.

Preserving the GINA Chain When Installing the Single
Sign-on Plug-in

The following only applies to Windows XP, Microsoft Windows XP Embedded, Microsoft
Windows Fundamentals for Legacy PCs, Microsoft Windows Server 2003 R2, and Microsoft
Windows Server 2003 with Service Pack 2. These are the only supported operating systems
using GINA functionality.

Graphical Identification and Authentication (GINA) is the Windows component that controls
the dialog box that users see when they press the key combination CTRL+ALT+DEL. The
dialog box collects the data needed to perform authentication. XenApp, the Single sign-on
plug-in, and the Novell NetWare client all interact with or require the replacement of the
Microsoft GINA dynamic link library (DLL).



If you install any software that uses a custom GINA DLL, make sure that you do not disrupt
the GINA chain. You might be required to install or uninstall software in a specific order to
preserve proper GINA chaining. By installing the Single sign-on plug-in last, you ensure that
the Single sign-on GINA is called first by the Winlogon process.

To install the Single Sign-on plug-in on a local device 
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To configure the service for multidomain
use

Single sign-on Service can process service requests among users in different trusted
domains. An administrator can install the Delivery Services Console with the Single sign-on
console component on computers in different domains and create one or more user
configurations in each domain.

For example, with the Single sign-on Service computer located in DomainA, users associated
with a user configuration in DomainA can use the Account Self-Service features to unlock
their accounts. Users associated with a user configuration in DomainB can also use this
feature, as provided by the DomainA service computer. In this case, multiple user
configurations exist in multiple domains and are using a single service computer for this
feature.

Multi-Domain Service Feature Requirements
Before you implement the multi-domain service feature, ensure that you meet the
following requirements:

Component Requirement

Domains Each domain sharing the service must be part of the same
domain forest.

The domains within the forest must have a two-way
transitive trust agreement.

Central store This feature is available for implementations using Active
Directory or NTFS network share central stores.

All users sharing the same service computer must be
implemented using the same central store type: Active
Directory or NTFS shared folder. Multiple central store
types are not supported.

One NTFS shared folder central store per domain is not
supported in this case. However, you can use one NTFS
shared folder central store per forest.

Data Integrity feature The Data Integrity feature must be used consistently
across domains. That is, it is either enabled or disabled in
the service and Single sign-on plug-in configurations for all
domains. For example, you cannot enable this feature in
the service configuration and disable it when installing the
plug-in.



Single sign-on console
component of the Delivery
Services Console

Each console can view one central store only, not multiple
central stores.

The Single sign-on administrator should install one console
in each domain and install it by using a user account with
administrative rights in that domain.

Alternatively, the administrator can install a console with
the ability to access other domains and, as needed, switch
to one of those domains by logging on with credentials for
that specific domain.

Data Proxy and Self Service
accounts

You can configure one data proxy and self service account
that has read and write access to the central store and
sufficient privileges to reset user passwords and unlock
user accounts.

Optionally, you can specify these accounts for each
domain in the Service Configuration tool.

To configure the service for multidomain use
1. Log on as an administrator to the computer where the service is installed.

2. Start the Service Configuration tool by clicking Start > All Programs > Citrix > Password
Manager > Service Configuration.

3. When the Service Configuration tool appears, click Domain Configurations in the left
pane.

4. Select the check box next to each domain to enable service support on that domain.

5. Select one or more domains and click Properties to open the Edit Configuration dialog
box.

6. In the Edit Configuration dialog box:

a. If you created an Active Directory central store, click Domain Controllers and, from
the list, select the domain controller you want Single sign-on to bind to when
writing to the central store or select Any writeable domain controller.

b. Click Data Proxy Account and type the user name, password, and domain of the
data proxy account used to communicate with the central store.

c. If you installed the Self Service module, click Self-Service Features Account and
type the credentials for this feature.

To configure the service for multidomain use
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Upgrading Single Sign-on to version 4.8

The suggested upgrade order of Single Sign-on is as follows:

• Upgrade the Single Sign-on Service if you are using one or more of the following
modules. You can also install additional modules at this time.

• Key management

• Self-service

• Provisioning

• Credential synchronization

• Data integrity

Note: If you decide to install the Data Integrity Module at a later date or after
installing the Single Sign-on component of the Citrix AppCenter and Single Sign-on
Plug-in, you must digitally sign your existing central store data by using the data
signing tool CtxSignData.exe. (This tool is available after you install the Data Integrity
Module.) Conversely, if you uninstall the Data Integrity Module, you must unsign your
central store data.

• Upgrade the Single Sign-on component of the Citrix AppCenter on one or more
computers in your environment.

• Upgrade or install the Application Definition Tool on one or more computers in your
environment when you need to create application definitions only.

• Upgrade the Single Sign-on central store automatically by selecting the Single Sign-on
node and running the Configure and run discovery wizard from the Citrix AppCenter:

• Before upgrading network share-based central stores, back up the network share
folder.

• In the wizard, specify the UNC path of your existing NTFS network share, typically
\\servername\CITRIXSYNC$, where servername is the name of the server computer
where you created your central store.

• Active Directory-based central stores are also automatically upgraded during
configuration and discovery.

• If you are upgrading from a version of Citrix Password Manager that supported
Novell shared folder (for example, version 4.6), you might need to back up the
share and export and import administrative data to continue using settings
configured in that central store type. Please refer to the Password Manager 4.6
administration and installation documentation for information about moving central
store data.

If you’re looking for documentation for previously released versions of this product,
go to the Citrix Knowledge Center.

http://support.citrix.com/article/CTX113935
http://support.citrix.com/article/CTX113933
http://support.citrix.com


• After configuring Single Sign-on features in the Citrix AppCenter, upgrade or install the
Single Sign-on Plug-in on each user computer in your environment.

Upgrading Single Sign-on to version 4.8
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Single Sign-on Administration

Single sign-on provides password security and single sign-on access to Windows, Web, and
terminal emulator applications running in the Citrix environment as well as applications
running on the desktop. Users authenticate once and Single sign-on does the rest,
automatically logging on to password-protected information systems, enforcing password
policies, monitoring all password-related events, and even automating user tasks, including
password changes.
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Enforcing Password Requirements

You can use password policies to define rules that control the characteristics of users'
stored passwords. These rules comprise password policies that you can apply to all users or
to specific groups of applications as determined by your organization’s needs.

Note: Citrix XenApp provides policy rules that allow you to configure and control which
users can access Single sign-on when they connect to servers and published applications
in the server farm. Despite the similar names, these two types of policies are not related.

Single sign-on includes two standard password policies named Default and Domain. You can
use these policies as is, copied, or modified to suit your enterprise policies and regulations.
You cannot delete the Default and Domain policies.

When a user adds credentials to Logon Manager for an application not defined by an
administrator, Single sign-on uses the Default policy to manage that application. If you
want an application group to be treated as a domain password sharing group, apply the
Domain policy to that application group.

Because Single sign-on applies the Default password policy to user-added applications,
configure the Default policy to be as broad as needed to accept passwords for those
applications for which you allow passwords to be stored.

You can create as many policies as you need in your enterprise. For example, you can apply
one policy for your domain sharing group, and create individual policies to apply to
individual groups of applications to define the requirements further. With a password
policy, you can:

• Automate password changes for applications.

• Implement security schemes that include complex passwords and application-specific
passwords not visible to the users.

• Define password expiration for applications, even if the application does not have a
password expiration feature.

• Prevent users from reusing passwords for the same application twice in a row.

Password Sharing Groups
Users might have a single password that is used for multiple applications (in a suite of
products, for example). This is known as password sharing, where the same authentication
authority is used for the applications.

While other credentials for those applications (such as user name and custom fields) might
be different, the user’s password is the same. In this case, create an application group that
is a password sharing group to ensure that Single sign-on plug-in manages the password for
all applications in the group as a single entity. When the password is changed in one of the
applications, Single sign-on plug-in ensures that the password change is reflected in the
stored credentials for all applications in the group.



Domain Password Sharing Groups
Domain password sharing groups differ from other password sharing groups because the
user’s domain password is the master password for the application group. When the user
changes the domain password, Single sign-on plug-in reflects the change in the credentials
for all other applications in the group. Only the domain password can be changed; users
cannot initiate password changes on any of the other applications in the group unless the
administrator removes the application from the domain password sharing group.

Enforcing Password Policies
Single sign-on enforces password policies, regardless of whether the password is
user-defined or automatically generated by Single sign-on.

A password policy is not enforced when:

• A user registers with Single sign-on (during first-time use).

• A user edits a password from the Logon Manager.

• An administrator creates an application definition.

Single sign-on also does not enforce a password policy on existing passwords (those created
before Single sign-on is implemented in the enterprise) because users might be denied
access to applications or resources currently in use.

 Enforcing Password Requirements
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Creating Password Policies

The Password Policy Wizard uses the Default policy to create a new password policy.
Change the settings as needed and apply the newly created policy to your application
group.

Important: When creating a custom password policy or modifying existing policies, ensure
your enterprise requirements and application requirements match. For example, if you
create a policy that does not match an application’s requirements, your users cannot
authenticate to that application.

To start the Password Policy Wizard
1. Click Start > All Programs > Citrix > Management Consoles > Citrix Delivery Services

Console.

2. Expand the Single Sign-On node and select Password Policies.

3. From the Action menu, click Create new password policy.

4. Follow the instructions in the Password Policy Wizard.
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Helping to Increase Password Strength
and Security

As the Single sign-on administrator, you can help increase the strength of user passwords by
setting password policies that encourage strong password creation. To do so, consider the
following:

• Use the Provisioning Module to preset user passwords. Users are not required to know
their passwords, which prevents them from accidentally revealing them. This technique
requires coordination between the user configuration and the associated password
policy.

• Require users to change their passwords at regular intervals.

• Do not allow blank passwords.

• Do not allow users to reveal passwords.

• Do not allow reuse of passwords.

• Do not allow user or application names to be part of the password.

• Force users who have regular access to confidential or sensitive information to have
stronger or more complex passwords. Additionally, group these users into user
configurations containing these applications.
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Configuring Single Sign-on to Recognize
Applications

Single sign-on recognizes and responds to applications based on the settings identified in
application definitions.

Application definitions contain forms that allow the Single sign-on plug-in to analyze each
application as it is started, recognize certain identifying features, and determine if the
starting application requires the plug-in to perform some specific action, such as:

• Submit user credentials at a logon prompt.

• Negotiate a credential changing interface.

• Process a credential confirmation interface.

Application definitions consist of sets of specific user credential form recognition and action
characteristics referred to as form definitions, and the set of configuration options that
apply to all the forms in the configuration.

The form definition settings define the actions that Single Sign-on performs when an
application requests a specific user credential action.

An application definition contains all the user credential management forms associated with
a single application.

Although most applications and their corresponding application definitions use only two
forms for managing user credentials, you can define as many forms as necessary in a single
application definition.

Single sign-on provides support for a variety of applications including Windows, Web, and
terminal emulator-based applications. It works with Java applications; SAP solutions; and
applications hosted on a mainframe, AS/400 system, or UNIX server.

To simplify the application definition process, you can import a variety of predefined
application definition templates into Single sign-on from the Citrix Web site
(http://www.citrix.com/passwordmanager/gettingstarted). This site provides an
interactive exchange where Citrix Consultants, Sales Engineers, System Integrators, and
administrators share application definitions.

By sharing application definitions, you can implement single sign-on enabling application
definitions with less effort and more confidence.

Use the provided wizards to create application definitions for applications that do not have
predefined application templates. The Application Definition Wizard configures the
characteristics associated with all the forms included in the definition. The Form Definition
Wizard leads you through a step-by-step procedure to define support for Windows, Web,
and terminal emulator-based applications.

http://www.citrix.com/passwordmanager/gettingstarted


Single sign-on also provides the ability to perform external application discovery and action
processing support. This allows third-party implementers to extend the application
detection and credential submission tasks associated with a form by providing access to
external processes during the application detection and action submission processing phases
in the Single sign-on plug-in.

These features combine to provide you with a flexible and adaptable application definition
development environment to support your user community with secure and flexible single
sign-on access to critical applications.

Caution: Single sign-on is dependent on the secure operation of the computers hosting
the product’s components. If the user device becomes infected with any malicious code,
there is a risk that this code could undermine the security provided by Single sign-on. To
reduce this risk, follow standard security best practices to maintain the security of your
organization’s infrastructure.

Configuring Single Sign-on to Recognize Applications
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Application Templates

Application templates are XML files used to share application definitions between different
Single sign-on environments. Application templates save time and effort because you can
convert them to application definitions with minimal intervention or configuration.
Templates require you to provide information to complete the application definition, such
as a URL or executable file name, password expiration, and any advanced detection
settings.

Install application templates using the Single Sign-On node of the Delivery Services Console
or the Application Definition Tool. Both of these include application templates for
commonly-used Windows and Web applications.

Important: To write to an Active Directory central store while running in Windows Server
2008, Windows Server 2008 R2, Windows Vista, or Windows 7, grant the Application
Definition Tool an integrity level of High. Log onto an account that is a member of the
local administrators group to start the tool on the system computer as well as be a
member of the domain administrators group or have write privileges to the Active
Directory objects in the central store. Provide these credentials when running the tool,
either at the User Account Control prompt or when logging on to the system. The tool is
assigned a High integrity level and can write to the Active Directory.

You can find additional templates on the Citrix Web site
(http://citrix.thinkbuilddeploy.com/index.php). You can also create application templates
and share them with other Citrix administrators by uploading them to the Web site.

When an application template cannot be found for an application, create an application
definition using the Single Sign-On node of the Delivery Services Console or the Application
Definition Tool.

http://citrix.thinkbuilddeploy.com/index.php
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How Single Sign-on Plug-in Identifies
Applications and User Credential
Management Events

The user interface to an application includes different forms that are used to manage user
credential events associated with the application.

For example, one form enters the logon credentials, a second form changes an application
password, and a third form confirms a successful change to user credentials.

Depending on the type of application being defined (Windows, Web, or terminal emulator),
Single sign-on uses a variety of identifiers collected in application definitions, to uniquely
respond to and identify the forms. These include but are not limited to the application
type, window title, and the executable file name.

When Single sign-on plug-in identifies the application and form, it prompts users to provide
or store their credentials, submits stored credentials, or prompts users to update their
credential information, depending on the defined settings.

Create application definitions using the Delivery Services Console or the Application
Definition Tool.

A single application definition supports all user credential management events associated
with a single application including:

• Authenticating the user.

• Changing user credentials.

• Confirming credential changes.

Application definitions are categorized into three main types which determine the
information collected:

• Windows applications (including Java applications and the SAP LogonPad)

• Web applications (including Java applets)

• HLLAPI-compliant terminal emulator-based applications

An application definition consists of:

• Application characteristics that apply to all forms included in the definition. These are
defined using the Application Definition Wizard.

• Form-specific data used to recognize each different credential management event
associated with the application. Define these forms and events using the Form
Definition Wizard. This wizard runs during the Application Definition Wizard operation.



The application characteristics for all types of applications contain similar configuration
information. However, form-specific data contained in the application definition varies
greatly based on the type of application being defined.

To create an application definition, you must be able to access the application from the
computer where the application definition is created. Because application signatures can
vary depending on the underlying operating system, test application definitions on all
operating system software in your organization.

Test any changes or upgrades to an application after an application definition is deployed
to ensure that there are no changes to the application signatures requiring a change to the
application definition.

Important: As a security measure, in its default state, Windows Server 2008, Windows
Server 2008 R2, Windows Vista, and Windows 7 run with User Interface Privilege Isolation
(UIPI) enabled. UIPI prevents applications from sending messages to other applications
with a higher integrity level. As a result, the Single sign-on plug-in, which operates by
default at a medium integrity level, does not detect or submit credentials to applications
running at a high integrity level. To maintain the intended security level of these
operating systems and Single sign-on, continue to use these default settings.

How Single Sign-on Plug-in Identifies Applications and User Credential Management Events
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Collect Information About Each
Application in Advance

Before you create a definition, collect the following information about each Single sign-on
(SSO) enabled application in your enterprise. You can also start the application to allow the
Application Definition wizard or tool to detect some of this information.

• Application executable name and, optionally, its path.

You can supply a path for the application for added security, ensuring the user is
running the specific application qualified for your enterprise.

• Individual user credential fields required for each application, such as user name,
password, and other fields (for example, domain name or secondary password).

• Other credential-related fields in the form, including these password change fields:
Logon, Change Password, Change Password Success (optional), Change Password Failure
(optional).

• Password sharing application requirements.

You might also need to know which applications share the same authentication
authority and might be part of a password sharing group. Password sharing groups
enable Single sign-on to manage multiple credentials for applications that use the same
method of authentication. Also, you can apply the same password policy to application
groups.

• Information associated with terminal emulation applications.

Information such as terminal emulator session short names is required by High-Level
Language Application Programming Interface (HLLAPI) compliant terminal emulators.
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Application Definition Wizard Overview

All application definitions are initially created using the Application Definition Wizard and
the integrated Form Definition Wizard.

To start the Application Definition Wizard, select the Application Definitions node in the
Delivery Services Console, and then, from the Action menu, select Create application
definition.

The Application Definition Wizard collects information for each type of application
(Windows, Web, and terminal emulator-based).

Data Collected Windows Web Terminal
Emulator

Identify application X X X

Manage forms X X X

Name custom fields X X X

Specify icon X    

Configure advanced
detection

X X X

Configure password
expiration

X X X

Confirm settings X X X

Managing Forms with the Application Definition
Wizard

Most applications have separate forms for logon and password changes. Some applications
also have separate forms that notify users if they successfully changed their password.

Use the Manage forms page is to add forms to the application definition. You can also edit
and delete forms on this page.

Selecting Add Form starts the Form Definition Wizard that is used to collect the form data
for a single form. Use the Form Definition Wizard for each form in the application
definition.

Naming Custom Fields
Single sign-on includes the user name and password fields as required for any logon form.
Some applications require additional information such as a database name, domain name,
or system name to authenticate the user.



You can add up to two custom fields with the Form Definition Wizard. If you do so, when
you return to the Application Definition Wizard, use the Name custom fields page to name
these fields.

To create a hot key for the custom field name, place an ampersand (&) in the field name
immediately before the letter you want to specify as the hot key. If no hot key is identified,
Single sign-on plug-in dynamically appends a numeric value as the hot key for the control.
This appears on the button as (1) or (2) depending on the number of custom fields defined.

Specifying an Icon for Windows Applications
By default, Single sign-on uses a different icon to denote between Windows, Web, and
terminal emulator-based applications in the Logon Manager. However, you can specify a
custom icon for Windows applications on the Specify icon page to help users identify
specific applications. If you chose the custom icon option, store the icon file in the same
location as the application.

Preventing Credential Loops
Use the options on the Configure advanced detection page to mitigate credential
submission loops and credential change loops.

On occasion, users may find themselves on a Web site with a credential submission loop. In
these cases, users log off from an application which returns them to the logon screen.
Single sign-on plug-in detects the logon screen and submits the users' credentials,
automatically logging them back on. Enable Process only the first logon for this application
to prevent the automatic submissision.

When a predefined application is launched for the first time and this option is selected,
Single sign-on plug-in submits credentials on the initial instance of the logon form without
any additional user action required. When users log off and the logon screen appears again,
a window appears and stays visible for approximately 10 seconds. Users have three options:

• Close the window - no credentials are submitted

• Ignore the window - no credentials are submitted

• Click the link - credentials are submitted

Closing the application terminates the session and Single sign-on submits the credentials
the next time the application opens.

To prevent a credential change loop, enable Process only the first password change for this
application. With this option selected, if users attempt to change their passwords multiple
times while accessing a specified application, they are asked to verify subsequent password
changes.

Configure Password Expiration
The Configure password expiration page includes options to:

Application Definition Wizard Overview
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• Identify a script to run when the password expires.

• Use the Single sign-on expiration warning.

You or someone within your enterprise may develop a script to prompt users to change
passwords on any or all of their applications at regular intervals, change passwords on any
or all of their applications automatically, or a combination of these processes to meet your
security and regulatory requirements. To run such a script when the password associated
with this application definition expires (as defined in the password policy), enable the run
script option and specify the absolute script path. The script path must be accessible to all
users. Do not use a Universal Naming Convention (UNC) path.

Typically, the script invokes an associated application using a command prompt interface
with a change password parameter.

You can also optionally enable the Use Single sign-on expiration warning. Enabling this
option causes a Single sign-on password expiration warning to appear when the password
policy associated with the application indicates that the password expired. This action
displays a re-occurring message that the associated time period has expired but does not
force a password change action.

Application Definition Wizard Overview
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Form Definition Wizard Overview

The Form Definition Wizard defines the characteristics associated with each user credential
management form included in an application definition.

Use the Form Definition Wizard to:

• Define a form with the Application Definition Wizard.

• Edit an existing form.

• Add a form to an existing application definition.

Use the Form Definition Wizard to define several standard user credential management
forms:

• Logon form

Identifies the logon interface to an application and manages the actions required to
gain access to the associated application.

• Password change form

Identifies the password change interface to an application and manages the actions
required to change the user password to the associated application.

• Successful password change form

Identifies the password change interface to an application and manages the actions
required to acknowledge the successful password change for the associated application.

• Failed password change form

Identifies the unsuccessful password change interface to an application and defines the
actions to take when a credential change operation is unsuccessful.

Password Manager Agent Versions 4.0 and 4.1 do not support successful or failed change
credentials forms and do not respond to application definitions containing these forms.

The data collected for each form performs two functions:

• Uniquely identifies when an application-specific form is started.

• Performs the appropriate user credential processing actions associated with the form.

The Form Definition Wizard is started from the Manage forms page of the Application
Definitions Wizard by selecting Add Form.

The following table shows the form information that is collected for each type of
application (Windows, Web, and terminal emulator-based) using the Form Definition
Wizard.



Data Collected Windows Web Terminal Emulator

Name form X X X

Identify form X X X

Define form actions X X  

Set field detection rules     X

Configure other settings X X X

Confirm settings X X X

Form Definition Wizard Overview
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Defining Windows Type Application
Definitions

Use Windows type application definitions to identify Windows applications, Java
applications, and applications started from an SAP Logon Pad.

For the purposes of defining an application definition, categorize any application launched
by a file with an .exe extension as a Windows application.

To gather information required for Windows application definitions, launch the application
and navigate to the form that requires a user credential management event (user logon,
change password, successful password change, or failed password change) while running the
Form Definition Wizard from the console or from the Application Definition Tool. The
wizard provides instructions for locating and identifying the applicable parts of the
application.

Identifying Forms
When creating application definitions for Windows type applications, use the Identify form
page to provide the information required for Single Sign-On Plug-in to uniquely recognize
the form being defined.

The identifying information includes the Window title and the executable file name. When
Single Sign-On Plug-in detects the executable file name, it monitors the application for the
defined Window titles.

When a window title is detected, Single Sign-On Plug-in performs the actions defined for
the form.

To identify a form
1. If you haven't already done so, start the Windows program and navigate to the user

logon, change password, successful password change, or failed password change form.

2. From the Identify Form page of the Form Definition Wizard, click Select.

3. If the desired program is not highlighted, use the Window selector to choose from the
other available programs.

Identifying Dynamic Window Titles
While on the Identify form page, you can edit the titles in Window titles for this form to
manage dynamic Window title data such as a date or session identifier. To do so, substitute
wildcard characters for dynamic data that appears in the Window title as follows:

Wildcard Description



? Use only for a single dynamic/changing character in a Windows title.

* Use this value to represent dynamic title data for one or more characters.
This value is not recommended for empty Windows titles. Use NULL for these
situations.

NULL Use this value for empty Windows titles (the word “NULL” must be all
uppercase).

Identifying Secure Paths
The Executable file names and paths area displays the name of the identified executable
file and any secure path information.

Secure paths limit recognition of the application to only those program instances initiated
from the paths defined here. If one or more secure paths are identified, Single sign-on
plug-in submits credentials only when the identified program is run from the defined path
and all other defined form identifiers are present.

You can define a secure path by clicking, in the Window selector, Use Full executable path.

If no path information is defined, None provided appears and Single Sign-On Plug-in
provides credential information to any program that matches the other form identifiers.

Separate multiple paths with semicolons. You can use absolute paths or environment
variables to identify the path.

Note: You can use application definitions that include secure path information to create
an application definition template; however, the secure path is not included as part of
the template.

Defining Form Actions
The Define form actions page is used to define the actions that must be performed by the
Single sign-on plug-in to submit the credentials for the specific form being defined.

The top of the page displays the selection of user credentials associated with the specific
form:

  Logon Form Password
Change Form

Successful
Password Change
Form

Failed Password
Change Form

Username/ID X X X X

Password X   X X

Old Password   X    

New Password   X    

Confirm Password   X    

Custom Field 1 X   X X

Custom Field 2 X   X X

OK X X X X
The bottom of the page displays the defined action sequence.

Defining Windows Type Application Definitions
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The objective of this page is to define the actions to be taken by the Single sign-on plug-in
to successfully submit the required user credentials to the identified form.

To define form actions
The following procedure is sufficient for most Windows applications:

1. Click the Set/Change hyperlink associated with a specific user credential. This action
opens the Configure Control Text dialog box used to identify the control to receive the
selected credential.

2. Select the control type candidate to receive the credential. As the different candidates
are selected, the associated control type is visibly highlighted on the application to
make it easier to identify the control type that is to receive the identified user
credential or submit button.

3. Repeat this action for all the user credentials required by the form and for the button
required to submit the form.

Some forms require domains or other user-configurable credentials that must be
successfully submitted to process the form. To accommodate these requirements, two
custom fields are made available. Assign special-requirement credentials to these
fields. The names associated with these fields are defined on the Name custom fields
page of the Application Definition Wizard after the form is defined.

Note: Not all the credentials identified in the top of the Define form actions page
must be configured.

Defining Windows Type Application Definitions
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Identifying Windows Forms with
Advanced Matching

The Identify forms page of the Form Definition Wizard provides enough form identification
matches for most Windows applications. Some user credential management forms require
additional identifiers. For these forms, Single sign-on offers Advanced Matching. You can
access this feature from the Identify form page of the Form Definition Wizard by clicking
Advanced Matching.

Advanced Matching offers five advanced identifiers for Windows applications:

• Class Information

• Control Matching

• SAP Session Information

• Window Identifier

• Identification Extensions

Ignoring Forms Using Class Information
Using the Class Information page, you can identify forms you want Single sign-on to ignore.
If you type a Window class into the Ignore this window class field, the Single sign-on plug-in
does not react when a form with that class information appears.

Do not use this type of matching for .NET applications or applications that use Windows
class 32770 (default class).

This setting is useful when the Window class is dynamic. In this case, use wildcard
characters to match a dynamic Windows class identifier.

Wildcard Description

? Use only for a single dynamic/changing character.

* Use this value to represent dynamic identifier data for one or more
characters. This value is not recommended for empty Windows class
identifiers. Use NULL for these situations.

NULL Use this value for empty Windows class identifiers (the word “NULL” must be
all uppercase).

Use Windows class identifiers when trying to identify one Windows class from among many
possible Windows class targets. The following conditions apply:

• The specified window title and associated executable file result in multiple matching
candidates. This condition most often occurs when the Windows title contains dynamic
data and wild cards are specified.



• The target form must be associated with a unique Window class identifier and all other
candidates must use different Window class identifiers.

To identify class information
Start this procedure on the Identify form page of the Form Definition Wizard.

1. Click Advanced Matching and then select the Class Information option.

2. Click Select to choose the target application from among the applications currently
open on your computer.

Note: To expand your choices, select the Show hidden program windows check box or
the Show child windows check box.

Defining Matching Criteria With Control Matching
When Associated Identifiers are Identical

Some applications assign dynamic information to control labels. In these cases, the window
title, its associated executable application, and the control ID (or IDs) can be the same for
several different user credential management forms while the text labels or other
properties on the form change in response to application-specific events.

For these types of forms, use the control matching configuration options to uniquely
identify a form for a specific plug-in action based on the unique class, style, or text values
associated with control ID (or multiple control IDs if multiple definitions are required to
uniquely identify the form).

To define matching criteria
Start this procedure on the Identify form page of the Form Definition Wizard.

1. Click Advanced Matching and then select the Control Matching option.

2. Click Add Match.

Note: Define only enough control matching criteria to uniquely identify the user
credential management form being defined.

3. From the Define Matching Criteria dialog box, click Select.

4. Right-click a control ID entry.

5. Select Class, Style, or Text to choose a characteristic to be used to qualify the form for
the selected control ID.

6. Repeat Steps 4 and 5 for each control ID that is to be used to uniquely identify the
form.

Identifying Windows Forms with Advanced Matching
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Identifying Matches When Using Multiple SAP
Sessions

Older versions of SAP are managed using the standard Windows and Web application
definitions. However, the Advanced Matching dialog box provides support for SAP
applications when multiple SAP systems are defined to use the same SAP GUI user logon
interface (such as SAP Logon Pad).

SAP Session Information support requires that the SAP administrator enable GUI scripting on
the server. This allows the console and Single sign-on plug-in to interrogate the SAP Logon
Pad and determine the System ID or Server name (or both) required to uniquely identify the
specific user credential management form.

By using the SAP Session Information option, the session information can be extracted from
an SAP window to uniquely identify and differentiate one SAP logon window from another.

To manually define SAP session information
The SAP System ID and Server Name field values can be manually entered. Both fields
accept regular expressions for their respective values. This is useful for controlling the
ability to match multiple servers.

You may also want to manually enter the values to match DNS and NetBIOS names of a
server.

Use the following regular expression format to support both DNS and NetBIOS.

^servername(\.domain\.com)?$

To generate an SAP GUI scripting message
SAP GUI scripting messages can be generated whenever a program attempts to establish a
connection to the SAP LogonPad using the SAP GUI. In this case, a registry setting can be
changed to prevent the message.

The key is HKEY_CURRENT_USER\Software\SAP\SAPGUI Front\SAP Frontend
Server\Security\WarnOnAttach. It is a DWORD. If this key value is set to 0, a message is not
shown. The default value is 1.

Identifying Windows Forms with Advanced Matching
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Windows Type Application Definitions

Windows type application definitions are used to identify Windows applications, Java
applications, and applications that are started from an SAP Logon Pad.

Typically, any application that is launched by a file with an .exe extension is categorized as
a Windows application for the purposes of defining an application definition. Windows
application definitions are created, in part, by identifying parts of the application as it
runs.

In the Single sign-on application definition for a Windows application, information is
provided about the application forms and the fields used to collect user credential
information using the Form Definition Wizard.

The Form Definition Wizard is started when:

• Using the Application Definition Wizard to create a new application definition

• Editing a form in an existing application definition

• Adding a form to an existing application definition.

The type of application being defined is identified when a new application definition is
initiated.
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Window Identifier

The Window Identifier page is used to define a Windows control ID that uniquely identifies a
form when more than one window can be identified using only the defined Windows title
and the executable file name. It is useful only if the Windows control ID can be used to
differentiate among the multiple forms that can be identified.

Select the Enable matching by Window Control ID check box and provide the control ID that
uniquely differentiates the window for the form being defined from all the other possible
forms.
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Identification Extensions

Identification extensions are part of the Application Definition Extensions. These extensions
provide support for using applications that are external to the plug-in software to recognize
the occurrence of a user credential management event and perform the credential
submission process.

Although Single sign-on administrators can generally create application definitions using the
Single sign-on console component and the Application Definition Tool, some applications
have special considerations or requirements that require an alternate means of detecting
the application and submitting the user credentials or performing other similar actions.

To support these applications, Single sign-on administrators can use the Application
Definition Extensions to provide an abstraction for the application controls and the
associated data input mechanisms.

Identification extensions are developed by third-party implementers and implementation is
application-specific. Therefore the procedures required to configure their use are
application-specific.

Generally, Single sign-on administrators are not involved in the development of these
extensions. Extensions are created by third-party implementers. Because configuration of
these extensions is extension-specific, instructions for configuring the extension will most
likely accompany the extension.
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Defining Action Sequences for Windows
Forms Using the Action Editor

Use the Define form actions page to define actions that must be performed by the plug-in
software to submit the credentials for the specific user credential management form being
defined.

For many Windows applications, the basic information gathered in the Form Definition
Wizard is enough to define the form. However some forms require more information, steps,
special keys, or other actions to successfully complete a user credential management task.
For these forms, on the Define form actions page, click Action Editor to open the Action
Editor dialog box.

The Action Editor dialog box consists of:

• Select Actions

Displays all possible action-sequence actions:

• Configure Actions

Used to define the action-specific options to include in the action sequence.

• Sequence Actions

Displays the sequence of defined actions to perform to process the specific user
credential management form.

At the bottom of the Action Editor dialog box is the Advanced Settings button that is used
to access the Advanced Settings dialog box. The Advanced Settings dialog box has two
controls:

• Control ordinal numbers

Select this check box to use control ordinal numbers (often referred to as Z-order)
instead of control ID numbers. Control ordinal numbers are independently enumerated
during the definition process (and by the plug-in software) to uniquely identify the
controls independently of the control ID numbers defined by the application.

Consider selecting this feature defining .NET applications that dynamically generate
control ID numbers or for applications that have duplicate control ID numbers.

• Initial delay

Select this option and define the amount of time that the plug-in software is to delay
processing before beginning the action sequence. A delay can also be configured by
starting the action sequence with a delay using the Insert delay action for additional
information.



Unlike using the Insert delay option that is accessed from the Select Actions area on the
Action Editor dialog box (defined as a send key operation), any initial delay defined
here can be used to avoid creating an application definition that is supported only on
Versions 4.5, 4.6, 4.6 with Service Pack 1, and 4.8 of the Single sign-on plug-in.

Defining Action Sequences for Windows Forms Using the Action Editor 
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To define an action sequence

1. Select an action from among the choices in Select Actions.

2. Configure the action using the Configure Actions options. When you are satisfied with
the configuration settings, click Insert. The configured action appears in Sequence
Actions.

3. Repeat Steps 1 and 2 for all actions required by the user credential form.

4. Select actions in Sequence Actions and click Move Up or Move Down to arrange them in
the correct execution sequence required by the user credential management form
being defined.

5. When satisfied that the action sequence is correct and complete, click OK. This action
returns you to the Define form actions page with the defined action sequence in the
Action sequence area.

6. Click Next to continue the form definition process on the Configure other settings page.
If any combination of form actions limits the defined sequence to the plug-in/agent of
only Password Manager 4.5, Password Manager 4.6, Password Manager 4.6 with Service
Pack 1, and Single sign-on 4.8, a message appears to allow you to continue or return to
modify your configuration.
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Action Descriptions

In the following descriptions, each action is identified as a control ID operation, send key
operation (mimic a keystroke), or advanced operation. To avoid creating an application
definition that is not supported by Versions 4.0 and 4.1 of the plug-in software, identify
action sequences that include only control ID operations or only send key operations.
Password Manager Agent Versions 4.0 and 4.1 do not support action descriptions and do not
respond to application definitions containing these action descriptions.

As you make your selections, click Insert.

Set Control Text (Control ID Operation)
Use this action to assign user credential values to their target window controls on the form.
Only unassigned user credential values appear in the list. Selecting this option displays all
the editable controls in the selected form. As a Window control is selected, the associated
control is visibly highlighted in the application to assist in assigning the correct user
credential value to a control. To assign a value to a control, select a User credential value
and its associated control.

Submit Form
Use this action to associate a submit action with a button. Select Click a window button
(control ID operation) to associate the button to use on the form for the submit action, or
select Send the ENTER key (send key operation).

As a Window button is selected, the associated control is visibly highlighted in the
application to assist in assigning the correct user credential value to a control.

Send Text to Window (Send Key Operation)
Use this action to send text or a user credential value to the form as a send key operation.
When sending user credential values, only unassigned user credential values appear in the
list.

Send Hot Key (Send Key Operation)
Use this action to send any combination of key modifiers and a selected key to the form.

Send Special Key (Send Key Operation)
Use this action to send a special key to the form. To send a value to the form, select a
Category value and a Key value.



Insert Delay (Send Key Operation)
Use this action to wait for the defined amount of time before processing the next action in
the action sequence. To insert a delay, enter a value in the Length of delay.

Launch Action Extension (Advanced Operation)
Action extensions are part of the Application Definition Extensions. These extensions
provide support for using applications that are external to the plug-in software to recognize
the occurrence of a user credential management event and perform the credential
submission process.

Although Single sign-on administrators can generally create application definitions using the
Single sign-on component to the Delivery Services Console and the Application Definition
Tool, some applications have special considerations or requirements that require an
alternate means of identifying an application and submitting the user credentials or
performing other similar actions.

To support these applications, Single sign-on administrators can use the Application
Definition Extensions to provide an abstraction for the application controls and the
associated data input mechanisms.

The extensions developed by third-party implementers are application-specific. Therefore
the procedures required to configure their use are application-specific.

Generally Single sign-on administrators are not involved in the development of these
extensions. Extensions are created by third-party implementers. Because configuration of
these extensions is extension-specific, instructions for configuring the extension will most
likely accompany the extension.

Action Descriptions
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Considerations for Windows Type
Definitions

When defining Windows type application definitions, consider the following:

• Application templates help reduce the effort of creating application definitions. Citrix
provides application templates for many commonly used applications. If the template
you are looking for is not available with the installed product, go to the Citrix Web site
(http://citrix.thinkbuilddeploy.com/index.php) to see if an existing template is
available.

• Test your application definitions with the plug-in software before you make them
available to users.

• Most application definitions work using only the basic information. If an application
definition does not work as expected in your test environment, it may be due to unique
features such as a dynamic window title, dynamic control IDs, or other special
identifiers or actions that were programmed into the application.

• To export application definitions from your test environment to your production
environment, use the Export administrative data task from the Single sign-on
component of the Delivery Services Console.

• Settings that are selected at the application definition level apply to all forms within
the application definition.

• Some settings that are selected at the application definition level can be overridden at
the form level. For example, for an application with three defined forms, the
auto-submit can be enabled at the application definition level. Each time the plug-in
software encounters one of these three forms for this application, the user credentials
are supplied and submitted automatically. However, auto-submit can be disabled for
one of the forms at the form level and the plug-in software will not submit the
information for that specific form automatically—in this case the user is required to
click Submit or OK for the selected form.

• To create a hot key for the custom field name, place an ampersand (&) in the field
name immediately before the letter you want to specify as the hot key.

If no hot key is identified, the plug-in software dynamically appends a numeric value as
the hot key for the control. This will appear on the button as (1) or (2) depending on
the number of custom fields that are defined.

Be sure to test the resulting form to ensure that the defined name does not exceed the
amount of space allocated to the custom field name.

http://citrix.thinkbuilddeploy.com/index.php
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Web Type Application Definitions

Web type application definitions are used to identify Web-based applications, including
Java applets.

Typically, any application that runs in a browser is categorized as a Web application for the
purposes of defining an application definition. Single sign-on supports Web applications
running on Internet Explorer Versions 6.0, 7.0, and 8.0.

Web application definitions are created, in part, by identifying parts of the Web application
as it runs.

In the Single sign-on application definition for a Web application, information is provided
about the application forms and the fields used to collect user credential information using
the Form Definition Wizard.

The Form Definition Wizard is started when:

• Using the Application Definition Wizard to create a new application definition

• Editing a form in an existing application definition

• Adding a form to an existing application definition.

The type of application being defined is identified when a new application definition is
initiated.
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Gathering the Information Required for
Web Application Definitions

To gather the information required for Web application definitions, launch the application
and navigate to the form that requires a user credential management event (user logon,
change password, successful password change, or failed password change) while running the
Form Definition Wizard from the console or from the Application Definition Tool. The
wizard’s on-screen text provides instructions for locating and identifying the applicable
parts of the application.
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Name Form

When creating application definitions for Web type applications, the Name form page of the
Form Definition Wizard is used to:

• Assign a user-defined name to the form being created

• Identify the type of form being created

• Identify any special actions

Consider that the name assigned to the form appears on the Manage forms page of the
Application Definition Wizard. Assign a name that is meaningful to the type of form being
defined.

Several types of standard user credential processing forms can be defined using the Form
Definition Wizard including:

• Logon form

Used to identify the logon interface to an application, and to manage the user
credential actions required to gain access to the associated application.

• Password change form

Used to identify the password change interface to an application, and to manage the
user credential actions required to change the user password to the associated
application.

• Successful password change form

Used to identify the password change interface to an application, and to manage the
user credential actions required to acknowledge the successful change to a password
for the associated application.

• Failed password change form

Used to identify the unsuccessful password change interface to an application, and to
define the actions to take when a credential change operation is unsuccessful.

Password Manager Agent Versions 4.0 and 4.1 do not support successful or failed change
credentials forms and do not respond to application definitions containing these forms.

Use the Special actions area to identify any special form treatments for the form being
defined:

• No special action

Select this option for normal Web form processing.

• Redirect to Windows application



Select this option when no form is recognized for the web application in the Web Form
Wizard. This occurs when the Web application uses ActiveX controls, Flash-based
controls, some types of Ajax controls, or other non-HTML based controls used to
manage user credential management events.

• Ignore this form when it is detected by the plug-in software

Select this option to have the plug-in software ignore the form.

Name Form
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Identify Form

When creating application definitions for Web type applications, the Identify form page is
used to provide the information required to have the Single sign-on plug-in software
uniquely recognize the form being defined.

Web applications are identified using the URL address associated with the user credential
management form being defined.

Click Select to open the Web page selector. Use the Web page selector to identify the Web
page you want to associate with the form.

After completing the Web page selector, you are returned to this page. Two check boxes
are available to manage how to interpret identified URLs:

• Strict URL matching

Select this check box to recognize only user credential management events from Web
applications that are started using the specified URL(s). Some URLs may contain
dynamic data such as session management identifiers, application parameters, or other
identifiers that can change for each instance. In these circumstances, using strict
matching results in the URL not being recognized.

• Case-sensitive URL

Select this check box to use exact case matching URL(s).
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Define Form Actions

The Define form actions page is used to define the actions that must be performed by the
Single sign-on plug-in to submit the credentials for the specific form being defined.

The top of the page displays the selection of user credentials associated with the specific
form:

  Logon Form Password
Change Form

Successful
Password Change
Form

Failed Password
Change Form

Username/ID X X X X

Password X   X X

Old Password   X    

New Password   X    

Confirm Password   X    

Custom Field 1 X   X X

Custom Field 2 X   X X

OK X X X X
The bottom of the page displays the defined action sequence.

The objective of this page is to define the actions to be taken by the plug-in software to
successfully submit the required user credentials to the identified form.

For many Web applications, the following process is all that is required:

1. Click the Set/Change hyperlink associated with a specific user credential. This action
opens the Configure Field Text dialog box used to identify the field to receive the
selected credential. If the form is already open, this dialog box displays all the possible
candidates for the field type associated with the selected user credential or submit
option.

If the application credential form is not currently open, start the application and
navigate to the correct user credential form. Then select the Refresh . After the
application form is selected, this dialog box is populated with field type candidates that
are appropriate for the selected user credential.

2. Select the field type candidate to receive the credential. As the different candidates
are selected, the associated field type is visibly highlighted on the application to make
it easier to identify the field type that is to receive the identified user credential or
submit button.

3. Repeat this action for all the user credentials required by the form and for the button
required to submit the form.

Some forms require domains or other user-configurable credentials that must be
successfully submitted to process the form. To accommodate these requirements, two



custom fields are made available. Assign special-requirement credentials to these
fields. The names associated with these fields are defined on the Name custom fields
page of the Application Definition Wizard after the form is defined.

Note: Not all the credentials identified in the top of the Define form actions page
must be configured.

For many Web applications, after you define which fields on the form are to receive the
identified user credential and which button to select to submit the form, you have
completed the form action definition process and you can continue with the next page in
the wizard.

However some forms require more information, steps, special keys, or other actions to
complete a credential management task successfully. For these forms, click Action Editor to
open the Action Editor dialog box.

Define Form Actions
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Defining Action Sequences for Web
Forms Using the Action Editor

Use the Define form actions page to define actions that must be performed by the plug-in
software to submit the credentials for the specific user credential management form being
defined.

For many Web applications, the basic information gathered in the Form Definition Wizard is
enough to define the form. However some forms require more information, steps, special
keys, or other actions to successfully complete a user credential management task. For
these forms, on the Define form actions page, click Action Editor to open the Action Editor
dialog box.

The Action Editor for Web dialog box consists of:

• Select Actions

Displays all possible action-sequence actions:

• Configure Actions

Used to define the action-specific options to include in the action sequence.

• Sequence Actions

Displays the sequence of defined actions to perform to process the specific user
credential management form.
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Configure Other Settings

For Web definitions, the Configure other settings page is used to specify if the Web page’s
submit button is pressed automatically by the plug-in software or if the user is required to
manually press the button.

Select Submit this form automatically to submit the form without user intervention.
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Redirect to Windows Application
Configuration

When no form is recognized for the Web application in the Web Form Wizard, the form
definition must be redirected to use a form definition defined for a Windows application.

Forms may not be recognized when the Web application uses ActiveX controls, Flash-based
controls, some types of Ajax controls, or other non-HTML-based controls used to manage
user credential management events.

In these cases, ensure that the Redirect to Windows application check box is selected on
the Name form page. Click Next to progress through each of the remaining Form Definition
Wizard pages, and click Finish on the Confirm settings page.

The form recognition characteristics and credential actions must now be defined using
Windows type definitions and send key actions.
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Advanced Settings Dialog Box for Web
Applications

Some Web applications use dynamic URLs. When this condition is encountered, additional
form definition criteria (referred to as detection matching entries) must be used to
uniquely identify a specific user credential management form.

These detection matching entries are defined using the Match Detail dialog box and appear
on the Advanced Settings dialog box. To access the Match Detail dialog box, click Advanced
Matching on the Identify form page to access the Advanced Settings dialog box, then click
Add.

Use the Match Detail dialog box options and controls to define the criteria used to uniquely
identify a specific user credential management form. It works by looking for specific values
in the tagged content of the HTML form presented to manage a specific user credential
management action. You need to define only enough match conditions to uniquely identify
the user credential management form being defined.

Type the Web element you want to match in the Find box. If the element is not found,
expand the Additional Settings section to manually identify the element.

The Additional Settings section is divided as follows:

• Tag

This field is used to search for the identified HTML tag. If the specific instance of the
tag is known, select Match this instance and identify which instance in the document to
use. If no specific instance is identified, all instances in the document are evaluated.
Only the tag needs to be specified, not the delimiter (for example p rather than <p>).
As a guideline, select the tag nearest to the content you are matching.

Note: Because the Match this instance option can vary from browser to browser, use
this feature only when necessary and test your configuration well.

• Value Type

This area is used to define the criteria to match. Select one of the following criteria:

Criteria Description

Text Can be any text found in the HTML code.

HTML Any specific code found within the specified tag.

Attribute Any attribute of the HTML code (such as a name attribute of a form
tag)

• Value to match

This field is used to enter the value to match. Select Match the whole value to enforce
strict matching of the value (any unspecified text that is in the tag element will cause
the match to fail). Include all delimiters and quotes that could be encountered.



Note: Match the whole value should be selected only when there are multiple
instances of similar matching criteria.

• Operator

This area is used to define the relationship of this match entry to others defined for this
form. The options include:

Options Description

AND Select this option when this match entry is one of multiple matches
that must succeed to identify the form. By selecting this option the
current match outcome is compared with the next match outcome. If
both are true, the match succeeds.

OR Select this option when this match alone can successfully identify the
form. By selecting this option, the current match outcome is
compared with the next match outcome. If either is true, the match
succeeds. This option is used for single match definitions.

NOT Select this operation to apply negative logic to the operator. This
operator is used to define match criteria that should not appear on
the page to succeed.

Advanced Settings Dialog Box for Web Applications
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Terminal Emulator Type Application
Definitions

Terminal Emulator type application definitions are used to identify terminal emulator-based
applications including mainframe, AS/400, OS/390, or UNIX. Single sign-on provides single
sign-on functionality to terminal emulator-based applications that implement a High-Level
Language Application Programming Interface (HLLAPI), or that have a built-in scripting
language that can display a dialog box.

Gathering the Information Required for Terminal
Emulator Application Definitions

Usually the best (and simplest) way to gather the information required for terminal
emulator (HLLAPI) application definitions is to launch the application.

Terminal emulator-based application definitions are created using the Form Definition
Wizard. The wizard is used to identify one or more text strings that must be present (or not
present) on the terminal emulator-based application screens for a specific user credential
management form (user logon, change password, successful password change, or failed
password change).

As you navigate to the user credential management form being defined, record all the user
actions required to access the form. These actions must be provided in the form definition
for each form while running the Form Definition Wizard from the console or from the
Application Definition Tool.

After identifying the correct user credential management form, the coordinates of the data
entry fields used for submitting the appropriate user credential information to the
application are defined. These are defined by specifying the sequence of actions, or
keystrokes required to move between fields or screens and enter text.

The Form Definition Wizard is started when:

• Using the Application Definition Wizard to create a new application definition

• Editing a form in an existing application definition

• Adding a form to an existing application definition

The type of application being defined is identified when a new application definition is
initiated.
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Form Definition Process

The form definition process consists of collecting the form-specific identification
information and action information using the following pages in the Form Definition Wizard
for terminal emulator-based applications:

• Name form

• Identify form

• Set field detection rules

• Configure other settings

• Confirm settings

After completing the actions required for a specific page, click Next to proceed through the
wizard. The Back button is generally available on each page to return to some previously
configured options. However, changing previously configured options may require you to
alter subsequent settings.
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Name Form

When creating application definitions for terminal emulator (HLLAPI) type applications, the
Name form page of the Form Definition Wizard is used to:

• Assign a user-defined name to the form being created

• Identify the type of form being created

Consider that the name assigned to the form appears on the Manage forms page of the
Application Definition Wizard. Assign a name that is meaningful to the type of form being
defined.

Several types of standard user credential processing forms can be defined using the Form
Definition Wizard including:

• Logon form

Used to identify the logon interface to an application, and to manage the user
credential actions required to gain access to the associated application.

• Password change form

Used to identify the password change interface to an application, and to manage the
user credential actions required to change the user password to the associated
application.

• Successful password change form

Used to identify the password change interface to an application, and to manage the
user credential actions required to acknowledge the successful change to a password
for the associated application.

• Failed password change form

Used to identify the unsuccessful password change interface to an application, and to
define the actions to take when a credential change operation is unsuccessful.

Password Manager Agent Versions 4.0 and 4.1 do not support successful or failed change
credentials forms and do not respond to application definitions containing these forms.

If the terminal emulator you are using displays more than one logon or password change
page, you must create a form for each page.
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Identify Form

When creating application definitions for terminal emulator (HLLAPI) type applications, the
Identify form page is used to provide the information required to have the Single sign-on
plug-in software uniquely recognize the form being defined.

Terminal emulator-based applications are identified by locating text strings that appear at
specified row and column locations on the terminal emulator-based application page. Only
enough text string matches required to uniquely identify the host need to be defined.

To add a text-match qualification entry
1. Ensure that the terminal emulator-based application is started and that you already

determined the text strings to be used to uniquely identify the target application.

2. On the Identify form page of the Form Definition Wizard, click Add to add a new text
match entry to the list of text match entries used to qualify the application. This action
opens the Text to Match dialog box.

3. Complete the following fields on the Text to Match dialog box:

• Text string

Enter the exact text that will be used to identify the application.

• Row

Enter the exact row number for the string.

• Column

Enter the exact column number for the string.

Note: When the plug-in software scans a terminal emulator-based application, the
screen is searched for the exact text string to appear at the defined row and column
location. If the text at the defined coordinates does not match the specified text, the
screen is ignored.

4. Click OK. The defined Text to Match entry appears on the Identity form page.

Often, more than one text string must be defined to exactly identify the correct start of
the target terminal emulator-based application. If more Text to Match strings are required,
repeat Steps 2 through 4 for each string.
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Set Field Detection Rules

The Set field detection rules page is used to identify the location and key actions required
to manage the user credential form being defined.

The objective is to create field entries that indicate the user credential to process, the
location on the screen where the user credential is to be inserted (row and column
coordinates), and the keystrokes required to advance the cursor to the next credential or
submit action.

To add a field entry
1. Click Add to open the Define Field dialog box.

2. Complete the following fields on the Define Field dialog box:

• Field function

Select the user credential to be submitted from among the choices that appear in
the drop-down list box.

• Row

Enter the exact row number for the string.

• Column

Enter the exact column number for the string.

• Keys after

Enter the key codes required to advance to the next credential field or to perform
the submit action

Note: Select the Virtual key codes hyperlink to access help information about the
valid key codes.

3. Click OK. The defined field entry appears on the Set field detection rules page.

4. Repeat Steps 1 through 3 for each user credential required by the form being defined.

5. The field entries displayed on the Set field detection rules page are processed from top
to bottom as they appear on the page. Use the UP ARROW and DOWN ARROW keys to
arrange the entries in the sequence required by the user credential form being
processed.
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Configure Other Settings

The Configure other settings page is used to access advanced settings options for the form
being defined. Advanced settings include:

• Defining an initial form processing delay

• Defining the keystrokes required to access the user credential management form being
defined

• Defining text string matching criteria that tells the plug-in software to ignore
processing

If any additional advanced configuration is required for the user credential management
form being defined, click Advanced to open the Advanced Settings dialog box.
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Advanced Settings for Terminal
Emulator-Based Applications

Some terminal emulator-based applications require additional configuration support to
ensure that the correct user credential management form is identified. That might include:

• Waiting a defined amount of time for the terminal emulator-based application to start
before attempting to identify the application

• Processing a series of keystrokes to navigate to the initial logon page or change
password page

• Ignore processing a page when specific text appears

When advanced configuration settings are required for the user credential management
form being defined, click Advanced on the Configure other settings page of the Form
Definition Wizard to open the Advanced Settings dialog box.

The Advanced Settings dialog box has two configuration pages that are accessed from the
left panel on the page:

• Highlight the Host Form Additional Settings option to access the Additional settings
options:

• Delay field entries (ms). Enter the number of milliseconds to delay processing the
form while waiting for the application to complete loading.

• Keys before. Enter the virtual key codes that must be entered to access the first
field of the user credential management form being processed. Select the Virtual
key codes hyperlink to access the help for the valid virtual key codes.

• Highlight the Ignore Match option to access the Text match to stop credential
submission option. This option is used to specify text strings that appear on the
application page for forms that are to be ignored.
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Considerations for Terminal Emulator
Type Definitions

Consider the following factors when defining terminal emulator (HLLAPI) type application
definitions:

• Terminal emulation support must be enabled for each user configuration that uses
terminal emulator-based applications.

• Verify that your terminal emulator program is HLLAPI compliant.

• Verify that your terminal emulator program is defined in the plug-in software
mfrmlist.ini file.

• Save time by using a terminal emulator that shows the row and column coordinates of
the cursor position. This allows you to more easily determine the location of the text
and fields used to identify the host application and its logon forms.

• For HLLAPI detection, the terminal emulator must set a short name for each session.
The plug-in software cannot detect an application without the terminal emulator’s
session short name.

• The documentation for your terminal emulator-based application may include unique
identifiers, such as screen numbers, for the screens used to submit user logon
information. In this case, use the screen number as the unique identifier that ensures
the plug-in software identifies and submits credentials to the correct form.
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Terminal Emulation Support

The supported terminal emulators are included in a Mfrmlist.ini file. This file represents all
the terminal emulators tested by Citrix.

It is possible to add terminal emulators to this list. However, these definitions should be
tested and verified before being introduced into your production environment. A sample
section of this file is included below:

[Emulators]
Ver=20021101
EMU1=Rumba6
EMU2=Attachmate myExtra!
EMU3=Attachmate Extra! 6.3
EMU4=Attachmate Extra! 6.4
EMU5=Attachmate Extra! 6.5
EMU7=Attachmate Extra! 7.1
EMU8=Reflection7
EMU9=Reflection8
EMU10=Reflection9
EMU11=Reflection10
EMU12=PCOM
EMU13=HostOnDemand 4.1
EMU14=GLink
EMU1EMU16=ViewNow5=Aviva
EMU16=ViewNow
EMU17=ZephyrPC
EMU18=ZephyrWeb
;EMU19=BOSaNOVA
;EMU20=HostExplorer6
;EMU21=HostExplorer8
[Rumba6]
DisplayName=Rumba
RegistryLoc=WALLDATA\Install
ValueName=
DLLFile=SYSTEM\EHLAPI32.DLL
UpdateNotificationHandling=0.FirstLogin
Process=shared
ConvertPosType=long
QuerySessionsType=long
QuerySessionStatusType=long
QueryHostUpdateType=long
StartNotificationType=long
IntSize=16
WindowClass=WdPageFrame
WindowTitle=RUMBA

The terminal emulator entries in the [Emulators] section of the Mfrmlist.ini file must be in
numeric sequence, from EMU1 up to and including EMU99. Any break in sequence causes the



Ssomho.exe process to terminate before reading all of the entries.

Removing or commenting out unused terminal emulators can improve the startup process.
Ssomho.exe does not waste resources or time scanning for the location of unnecessary
HLLAPI DLLs.

To comment out an entry, move the entry to the bottom of the list, place a semicolon
before the entry, and then renumber the remaining EMU entries so no numeric value is
skipped.

Single sign-on cannot globally update this mfrmlist.ini file; you must overwrite the file
manually after installing the plug-in. For large deployments, consider using batch files or
scripts run through System Management Server (SMS), CA-Unicenter, or Active Directory
software installation.

Terminal Emulation Support
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Mfrmlist.ini Field Definitions

Terminal emulators added to the Mfrmlist.ini file will function only if they follow the
HLLAPI standard. The field definitions for the Mfrmlist.ini file are provided below. If you
must add a terminal emulator definition, check with the terminal emulator’s manufacturer
to determine whether or not the terminal emulator supports HLLAPI and to obtain the
correct field definition entries. To determine whether or not a terminal emulator works
with Single sign-on, test it outside of your production environment.

Field Definitions

[EmulatorName] The value for EmulatorName must match the value used for
the EMUnn=EmulatorName line in the [Emulators] section.

GroupName Internal use only.

DisplayName The display name of the terminal emulator, which will be
one of the two parameters used when spawning a new
process to handle the session. Must be unique to the
Mfrmlist.ini file.

RegistryLoc The registry key in HKEY_LOCAL_MACHINE\SOFTWARE that
points to the path where the HLLAPI DLL is stored. If the
program does not store this information in
HKEY_LOCAL_MACHINE\SOFTWARE, use the ExplicitPath
setting instead of the RegistryLoc setting. If both
RegistryLoc and ExplicitPath settings are defined, the
ExplicitPath setting takes precedence.

ExplicitPath The explicit path of the HLLAPI DLL file used by this
emulator. This setting is used in place of the RegistryLoc
setting when the emulator program does not store the
HLLAPI DLL location in the system registry. If both
RegistryLoc and ExplicitPath settings are defined, the
ExplicitPath setting takes precedence.

ValueName The name of the value in the RegistryLoc key that contains
the actual path value.

DLLFile The name of the HLLAPI DLL file.

StripFileName Indicates the value stored in ValueName contains a
backslash \ that must be stripped when assembling the
HLLAPI DLL path from ValueName and DLL File entries.

IntSize Defines the integer size supported by the terminal emulator,
16-bit or 32-bit.

WindowClass The Window Class name for the terminal emulator. Obtained
by using the Single sign-on console or the Application
Definition Tool.



WindowTitle A portion of the Window Title that can be used by Single
sign-on to ensure this window is associated with the terminal
emulator. Must contain at least one word that will always be
in the Windows title. Wildcards are assumed on either side
of the text

UseSendKeys Instructs Single sign-on to use SendKeys for communicating
with the terminal emulator. The option is not the same as
the one used for Windows applications.

Mfrmlist.ini Field Definitions
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Creating User Configurations

A user configuration enables you to control the behavior and appearance of the plug-in
software for users. Creating one or more user configurations is the final step you take
before distributing Single sign-on plug-in software to users in your environment. Note that
you can add new or edit existing user configurations at any time.

A user configuration is a unique collection of settings, password policies, and applications
that you apply to users associated with an Active Directory hierarchy (organizational unit
[OU] or an individual user) or Active Directory group.

A user configuration consists of the following:

• Users associated with an Active Directory domain hierarchy (OU or individual user) or
Active Directory group

Important: Distribution groups and Domain Local groups in Active Directory mixed
mode are not supported.

• License type and related settings associated with the users (concurrent or named user
license model)

• Data protection methods

• Application definitions that you created, which you can combine into an application
group when you create a user configuration

• Password policies associated with any application groups

• Self-service features (account unlock and password reset) and key management options
(use of previous passwords, security questions, and automatic key management)

• Settings for options such as credential provisioning and application support

Before you create your user configurations, ensure that you already created or defined the
following:

• Central store

• Application definitions

• Password policies

• Security questions

You must create user configurations before you deploy the Single sign-on plug-in software
to users. Among other settings, a user configuration contains the license server and
licensing information required by the plug-in software for operation.
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Default User Configuration Properties

User Configuration Property Default Setting

Account Association  

  Account association default
domain

Not provided

  Account association default
service address

Not provided

  Allow users to associate
accounts

No

  Allow users to edit domain No

  Allow users to edit service
address

No

  Allow users to remember
password

No

Plug-in User Interface  

  Display computer name in
notification icon ToolTip

No

  Set the default columns and
column order shown in
Logon Manager

Application Name

Description

Group

Last Used

Modified

Password

URL/module

Username ID

  Show notification icon Yes

  Specify the length of time
plug-in delays credential
submission

No

0 seconds

Application Support  

  Detect client-side
application definitions

Yes

  Client-side application
definitions

All applications



  Enable support for terminal
emulators

No

  Number of domain name
levels to match

99

  Time interval in which
plug-in checks the terminal
emulator for changes

3000 milliseconds

Basic Plug-in Interaction  

  Allow users to pause Single
sign-on plug-in

Yes

  Allow users to reveal all
passwords in Logon Manager

No

  Automatically detect
applications and prompt
user to store credentials

Yes

  Automatically process
defined forms when Single
sign-on plug-in detects
them

Yes

  Force re-authentication
before revealing user
passwords

Yes

  Notify user when Single
sign-on plug-in
synchronization fails

Yes

  Time between
re-authentication requests

8 hours

Client-side Interaction  

  Delete user’s data folder
and registry keys when
Single sign-on plug-in is
shut down

No

  Enable users to cancel
credential storage when a
new application is detected

Yes

  Enforce password matching
during initial credential
setup

Yes

  Limit the number of days to
keep track of deleted
credentials

180 days

  Log Single sign-on plug-in
events using Windows event
logging

No

Data Protection Methods  

Default User Configuration Properties
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  Allow protection using
blank passwords

No

  Allow Smart Card PINs No

  Microsoft Data Protection
API

No

  Regulate account
administrator access to
data

Yes

  Smart Card Certificate No

  Smart Card key source Smart Card Data Protect

  Use data protection as in
Password Manager 4.1 and
previous versions

No

  Users’ authentication data Yes

Hot Desktop  

  Enable graphic No

  Enable session indicator Yes

  Graphic path  

  Lock time-out 10 minutes

  Session settings script path  

  Session time-out 5 minutes

Key Management Module  

  Key Management service
location

 

Licensing  

  Allow license to be
consumed for offline use

No

  Continue without validating
licensing information

No

  Disconnected mode period
(concurrent user )

1 hour 30 minutes

  Disconnected mode period
(named user )

21 days

  License server name  

  Licensing model Concurrent User Licensing
(Enterprise and Platinum
Edition only)

  Port number server:port

  Use default port Yes

Product Edition  

  Product edition Select Product edition

Default User Configuration Properties
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Provisioning module  

  Use provisioning No

  Provisioning service
location

 

Secondary Data Protection  

  Identity verification method Previous Password

Self-Service Features  

  Allow users to reset their
primary domain password

No

  Allow users to unlock their
domain account

No

Synchronization  

  Allow Single sign-on plug-in
to operate when unable to
reconnect to central store

Yes

  Allow users to update
Single sign-on plug-in
settings

Yes

  Allow user credentials to be
accessed through the
Credential Synchronization
Module

No

  Specify the time between
automatic synchronization
requests

No

0 minutes

  Synchronize every time
users launch recognized
application or Logon
Manager

No

User Configuration Name  

  Specify how you will
associate this user
configuration to users

Active Directory Hierarchy
(OU or User)

Default User Configuration Properties
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To specify a domain controller for an
existing user configuration

In environments where you use an Active Directory-based central store and have more than
one domain controller, you can select the domain controller to bind user configurations to
when writing to the central store.

This binding scheme helps to reduce synchronization delays caused by Active Directory
replication. Such delays might occur in environments where users access Single sign-on in
multiple Active Directory sites simultaneously.

During the discovery process available through the console, Single sign-on can discover
every domain controller in your domain. You can then bind user configurations that you
created to a specific domain controller by selecting that controller when you create a user
configuration.

For example, you can require users to be bound to a domain controller within their local
network. After you specify a domain controller, users are bound to that domain controller
the next time they log on to Single sign-on.

By default, users bind to any writeable domain controller until you select a domain
controller they must bind to. You can change the domain controller setting at any time by
updating the user configuration as needed without losing user data integrity.

Note: When choosing a domain controller for binding, verify that the resources available
on the domain controller can accept the communication traffic users generate when
connecting to the domain controller during peak operational times.

If the specified domain controller is unavailable or offline, the plug-in software uses the
local store’s user data (that is, the user data located on the user’s computer). If the domain
controller is offline for a long period of time (as defined by you), you can select the Edit
User Configuration task from the console and choose another domain controller or the Any
writeable domain controller option.

1. Click Start > All Programs > Citrix > Management Consoles > Citrix Delivery Services
Console.

2. Expand the Single sign-on node and User Configurations.

3. Select a user configuration.

4. From the Action menu, select Edit user configuration.

5. Select Domain Controller from the options on the left side of the Edit User
Configuration wizard page.

6. Select an available domain controller or select Any writeable domain controller.
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To create a user configuration

1. Click Start > All Programs > Citrix > Management Consoles >Citrix Deliver Services
Console.

2. Expand the Single sign-on node and select User Configurations.

3. From the Action menu, click Add new user configuration.

Naming Your User Configuration
The Name User Configuration page of the User Configuration Wizard allows you to name
your user configuration as well as choose how you will associate the user configuration to
the users.

• Name

Consider naming the user configuration according to how you plan to group your users
and associate them with specific applications. For example, Marketing Users, Software
Development Users, North American Users, and so on.

• User configuration association

You have two choices: associate users according to Active Directory hierarchy (OU or
individual user) or Active Directory Group. If necessary, you can associate the user
configuration with a different hierarchy or group later, by clicking Move user
configuration in the Action menu.

Important: How you organize your Active Directory environment might affect how
user configurations operate. If you use both (Active Directory hierarchy and group)
and a user is located in both containers, the user configuration associated with the
hierarchy takes precedence and is the one used. This scheme is considered a mixed
environment.

Also, if a user belongs to two Active Directory groups and each group is associated with
a user configuration, the user configuration with the highest priority takes precedence
and is the one used.

Associating user configurations to groups is supported only in Active Directory domains
that use Active Directory authentication.

Specifying a Domain Controller
If you are using an Active Directory central store, the Specify Domain Controller page of the
User Configuration Wizard enables you to select an available domain controller or select
Any writeable domain controller.
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Choose Applications

From the Choose applications page of the User Configuration Wizard, add the applications
for the user configuration. When you click the Add button, a dialog box showing the
application definitions you created previously appears. You can now combine these
application definitions in an application group. An application group can contain several
applications or as few as one application.

You can also make the application group a password sharing group to automate and simplify
the password change process. If the password for an application definition that is part of a
password sharing group changes, the plug-in software ensures that the password change is
reflected in the stored credentials for all applications in the group.

Password sharing groups enable the plug-in software to manage multiple credentials for
applications that use the same authentication authority. For example, if you have two
applications that use the same Oracle database to authenticate, such as a financial
application and a human resources application, you can place these two applications in the
same password sharing group. When your users change their password for either
application, the other application’s credentials are updated automatically.

Important: For best results, ensure that all passwords in the password sharing group are
managed by a common authentication authority. For example, you would implement a
password sharing group if the applications in a password sharing group share a common
back-end authentication authority like a database, where the user would submit the same
credentials to each application to authenticate to the database. You would not group
unrelated applications like an email program, a Web application, and a custom single
sign-on enabled program on your intranet where a user could potentially submit three
different sets of credentials, but only by coincidence is using the same credentials for all
three applications. In this case, if a user changed the credentials for one application in
this password sharing group, it does not necessarily follow that those credentials would
be valid for the other two applications.
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Configure Plug-in Interaction

The Configure Single sign-on plug-in interaction page of the User Configuration Wizard
enables you to determine the user experience for all plug-in software users in your
environment.

• Allow users to reveal all passwords in Logon Manager

Select this option to allow users to see the password associated with the applications in
the user configuration.

Note: To allow users to see their application passwords, you must also enable the
reveal password option in the the password policy you selected on the Choose
applications page.

• Force re-authentication before revealing user passwords

Select this option to force users to enter their Windows credentials first before allowing
them to see their passwords. It is enabled by default. You can enable or disable this
option if you enabled Allow users to reveal all passwords in Logon Manager.

• Allow users to pause Single sign-on plug-in

Select this option to enable users to prevent the plug-in software from submitting
credentials to applications. In this case, the plug-in software temporarily does not
detect or respond to applications and users must submit their credentials manually. The
plug-in is paused but not shut down.

• Notify user when synchronization fails

Select this option to notify users when plug-in synchronization fails. Depending on how
Allow Single sign-on plug-in to operate when unable to reconnect to central store on
the Advanced Settings > Synchronization page is set, users may be able to continue
working after a synchronization failure.

• Automatically detect applications and prompt user to store credentials

Select this option to prompt users to submit their credentials to Single sign-on for
applications newly detected by the plug-in software.

Clear this option to disable the Single sign-on plug-in software’s ability to detect any
applications that are not associated with this user configuration. If this option is
cleared, users must submit credentials manually to these applications. Use this setting
to prevent users from adding applications that are not currently part of their assigned
user configuration to their set of SSO-enabled applications.

If cleared, this option overrides the Enable users to cancel credential storage when a
new application is detected option available on the Advanced Settings > Client-Side
Interaction page. Also, if you plan to use provisioning, clearing this option prevents
users from being prompted to enter their credentials.

• Automatically process defined forms when the Single sign-on plug-in detects them



Select this option to enable the plug-in software to submit stored credentials
automatically without user intervention. Credential fields in the application will
automatically populate if you enabled the corresponding setting Submit this form
automatically in the application definition associated with this user configuration.

• Time between re-authentication requests

Specify the time between plug-in reauthentication requests. When the time expires,
the user’s device is locked and users must reauthenticate by typing their Windows
credentials. Minimum allowed value is one minute.

Configure Plug-in Interaction
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Advanced Settings

Click Advanced Settings on the Configure Single sign-on plug-in interaction page of the User
Configuration Wizard to access these settings.

Control Description

Plug-in User Interface

  Display computer
name in
notification icon
ToolTip

Controls whether the computer name appears in the notification
icon ToolTip (in the notification area of the user’s toolbar). If
enabled, the computer name is appended to the notification icon
ToolTip. This option is helpful in Citrix XenApp environments or
mixed environments (published and local applications) to help the
user identify which plug-in is running.

  Show notification
icon

Enabled by default. Controls whether or not to show the Citrix
Single sign-on notification icon when the plug-in software is active.
When the icon is disabled, users cannot start or stop the plug-in
software or access other user-controlled options.

  Specify the length
of time plug-in
delays credential
submission

Specifies the length of time in seconds that the plug-in software
delays credential submission after detecting an allowed application.
Use this setting to ensure that the application is ready to receive
the credentials. During this time, the plug-in software will show a
progress indicator, indicating that the plug-in software is working.

  Set the default
columns and
column order
shown in Logon
Manager

Controls which columns are shown in the Logon Manager’s Details
view and the order in which they are presented. This setting does
not affect the List or Icon views in the Logon Manager.

Client Side Interaction  

  Enforce password
matching during
initial credential
setup

Enabled by default. Controls whether or not users must enter
passwords twice for confirmation during initial credential setup.

  Log Single sign-on
plug-in events
using Windows
event logging

Controls whether or not plug-in software error and warning events
will be tracked in the local workstation Windows Event Log.

  Delete user’s data
folder and
registry keys
when Single
sign-on plug-in is
shut down

Controls whether or not the user’s registry keys and data folder
(including encrypted credentials) are deleted when the plug-in
software is shut down.



  Enable users to
cancel credential
storage when a
new application is
detected

Enabled by default. Controls whether or not users are prompted to
store credentials every time the plug-in software recognizes an
application for which no credentials are stored. If enabled, users
can choose to store their credentials in the Logon Manager now,
later, or never.

Note: If the setting Automatically detect applications and prompt
users to store credentials on the Configure plug-in interaction page
is disabled, the plug-in software does not prompt users to store
credentials.

  Limit the number
of days to keep
track of deleted
credentials

Enabled by default as 180 days. Specifies how long in days that the
central store tracks credentials deleted from Logon Manager. When
user credentials are stored on multiple client devices, the plug-in
software deletes the credentials when it synchronizes with the
central store during this time period. If the credentials are still
stored on the client device when the time has elapsed, they are
restored when the plug-in software synchronizes with the central
store.

Synchronization  

  Allow users to
update Single
sign-on plug-in
settings

Enabled by default. Controls whether or not users are allowed to
refresh plug-in software settings in Logon Manager. When the
setting is disabled, the Logon Manager Refresh button is
unavailable.

  Synchronize every
time users launch
recognized
applications or
Logon Manager

Controls whether or not the plug-in software synchronizes user
configuration information whenever a user launches a recognized
application or Logon Manager.

Note: Frequent synchronization can degrade performance on both
the client and server, as well as increase network traffic.

  Allow Single
sign-on plug-in to
operate when
unable to
reconnect to
central store

Enabled by default. Controls whether or not Citrix Single sign-on
operates when unable to connect to the central store for
synchronization. When enabled, a licensed instance of the plug-in
software continues to operate even if the connection fails. If the
setting is unavailable, the plug-in software operates only when
connected to the central store.

  Specify the time
between
automatic
synchronization
requests

Specifies the time in minutes between automatic synchronization
attempts. Automatic synchronization is independent of user activity
and takes place in addition to events that trigger synchronization.

  Allow user
credentials to be
accessed through
the Credential
Synchronization
Module

Controls whether or not remote clients can access user credentials
through this service module. This option is used with the Account
Association feature that allows a plug-in software user to log on to
any application from one or more Windows accounts.

Account Association

  See Synchronizing Credentials by Using Account Association for configuring this feature.

Application Support  
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  Detect client-side
application
definitions

Enabled by default. Allows the plug-in software to detect client-side
application definitions by selecting one of the the following options:

• All applications—detects and responds to applications defined
by an administrator or a user (in Logon Manager) and defined in
the default settings at installation

• Only applications that are defined by users in Logon
Manager—detects and responds to applications defined by an
administrator and a user in Logon Manager. The plug-in software
will not recognize or respond to applications defined in the
default settings at installation.

• Only applications that are included with Single sign-on
plug-in—detects and responds to applications defined by an
administrator and defined in the default settings at installation.
Users cannot create their own application definitions from
Logon Manager

  Enable support
for terminal
emulators

Controls support for terminal emulator-based programs. When
enabled, the plug-in software runs a process that detects terminal
emulators and terminal emulator-based applications.

You can optionally select, in milliseconds, the Time interval in
which plug-in checks the terminal emulator for changes. This option
specifies how much time must pass before the plug-in software
checks the terminal emulator for screen changes. Lower values can
use more CPU time on the client and increase network traffic. If not
selected, plug-in software uses 3000 milliseconds as the default
value.

  Web application
settings

Specifies the minimum number of domain name levels to match for
allowed Web applications. For example, a value of two or less would
match *.domain1.topleveldomain; a value of three would match
*.domain2.domain1.topleveldomain. Domain name levels beyond
the specified number are treated as wild cards. To strictly control
URL matching for Web applications, you might prefer to set strict
URL matching in your application definitions.

Hot Desktop (see also User Configuration Settings for Hot Desktop)

  Session settings
script path

Specifies the path of the session settings file that defines the scripts
to be executed at the start and end of a Hot Desktop session. The
start script can be used to start applications. The shutdown script
can be used to perform cleanup tasks such as file removal. The file
used must be accessible to all users.

  Lock time-out Specifies the length of time in minutes that a Hot Desktop session
will remain active when the workstation is idle. If this interval is
exceeded, the desktop is locked. The default is 10 minutes.

  Session time-out Specifies the length of time that a Hot Desktop session will run
while the desktop is locked. If this time is exceeded, the session is
terminated and a new session is started when the desktop is
unlocked. The default is five minutes.
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  Enable session
indicator

Enabled by default. Controls whether a window identifying the Hot
Desktop session is enabled. When enabled, a transparent moveable
window is shown on the desktop during Hot Desktop sessions. This
window indicates the user’s name and the elapsed time of the
active session.

  Session indicator
graphic

Specifies the path of the graphic file displayed in the Hot Desktop
session indicator. The file used must be in a location accessible to
all users and in Windows bitmap (.bmp) file format.
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Configure Licensing

Select a license server and licensing model at the Configure licensing page of the User
Configuration Wizard.

Important: If you edit the user configuration later and change product editions, your
license model will change. For example, changing the product edition from Single sign-on
Enterprise to Single sign-on Advanced will change your licensing model from Concurrent
User to Named User.

• License server name

Type the license server fully qualified domain name in this field.

• Port number

The default port number is 27000 which you can select by enabling the Use default
value checkbox.

• Named User Licensing

This option is enabled if you purchased this license type and selected Single sign-on
Advanced as the product edition. You can also choose this option if you select the
XenApp Platinum or Single sign-on Enterprise product editions.

With this license type, Single sign-on can be used only by specific, named users.

• Disconnected mode period

Specify the time period that the license is assigned to the named user before the
license expires and Single sign-on plug-in reconnects to the license server. The
license is consumed for the specified time period even if the user computer shuts
down. The default time period is 21 days.

• Concurrent User Licensing (Enterprise and Platinum Edition only)

This option is enabled if you select the XenApp Platinum or Single sign-on Enterprise
product edition. It is disabled if you select the Single sign-on Advanced product edition.

Note: This license model is enabled if you upgraded from Password Manager Version
4.1. Citrix Systems considers this previous version as equivalent to Single sign-on 4.8
Enterprise Edition for licensing purposes when you upgrade.

With this license type, a single Single sign-on license can be shared by different users
(although not at the same time; this license type is sometimes also known as a floating
license).

• Allow license to be consumed for offline use

Select this option to specify the amount of time that the user can be disconnected
(offline) before the license expires and returns to the pool of available licenses. If
enabled, the license is consumed for the specified time period even if the user
computer shuts down. The default time period is 21 days; it can range from 2 to 365



days.

If this option is not selected, the license expires and returns to the pool after 1
hour and 30 minutes. This time is not adjustable.
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Select Data Protection Methods

The Select data protection methods page of the User Configuration Wizard enables you to
select the data protection methods to protect user credentials based on the various
authentication methods your users are authorized to use. In some environments, users can
use more than one method.

Note: If you upgraded your central store from Version 4.1 to Version 4.8, the Use data
protection as in Password Manager 4.1 and previous versions option is selected
automatically.

Important: To use smart cards in a Windows Server 2008 R2, Windows Server 2008, or
Windows Vista environment, your central store must be created with or updated by a
Password Manager 4.5 or later console and Microsoft Data Protection API (requires
roaming profiles) must be selected in your user configurations.

• Do you need to regulate account administrator access to user data?

Select Yes if you want to disallow administrator access to user credentials.

Yes is the default setting for this page. With this configuration, the account or other
administrator does not have access to user passwords or user data. This setting helps
prevent an administrator from impersonating a user. The administrator cannot log on to
the plug-in software as the user with the default setting and possibly access data
located in the user local credential store.

If you select Yes, the Microsoft Data Protection API options (including the DPAPI with
profile selection in the Smart Card key source drop-down menu) on this page and the Do
not prompt users; restore primary data protection automatically over the network
option on the following Select secondary data protection page are disabled.

Select No if you want to allow use of all the multiple authentication features available
from this page and the secondary data protection methods on the following page in the
wizard.

• For improved user experience upon logon events, please select all data protection
methods that apply

This selection enables you to use the multiple primary authentication features in this
version of Single sign-on and control the plug-in software behavior. The options include
the following:

Control Description



Users authentication
data

A user secret is used to access and protect user data. The
authentication secret can be a user password or
PIN-based device used in your environment.

To further protect the user data, you can also select the
following:

Allow Smart Card PINs

Select to allow the smart card PIN to be used as the user
secret for protection. Use this only if your enterprise or
environment has a “strong PIN” policy.

Allow protection using blank passwords

Select this option only if your domain has low security
requirements and allows users to have blank domain
passwords. If you select this option and the plug-in
software detects that the user has a blank password, a
user secret is derived from the user ID.

If you do not select this option, the plug-in software does
not derive a user secret or otherwise perform any data
protection with the blank password.

If you select Users authentication data and do not select
Allow Smart Card PINs and Allow protection using blank
passwords, after the user logs on for the first-time
enrollment and registration process with a blank
password, an error message appears and the plug-in
software is disabled.

Microsoft Data
Protection API

Select this option if you are using roaming profiles
implementing a Kerberos network authentication protocol
for users. This option works only if roaming profiles are
available.

For example, select Users authentication data and this
option if users are using passwords to access their
computers and a Kerberos network authentication
protocol to access a farm of computers running Citrix
XenApp. This method also allows the use of user
credentials and smart cards to log on.

Smart Card Certificate Select to allow users to use cryptographic cards that
enable encryption and decryption of authentication data.
Citrix recommends that, if possible, you select this option
if you are using Hot Desktop in your environment.

• Use data protection as in Password Manager 4.1 and previous versions

Select this option and choose one of the following methods from the Smart Card key
source drop-down menu if you want to permit users to use a single primary
authentication method and/or you might be using Versions 4.0 or 4.1 of the plug-in
software. If you upgraded your central store from Version 4.1 to Version 4.8, this option
is automatically selected:
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• PIN as password

• Smart Card Data Protect

• DPAPI with profile (not available if No is selected for Do you need to regulate
account administrator access to user data?
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Select Secondary Data Protection

When users change their primary authentication (for example, a domain password change or
a replaced smart card), the Select secondary data protection page of the User Configuration
Wizard enables you to specify secondary credential data protection options to use before
unlocking user credentials. It also enables you to require that users verify their identity for
added security.

Alternatively, it also enables you to specify that credentials are restored automatically by
implementing the Key Management Module.

• Prompt users to verify identity

Choose this button to select one of the following user reauthentication methods:

Control Description

Prompt user to enter the previous
password

If you select this option, note that users who
forget their previous password will be locked
out and must reenroll their secondary
credentials. Do not select this option if your
users employ smart cards for their primary
authentication.

Prompt user to select the method:
previous password or security
questions

If you select this option, users are prompted
according to their choice of verification
method. This option includes this suboption:

Use identity verification as in previous
versions of Password Manager

Select this option if you upgraded from
Password Manager Versions 4.0 or 4.1 and you
enabled question-based authentication or
identity verification questions. The 4.0 and
4.1 Versions of the plug-in software do not
need access to the service in this case.

• Do not prompt users; restore primary data protection automatically over the network

Choose this option if you are implementing the Key Management Module to bypass
identity verification and automatically unlock user credentials. This method is less
secure than other data protection methods but increase ease-of-use for your users by
retrieving credentials automatically.
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Enable Self-Service Features

The options available on the Enable self-service features page of the User Configuration
Wizard require the installation of the Key Management Module. This feature inserts an
Account Self-Service button on the Windows logon and Unlock Computer dialog boxes and
can help reduce costs associated with administrator intervention or help desk support in
your enterprise.

These options enable users who might have forgotten their password to reset their primary
domain password and unlock their domain account without needing to call your help desk.

The options are as follows:

• Allow users to reset their primary domain password

• Allow users to unlock their domain account
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Locate Service Modules

The Key Management Module and Provisioning module pages of the User Configuration
Wizard require you to specify the URL and service port of any installed service modules.

1. Select the options associated with each service module.

2. Specify the fully qualified domain name of the computer hosting the service and the
port number (the default port number is 443).
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Synchronizing Credentials by Using
Account Association

In companies that might maintain multiple Windows domains, users might also have more
than one Windows account. Single sign-on includes a service known as Credential
Synchronization to enable Account Association.

Account Association allows a user to log on to any application from one or more Windows
accounts. Because Single sign-on typically binds user credentials to a single account, the
credential information is not automatically synchronized among multiple accounts that a
user owns. However, administrators can configure Account Association to synchronize user
credentials. Users with Account Association configured have access to all applications from
any of their accounts in their Single sign-on environment. When user credentials are
changed, added, or removed from one account, the credentials are synchronized
automatically with each of the user’s associated accounts.

Without Account Association, an individual with multiple Windows accounts is forced to
manually change their logon information separately from each Windows account.

To configure Account Association, the enterprise Windows domain administrators must
perform the following steps in order:

1. Choose a domain in which to install and run the Credential Synchronization Module,
which is part of the Single sign-on Service.

2. Deploy the trusted root certificate to all computers in the enterprise that will use
Account Association.

3. Manually synchronize application definitions among domains.

4. Configure the Account Association user settings in other domains to connect to the
Credential Synchronization Module.

5. Each user must enable Account Association in the plug-in software.
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Choosing and Configuring a Domain to
Host the Credential Synchronization
Module

Choose the domain that contains the accounts for all users in your enterprise who will use
Account Association. The Credential Synchronization Module acts as the hub for all user
credential information in the enterprise. Install this module in this domain as you would any
other Single sign-on Service.

Important: Contact your network administrator to determine if any firewall changes are
necessary and if the changes are compliant with your company’s policies.

After you install the Credential Synchronization Module, create or edit user configurations
from the Delivery Services Console to authorize individual user accounts to use the
Credential Synchronization Module, as follows.
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To configure the credential
synchronization features in the host
domain

Open the console from the domain that is hosting the Credential Synchronization Module.
Some domains can access multiple central stores. Ensure that the console you are using is
configured to connect to the same central store as the Credential Synchronization Module
service.

1. Click Start > All Programs > Citrix > Management Consoles > Citrix Delivery Services
Console.

2. Expand the Single sign-on node and select User Configurations.

3. Select an existing user configuration or create a new one.

• If you are creating a new user configuration, the following options are available
from the Advanced Settings button on the Configure plug-in Interaction page of the
User Configuration Wizard.

• If you are editing an existing user configuration, the following options are available
from the Edit User Configuration properties page.

4. Click Synchronization and select Allow user credentials to be accessed through the
Credential Synchronization Module.

5. Click OK and repeat Steps 3 and 4 for each existing and new user configuration.
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To manually synchronize application
definitions among domains

Accounts can also synchronize across different user configuration associations. That is, a
user configuration can be associated with an Active Directory hierarchy (OU or user) in one
domain and associated with an Active Directory group in another domain. As long as the
application definition names are the same in each user configuration, the Account
Association feature will synchronize credentials.

User credentials are shared only for applications defined by the Single sign-on
administrator. Administrators must ensure that each application definition on each domain
has the same name in each central store.

For example, if the application definition for SAP is named SAP Logon on one domain, SAP
on another, and SAP Launch Pad on another, user credentials for these applications will not
be synchronized across accounts for these domains.

A best practice when creating a new application definition across domains is to use the
Export application definitions and Import administrative data tasks in the console. Use
these tasks to export newly-created application definitions to import into each central
store. Existing, previously-defined applications must be manually renamed.
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To configure Account Association user
settings in other domains

Install and open the console from a workstation in each domain that is not hosting the
Credential Synchronization Module. Some domains have multiple central stores; therefore,
ensure that you configure each central store.

All domain administrators must allow the domain users to associate their accounts with
their host domain account. Edit the Account Association section of the appropriate user
configurations in the console.

1. Click Start > All Programs > Citrix > Management Consoles > Citrix Delivery Services
Console.

2. Expand the Single sign-on node and select User Configurations.

3. Select an existing user configuration or create a new one.

• If you are creating a new user configuration, the following options are available
from the Advanced Settings button on the Configure plug-in interaction page of the
User Configuration Wizard.

• If you are editing an existing user configuration, the following options are available
from the Edit User Configuration properties page.

4. Click Account Association.

5. Select Allow users to associate accounts.

The following options are not required but help provide a seamless user experience.

6. Select Provide default service address and type the Single sign-on Service address and
port for the domain hosting the Credential Synchronization Module.

7. Clear Allow users to edit service address.

8. Select Provide default domain and type the name for the domain hosting the Credential
Synchronization Module. If you do not provide the domain, users might be confused as
to which domain account user credentials they should provide.

9. Clear Allow users to edit domain.

10. Depending on your company’s security policies, select Allow users to remember
password.

11. Click OK and repeat for each user configuration.
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To configure Account Association in the
plug-in software

When logging on to the domain hosting the Credential Synchronization Module, users do not
need to perform any action to enable Account Association. These accounts act as a central
repository for each user’s credential information.

When logging on to other domains, users will now see an option under the Tools menu in
the plug-in software named Account Association. Users must choose this option to configure
Account Association.

1. From the Single sign-on plug-in software notification area icon: select Tools > Account
Association. The Account Association dialog box appears.

2. Select Enable Account Association.

Note: If you did not provide the service address that is hosting the Credential
Synchronization Module, users must type it in the text field. If the field is
unavailable, you already provided this service address and users cannot type in this
field.

3. Click OK. The Authenticate for Account Association dialog box appears.

4. Type your username and password for your associated Windows account. If the domain
where the Credential Synchronization Module is installed is not shown, type it in the
Domain field.

Note: If you provided the domain name, users cannot type text in this field.

5. Click OK. Account Association is now configured. The user’s credentials are
synchronized whenever plug-in software synchronization occurs.
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To reset user data

The Reset user data task requires that you install and configure the Provisioning Module.

Reset user data enables you to reset user information in your central store, which results in
the selected user being returned to an initial state.

• In Active Directory central stores, the user data (credentials, security questions and
answers, and so on) is deleted and the user is flagged as having had their data reset.

• In NTFS network share central stores, the user folders are retained, all user data is
deleted, and the user is flagged as having had their data reset.

You can use Reset user data if users forget the answers to their security questions or to
reset their credential data if the user’s data somehow is corrupted. When the user later
uses the plug-in software to contact the central store, the user’s local credential store is
cleared of all data, and the user must reenroll, similar to initial credential setup.

This task is also useful when a user cannot log on to the plug-in software.

Important: Password history is retained on a per-user basis. If you reset the data for a
user, the password history is removed and password history cannot be enforced for the
deleted passwords.

1. Click Start > All Programs > Citrix > Management Consoles > Citrix Delivery Services
Console.

2. Expand the Single sign-on node and select User Configurations.

3. From the Action menu, click Other Tasks > Reset user data. The Select User dialog box
appears.

4. Type a user name in the text field and click Check Names.

5. If the user is found, click OK.

6. Select a user in your central store and click Reset.

7. Click OK. A warning message appears.

8. Verify that any users who might be running Single sign-on as an application hosted by
Citrix XenApp are logged off and click Continue to flag the user’s data for reset.

Note: If users are not logged off, click Cancel, reset their ICA session, and return to
this procedure.

9. Click OK in the Reset User Data dialog box when the user information is verified and
reset. The user’s data is reset the next time the user logs on to Single sign-on using the
plug-in software.
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To delete user data

The Delete user data from central store task deletes all user data and information from the
central store. You can use Delete user data from central store when a user leaves your
enterprise permanently.

The local credential store on the user computer remains intact until it is explicitly deleted
by an administrator or operator.

If the plug-in software is run by the now-deleted user, the plug-in software synchronizes its
local credential store with the central store unless the local credential store is explicitly
deleted by an administrator or operator. To prevent this, delete this user from your
enterprise (for example, disable or delete the user from Active Directory).

1. Click Start > All Programs > Citrix > Management Consoles > Citrix Delivery Services
Console.

2. Expand the Single sign-on node and select User Configurations.

3. From the Action menu, click Other Tasks > Delete user data from central store. The
Select user dialog box appears.

4. Type a user name in the text field and click Check Names.

5. If the user is found, click OK. Click Yes to confirm. A confirmation message appears.

6. Click OK. The user is now deleted from the central store.
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To prompt users to reregister

You can prompt one user or all users to reregister answers to their security questions. You
would use these features for security purposes or when user data becomes corrupted:

• Revoke security question registration for a user

Select this option to delete a user’s security question data. Any question-based
authentication is unavailable until the user reregisters.

• Prompt all users to reregister security questions

Select this option to prompt all users to reregister their security questions and answers
when they launch the plug-in software. Security question data is retained and any
feature requiring question-based authentication is still available with the current
answers. Users are prompted until they reregister.

If users choose not to reregister their answers by cancelling the Citrix Single sign-on
Registration dialog box when prompted, they will not be able to use features that use
question-based authentication such as Account Self-Service until they choose to reregister
their answers.

1. Click Start > All Programs > Citrix > Management Consoles > Citrix Delivery Services
Console.

2. Expand the Single sign-on node and select User Configurations.

3. From the Action menu, click Other Tasks and one of the following:

• Revoke security question registration for a user

The Select User dialog box appears. Type or select a user. Confirm that you want to
revoke that user’s security question registration.

• Prompt all users to reregister security questions

Click Yes to prompt all users, then click OK.
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To set a user configuration priority

When you create or edit a user configuration, you can associate users located in Active
Directory groups with user configurations. It is possible that a user in a group can be
associated with more than one user configuration. In this case, you can set the priority of
the user configuration.

Important: How you organize your Single sign-on user environment might affect how user
configurations operate. That is, you associate user configurations in your Single sign-on
environment with an Active Directory hierarchy (OU or users) or an Active Directory
group. If you use both (hierarchy and group) and a user is located in both containers, the
user configuration associated with the hierarchy takes precedence and is the one used.
This scheme is considered a mixed environment.

1. Click Start > All Programs > Citrix > Management Consoles > Citrix Delivery Services
Console.

2. Expand the Single sign-on node and select User Configurations.

3. From the Action menu, click Other Tasks > Set user configuration priority. The Set User
Configuration Priority dialog box appears.

4. Select a user configuration and click Move Up or Move Down, according to your
preference.



176

Assigning a User Configuration to
Different Users

When you edit an existing user configuration, note that you cannot edit the user
configuration location. You can perform one of the following procedures:

• Apply a user configuration to an additional set of users by duplicating it

• Apply a user configuration to a different set of users by moving it

To duplicate a user configuration
1. Click Start > All Programs > Citrix > Management Consoles > Citrix Delivery Services

Console.

2. Expand the Single sign-on node and select User Configurations.

3. Select the user configuration.

4. From the Action menu, click Duplicate user configuration.

5. Type a name for the duplication configuration.

6. Specify the OU, user, or group that contains the users to which the user configuration
will apply.

To move a user configuration to different users
You cannot move a user configuration that is associated with an Active Directory group. To
associate the user configuration with an Active Directory hierarchy (OU or user), duplicate
the user configuration and specify the desired association.

1. Click Start > All Programs > Citrix > Management Consoles > Citrix Delivery Services
Console.

2. Expand the Single sign-on node and select User Configurations.

3. Select the user configuration.

4. From the Action menu, click Move user configuration.

5. Specify the OU, user, or group that contains the users to which the user configuration
will apply.
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Upgrading Existing User Configurations

In Password Manager Versions 4.0 and 4.1, you associated users to a user configuration by
an Active Directory hierarchy (OU or user). In Password Manager 4.5 and 4.6 and Single
sign-on 4.8, you can choose to associate users by an Active Directory group.

• If you use an existing user configuration organized by hierarchy and now create user
configurations organized by group and a user is located in both containers, the user
configuration associated with the hierarchy takes precedence and is the one used. This
scheme is considered a mixed environment. In this case, your users might experience
unintended plug-in software behavior. That is, they will have access to resources
associated with the hierarchy-based user configuration instead of resources associated
with the group-based user configuration.

• If you want to preserve the settings in your existing hierarchy-based user configurations
but change their association, move the user configuration to a different user. This
procedure is applicable for Versions 4.1, 4.5, 4.6, and 4.8 hierarchy-based user
configurations.

Consider the following if you want to upgrade existing user configurations whose users are
organized by OU or user:

If you upgrade the Single sign-on Service and console but do not upgrade the plug-in
software, the plug-in software will still provide basic functionality to users whose user
configurations are associated with Active Directory hierarchies (organizational units or
users). However, your users will not have access to the latest Single sign-on features.
Consider upgrading the plug-in software whenever possible to match the service and
console versions.
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User Authentication and Identity
Verification

Two types of authentication exist in Single sign-on:

• Primary authentication, which occurs when users type their primary user names,
passwords, and, optionally, domain name when logging on to Microsoft Windows to
access their corporate or enterprise network. The existing Windows security subsystem
is responsible for managing network authentication.

• Secondary authentication, which occurs when you configure Single sign-on to submit
credentials that allow users to access protected single sign-on enabled resources. These
resources can include an enterprise application, a Web application, a protected field in
an application, an IP address, a URL, and so on.

After a successful network authentication, Single sign-on obtains the primary password from
the Windows logon and, along with other variables, uses this information to create the
encryption key that protects user credentials. The plug-in software uses this key to retrieve
and decrypt the credentials as applications or resources request them.

Important: If a user’s password is compromised, reset the user's password twice, rather
than once, to ensure that the compromised password is removed from the previous
password feature. Users need to log on with each of the new passwords so that the
plug-in software can capture the changes.

When Must Users Confirm Their Identities?
Each time users log on to your environment, they confirm their identity by typing their user
name and password or by using a smart card or other authentication device that uniquely
identifies who they are.

However, several events require a second layer of authentication to verify that the user
initiating the change is the user authorized to do so:

Event Description

An administrator changes a user's
primary password

When administrators change users’ primary
passwords, users will then be further prompted
to confirm their identities to ensure the
authorized user is logged on.

Users reset their primary password
using Account Self-Service

When users reset their primary password using
Account Self-Service, they are prompted to
further confirm their identity. Do not use the
Prompt user to enter the previous password
authentication option if enabling the self-service
features.



Users unlock their domain account
using Account Self-Service

When users unlock their account using the
self-service features, they are prompted to
further confirm their identity.

Users change their authentication
types

For example, when users switch from smart card
authentication to password-based
authentication, they are prompted to further
confirm their identity.

Password change on a client device
not running Single sign-on

Users who change their primary password on a
client device not running the plug-in software
are prompted to confirm their identity the next
time they log on to a client device running the
plug-in software.

Your users can confirm their identity using one or more of the options you can specify to
meet your organization’s requirements.

User Authentication and Identity Verification
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Overview of Identity Verification Methods

Single sign-on includes two identity verification methods to help ensure that the user is
authorized to use Single sign-on:

• previous password

• security questions

You can also choose to bypass identity verification by using the automatic key management
feature.

You can allow users to choose the identity verification method (previous passwords or
security questions) they prefer to use when authenticating. This option is available as part
of Secondary Data Protection property in the user configuration.

Previous Password
With this method, users verify their identities by typing their previous primary password.

Caution: When previous password is the only method available to your users, users who
forget their previous primary password are locked out of the system. Their user data must
be deleted from the central store and from all client devices on which it is stored, and
they must reenter their credentials for all of their applications.

Security Questions
When users change their primary passwords, you can confirm your users’ identities by
prompting them to answer security questions in the form of a questionnaire you create.
This questionnaire appears the first time your users launch the plug-in software. Users
answer the required number of security questions and are prompted to reenter this
information at specific password change events.

The questions in your questionnaire should be of a nature that ensures the person answering
the question is the only person who knows or could easily provide the answer. You can use
the default questions Single sign-on provides or create your own.

Bypassing Identity Verification
Important: Automatic key management is not as secure as other key recovery
mechanisms such as security questions and previous password.

If you want Single sign-on to bypass identity verification and retrieve user encryption keys
automatically, you can specify the Secondary Data Protection option Do not prompt users;
restore primary data protection automatically over the network.



This method, known as automatic key management, is available when you install the Key
Management Module and you create a user configuration with this option selected.

With this method, users log on to the network and have immediate access to applications
managed by Single sign-on. There are no questions to answer. When users change their
primary passwords, the plug-in software detects these password changes and recovers the
users’ encryption keys using the Single sign-on Service.

Automatic key management provides users with the easiest and fastest access to their
applications. However, it does not protect against access by an unauthorized user because
there is no user secret to protect the user’s network password. To help prevent this
potential problem, implement automatic key management in combination with the
Self-Service Module. This module requires question-based authentication to allow your users
to confirm their identity when resetting their primary passwords or unlocking their domain
accounts.

Overview of Identity Verification Methods
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If Users Switch among Multiple Primary
Authentication Methods

In Single sign-on, users can switch among multiple primary authentication methods. Single
sign-on protects user passwords with a unique copy of the security key as a reauthentication
method to efficiently unlock the user’s data each time the user switches between
authentication methods, without the user having to verify identity.

The option to select multiple primary authentication methods is available as part of the
Data Protection Methods page in the user configuration.

Consider the following user scenario:

• A call center supervisor logs on to a computer using primary credentials (Windows user
name and password). Single sign-on plug-in software is installed on the computer and
allows the supervisor to use single sign-on (SSO) enabled applications.

• The supervisor occasionally uses a smart card with PIN to log on to a shared computer
on the call center floor and launch another published application through XenApp. This
computer uses Hot Desktop to enable fast user switching among different accounts.

In Citrix Password Manager Versions 4.0 and 4.1, the call center supervisor is required to
verify identify before using the SSO-enabled applications when changing primary
authentication methods. In this use case, the supervisor used two primary authentication
methods: first a user name and password, then a smart card with PIN. Password Manager
Versions 4.0 and 4.1 treat the change of authentication method as requiring security key
recovery and possibly required the supervisor to verify identity.

Users are required to register or enroll each new authentication method the first time they
use or switch to the method. However, later switches do not require a registration or
enrollment (that is, a key recovery is not subsequently required).
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Managing Question-Based Authentication

Question-based authentication allows you to provide secure authentication to users who
change their primary password under specific circumstances, change their method of
authentication, or have their accounts locked.

The use of security questions and question-based authentication can help protect against
access by unauthorized users by requesting information known only to your individual users.
The questions you create must request non-public information that would be difficult for
anyone other than the authorized users to provide or find (for example, difficult for brute
force guessing, dictionary based attacks, and so on).

Important: If you plan to use the password reset or domain account unlock self-service
features available from the Single sign-on Key Management Module, you must use the
question-based authentication method to allow your users to confirm their identity when
resetting their primary passwords or unlocking their domain accounts.
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Confirming User Identity Using
Question-Based Authentication

If you are implementing the password reset or domain account unlock self-service features
available from the Single sign-on Key Management Module, use question-based
authentication for user identity verification. You can also choose question-based
authentication as a form of secondary data protection if a user’s primary authentication
changes.

Depending on the user configuration settings in the console, users might be required to
verify their identities when the following events occur:

• Users change their authentication types; for example, a user might switch between
smart card and password authentication.

• An administrator changes a user’s primary password

• Users reset their primary password using Account Self-Service

• Users unlock their domain account using Account Self-Service

• Users change their primary password on a device that does not have the plug-in
software installed and then log on to a device where the plug-in software is installed

Note: You can also create a user configuration that does not require subsequent
verification when switching among authentication types; see If Users Switch among
Multiple Primary Authentication Methods.

If configured, the Single sign-on plug-in software prompts users to answer the security
questions during first-time use. When one of these events occurs that requires users to
verify their identity, the plug-in software launches the questionnaire you created for them.
A questionnaire is a preconfigured list of questions you create.

Each question in the questionnaire appears on a separate page. For example, if five
questions are in your questionnaire, users will see five separate pages—one for each
question. Users must answer every question correctly. Depending on administrator settings,
answers must be an exact match, including case and punctuation, to the answers users gave
when Single sign-on was launched for the first time.

The correct combination of questions and answers confirms the user’s identity. After a user
is confirmed, the plug-in software encrypts the keys again using the new primary password
and stores the user’s secondary credentials.
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Considerations

• If you choose not to configure answers to security questions as required for your users,
users are prompted for their previous primary password when they change their primary
password and attempt to log on with their new password. You can allow users to choose
the identity verification method they prefer to use when authenticating. This option is
available as part of the Secondary Data Protection property in the user configuration.

• To prevent user lockout, do not combine the Account Self-Service password reset
feature with the Prompt user to enter the previous password option. Users who reset
their password are unlikely to recall their previous primary password and cannot
retrieve their secondary credentials.

• Multiple questions provide the best data protection.

• By default, Question-Based Authentication is populated with four security questions.
While you can use these four questions exclusively, consider adding your own security
questions and question groups.

Note: Depending on administrator settings, alphabet case usage, punctuation, and spaces
are included in the user’s answer and must match exactly when the user is asked to
answer the selected security questions at a later date.
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Question-Based Authentication Workflow

Create and make available your security questions before deploying the plug-in software.
After a user selects a question, that question must always be available. If you change or
remove a question that is in use, those users cannot use the security questions to recover
their secondary credentials until and unless you force them to re-enroll.

1. Create your security questions, defining the minimum length and case sensitivity. These
questions can be made available in the languages Single sign-on supports.

2. Optionally, group these questions in security question groups. You can create a number
of questions for your users to choose from, giving them flexibility to choose a question
to which they are more likely to recall an answer. This allows you to define the number
of questions from each group that users are required to answer.

3. Add your questions, or questions and question groups, to your questionnaire.

4. Select one or two questions to be used for key recovery. These questions are used to
encrypt the data for key recovery; your users will still be required to provide answers
for questions they answered at enrollment.

5. Optionally, enable security questions answer masking. This feature provides you the
option to mask user answers to question-based authentication security questions. If
enabled, users’ answers are protected during answer registration and identity
verification.

Important: Enabling Security question masking for existing users with input method
editors, or IMEs, may prevent these users from being able to provide answers during
registration and identity verification. Eastern Asian languages, such as Chinese,
Japanese, and Korean, require the use of an IME to enter characters into the Single
sign-on interface. Enabling the masking feature automatically disables the IME during
registration and identity verification for those users who are upgraded to Single
sign-on 4.8.

There is no impact on users new to Single sign-on with Version 4.8.

Security question answer masking is available on console and plug-in software running
Password Manager 4.6 and 4.6 with Service Pack 1, and Single sign-on 4.8 only.
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Designing Security Questions: Security
Versus Usability

Single sign-on provides four default questions that you can use to manage user registration.
These questions are available in all supported languages (English, French, German,
Japanese, and Spanish). Citrix recommends you create your own security questions and
make them available in each of the languages your environment must support.

Someone trying to gain access to a user password needs to know the answers to all the
questions the user originally answered. Consider that requiring users to answer too many
questions might make it too difficult for your users to confirm their identity.

Security questions should request non-public information that would be difficult for anyone
other than the valid user to provide (for example, difficult for brute force guessing or
dictionary-based attacks). The key factor in determining the security of questions is the
degree of difficulty involved when someone attempts to guess the answer.

A good questions is one that has high entropy; that is, a question for which:

• The number of unique answers possible is very high

• The probability of guessing any one specific answer is very low

For usability purposes, the question should be easy for a user to remember but difficult for
an adversary to determine. For example:

• What is the name of your favorite college professor or high school teacher?

• Where would you go for your ultimate dream vacation? (city, country)

• What is the title of your favorite song and who is the artist?

• What is the title of your favorite book and who is its author?

• What is the name of your favorite work of art, who is the artist, and where did you see
it?

However, in these examples, cultural bias could make it more likely for users in the same
population to have identical answers to these questions, even if they do not deliberately
share the answers. This bias potentially increases the risk of an insider attack.

Avoid creating questions that:

• Return simple answers, such as “What is your favorite color?”

• Request information likely to be known, or change, such as “What is your address?”
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Managing Your Questions

The Question-Based Authentication node in the Single sign-on component of the Delivery
Services Console provides you with a central location for managing all security questions
associated with identity verification, self-service password reset, and account unlock. You
can add your own security questions to the list of default questions and create question
groups and target them to specific users.

• If you edit the existing default questions after users register their answers, consider the
meaning of the edited questions. Editing a question does not force a user reenrollment;
but if you change the meaning of a question, users who answered that question
originally might not be able to provide the correct answer.

• Adding, deleting, and replacing security questions after users are enrolled means that
all users who were previously enrolled using an older set of questions cannot
authenticate and reset their password until they reenroll. Users must answer the new
set of questions when they open the plug-in software.

• Individual security questions can belong to multiple security question groups. When you
create your security question groups, all questions you create are available for use with
any security question group.



189

To create new security questions

You can create many different questions and designate a language for each question. You
can also provide multiple translations of a single question. The plug-in software presents
the user with the questionnaire in the language that corresponds to the language settings of
the user's profile. If the language is not available, Single sign-on displays the questions in
the default language.

Note: When you specify a language for a security question, the question appears to users
whose operating system settings are configured for that designated language. If the
selected operating system settings do not match any of the questions available, users are
shown your selected default language.

1. Click Start > All Programs > Citrix > Management Consoles > Citrix Delivery Services
Console.

2. Expand the Single sign-on node, expand Identity Verification, and select the
Question-Based Authentication node.

3. From the Action menu, click Manage Questions.

4. Select Security Questions.

5. From the Language drop-down list, select a language and click Add Question. The
Security Question dialog box appears.

6. Create the new question In the Security Question dialog box.

Important: You must use the Edit command to include the translated text of existing
questions. If you select Add Question, you are creating a new question that is not
associated with the original.
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To set a default language

In most instances, users see security questions displayed in the language associated with
their current user profile. If the language is not available, Single sign-on displays the
questions in the default language that you specify.

1. Click Start > All Programs > Citrix > Management Consoles > Citrix Delivery Services
Console.

2. Expand the Single sign-on and Identify Verification nodes and select Question-Based
Authentication.

3. From the Action menu, click Manage questions.

4. Select Question-Based Authentication.

5. From the Default Language drop-down list, select the default language.

Note: The Perform backward compatibility option in this dialog box ensures that
Password Manager 4.0 and Password Manager 4.1 plug-in software can continue to display
identity verification questions.



191

To add or edit text for existing questions

Adding, deleting, and replacing security questions after users are enrolled means that all
users who were previously enrolled using an older set of questions cannot authenticate and
reset their password until they reenroll. Users must answer the new set of questions when
they open the plug-in software. Editing a question does not force a user reenrollment; but
if you change the meaning of a question, users who answered that question originally may
not be able to provide the correct answer.

Important: If you are editing an existing question, be careful not to change the meaning
of a question. This might cause a mismatch in user answers during reauthentication. That
is, a user might provide a different answer that might not match the stored answer.

1. Click Start > All Programs > Citrix > Management Consoles > Citrix Delivery Services
Console.

2. Expand the Single sign-on node, expand Identity Verification, and select the
Question-Based Authentication node.

3. From the Action menu, click Manage Questions.

4. Select Security Questions.

5. Select a language from the Language drop-down box.

6. Select the question and click Edit. The Security Question dialog box appears.

7. Edit the question in the Security Question dialog box.
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To add, remove, or change the order of
the security questions in the questionnaire

Your users view and answer the security questions you select in the form of a questionnaire.
The questionnaire draws on a pool of questions and question groups you create and make
available to your users.

A questionnaire consists of a list of one or more questions and/or one or more question
groups. You cannot repeat a question in the questionnaire. For example, you cannot create
a question group that includes a question that is already in the questionnaire.

Before you begin:

• Individual security questions can belong to multiple security question groups. When you
create your security question groups, all questions you create are available for inclusion
in any security question group.

• If you are upgrading from a previous release of Single sign-on/Password Manager, you
might need to add questions and question groups with specific settings for
backward-compatibility with older versions of the Single sign-on/Password Manager
plug-in software.

1. Click Start > All Programs > Citrix > Management Consoles > Citrix Delivery Services
Console.

2. Expand the Single sign-on node, expand Identity Verification, and select the
Question-Based Authentication node.

3. From the Action menu, click Manage Questions.

4. Select Questionnaire and click Add.

5. Select the security questions or security question groups you want to add to the
questionnaire and click OK. If the question group you add contains more questions than
you require users to answer (for example, three of six), users will select and answer
questions from a drop-down list until the required number of questions is answered.

6. Optionally, click Move Up or Move Down to change the order in which the questions or
question groups are presented to your users.

7. Optionally, select a question and click Remove to remove it from the questionnaire.

Note: When you remove a question from the questionnaire, this question is not
included in the list of questions displayed to new users, but it still appears for
existing users.

8. Click OK to save your questionnaire. A message might appear asking if you want to force
users to reenroll answers. Click Yes to force reenrollment.
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To create a security question group

You can create a number of security questions that your users answer to confirm their
identities. Each question you add to the questionnaire must be answered by your users.
However, you can also group these questions together in a security question group.

For example, putting your questions in a group enables you to add a group of six questions
to your questionnaire, and allows your users to choose from that group of questions,
answering, for example, three of the six. This gives your users flexibility in selecting
questions and providing answers to be used for identity verification.

1. Click Start > All Programs > Citrix > Management Consoles > Citrix Delivery Services
Console.

2. Expand the Single sign-on node, expand Identity Verification, and select the
Question-Based Authentication node.

3. From the Action menu, click Manage Questions.

4. Select Security Questions.

5. Click Add Group.

6. In the Security Question Group dialog box, name the group, select the questions, and
set the number of questions the user must answer.
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To edit a security question group

1. Click Start > All Programs > Citrix > Management Consoles > Citrix Delivery Services
Console.

2. Expand the Single sign-on node, expand Identity Verification, and select the
Question-Based Authentication node.

3. From the Action menu, click Manage Questions.

4. Select Security Questions.

5. Select the security group you want to edit and click Edit. The Security Question Group
dialog box appears, with a list of security questions available to be part of the group.
The questions currently in the group are indicated by a check mark. Here you can edit
the name of the group, add questions to the group, and select the number of questions
from this group a user must answer.
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To select one or more question for key
recovery

You must select one or two of the questions your users answer to encrypt the data for key
recovery. Your users need to provide answers for all of the questions they originally
answered when enrolling, but the questions you select are used to provide data to include
as part of the encryption and key recovery process.

1. Click Start > All Programs > Citrix > Management Consoles > Citrix Delivery Services
Console.

2. Expand the Single sign-on node, expand Identity Verification, and select the
Question-Based Authentication node.

3. From the Action menu, click Manage Questions.

4. Select Key Recovery.

5. Select the check box next to each question or question groups to use for key recovery
during identity verification.

6. Click OK to save your question and settings. A message might appear asking if you want
to force users to reenroll answers. Click Yes to force reenrollment.
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To enable security answer masking

Security answer masking is available with Password Manager Versions 4.6 and 4.6 with
Service Pack 1, and Single sign-on 4.8 only.

Important: Enabling security answer masking for existing users with input method
editors, or IMEs, may prevent these users from being able to provide answers during
registration and identity verification. Eastern Asian languages, such as Chinese, Japanese,
and Korean, require the use of an IME to enter characters into the Single sign-on
interface. Enabling the masking feature automatically disables the IME during registration
and identity verification for those users who are upgraded to Single sign-on 4.8. There is
no impact on users new to Single sign-on with Version 4.8.

Security answer masking provides an added level of security for your users when they
register their security question answers or provide their answers during identity
verification. When this feature is enabled, the answers of users running Password Manager
4.6, Password Manager 4.6 with Service Pack 1, or Single sign-on 4.8 are hidden. During the
answer registration process, these users will be asked to type their answers twice to avoid
typing and spelling errors. Users will need to type their answers only once during identity
validation because they are prompted to retry if there is an error.

Note: Security question answers registered with Password Manager 4.5 agent software
can be masked when your software is upgraded to Single sign-on Version 4.8. Security
question answers for users with agent software for Password Manager 4.5, 4.1, or 4.0
remain visible regardless of the console setting.

1. Click Start > All Programs > Citrix > Management Consoles > Citrix Delivery Services
Console.

2. Expand the Single sign-on node, expand Identity Verification, and select the
Question-Based Authentication node.

3. From the Action menu, click Manage Questions.

4. Select Security Answer Masking.

5. Select Mask answers for security questions.
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To make your questionnaire backward
compatible

Backward compatibility mode enables the plug-in software to continue prompting users
with identity verification questions you used for Password Manager Versions 4.0 and 4.1.
Backward compatibility mode also allows you to continue using the default question, "What
is your identity verification phrase?" If you are upgrading from Version 4.1, the identity
verification questions and the questions you used for self-service password reset appear as
a questionnaire in the Manage Questions dialog box.

Important: When creating and editing user configurations, do not enable backward
compatibility if you have a new installation of Single sign-on because that limits plug-in
software functionality to Versions 4.0 and 4.1 of the product. Conversely, do not disable
backward compatibility mode if agent software from Version 4.0 or 4.1 is running because
that prevents users from performing key recovery and self-service password reset
registrations.

If you are using automatic key management, do not enable backward compatibility.
Automatic key recovery does not require users to answer identity verification questions.

For Versions 4.0 and 4.1 backward compatibility, the questionnaire must include at least
one security question associated with the Account Self-Service password reset feature.

Each security question must include the following settings:

• Case sensitivity disabled.

• Minimum answer length set to one.

• Questions cannot be enabled for key recovery.



198

To check for backward compatibility

You can check for backward compatibility if you are upgrading from a previous version of
Single sign-on/Password Manager:

1. Click Start > All Programs > Citrix > Management Consoles > Citrix Delivery Services
Console.

2. Expand the Single sign-on node, expand Identity Verification, and select the
Question-Based Authentication node.

3. From the Action menu, click Manage Questions.

4. Select Question-Based Authentication.

5. Select Perform backwards compatibility check and click OK.

Single sign-on performs the backward compatibility check and displays any errors in a dialog
box.
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Allowing Users to Reregister Answers to
Their Security Questions

Single sign-on allows your users to reregister answers to their security questions at any time
without intervention of an administrator.

If your environment includes security questions or account self-service features, users who
register security questions and answers can use the plug-in software to provide new answers
to their available security questions.

Users can select Security Questions Registration from the Tools menu in Logon Manager or
from the shortcut menu associated with the notification icon for the plug-in software.
Selecting this option starts the Security Questions Registration wizard where users can
reregister answers to their security questions. After users successfully provide their answers
and receive confirmation that the new answers are saved to the central store, their old
answers are no longer valid.

This feature is available only to users connecting to Single sign-on using the current version
plug-in software and who previously registered answers to their security questions.
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Allowing Users to Manage Their Primary
Credentials with Account Self-Service

You can configure the self-service features of Single sign-on to allow your users to reset
their primary password or unlock their Windows domain accounts without intervention by
administrative or help desk staff. Depending on your needs, you can implement the
self-service password reset and account unlock features securely in your Single sign-on
environment.

Note: To implement Account Self-Service with Citrix Web Interface, see Web Interface.
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Overview of Self-Service

The Self-Service Module features are protected by question-based authentication, which
ensures that your users are authorized to reset their passwords or unlock their accounts.
During the first-time use of the Single sign-on plug-in software or first-time use after the
Account Self-Service function is configured, users must register answers to security
questions you create and select during Single sign-on setup.

These security questions are then presented to users when they need to reset their
password or unlock their account. When the questions are answered correctly, users are
allowed to reset their password or unlock their account, avoiding the need to call the help
desk or administrator.

Important: The self-service password reset and account unlock features require that you
implement question-based authentication. Users must register answers to security
questions to use these features. If you choose not to use question-based authentication in
your Single sign-on environment, the self-service password reset and account unlock
features are not available to your users.

Factors to consider:

• You can implement the features of the Self-Service Module to allow your users to reset
their primary (domain account) password or unlock their Windows domain accounts in
an Active Directory environment only.

• When users change their application password by using the Single sign-on plug-in
software or primary password by using the CTRL+ALT+DEL key combination on a device
in which the plug-in software is installed, Single sign-on automatically captures the
password change.

• To prevent user lockout, do not combine the self-service password reset with the
Prompt user to enter the previous password option for confirming users’ identities
exclusively. When the previous password is the only method available to your users,
users who forget their previous primary password are locked out of the system. Their
user data must be reset or deleted from the central store and from all user devices on
which it is stored, and they must reenter their credentials for all of their applications.
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Using Automatic Key Management with
Self-Service

Combining automatic key management with self-service provides greater ease-of-use to
users needing access to password-protected applications handled by the Single sign-on
plug-in software. For example, if users reset their primary passwords, they do not need to
answer security questions after successfully resetting their passwords. (However, they do
need to answer security questions during the self-service password reset process.)

With automatic key management, users do not have to verify their identities after
unlocking their accounts or resetting their domain passwords.
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Summary of Self-Service Implementation
Tasks

To use Account Self-Service functionality, perform the following steps:

1. Install the Self-Service Module and the Key Management Module.

2. Configure your question-based authentication.

3. Create a user configuration with one or both of the self-service password reset or
account unlock features enabled.

4. Install and configure the plug-in software.
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To reset self-service user registration

If users are locked out of their Windows account and cannot remember the answers to their
security questions, you must use the Single sign-on component of the Delivery Services
Console to reset self-service registration for users. After you reset users, the Self-Service
Registration wizard appears the next time the users open the plug-on software. Your users
can then register answers to their security questions.

1. Click Start > All Programs > Citrix > Management Consoles > Citrix Delivery Services
Console.

2. Expand the Single sign-on node, expand the Identity Verification node and select
Question Based Authentication.

3. In the Action menu, click Other Tasks > Revoke security question registration for a user.

4. In the Select User dialog box, type the user or user group name.
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User Experience

After the service and plug-in software are installed and configured, the Self-Service Module
modifies the user’s Windows logon dialog box and the Unlock Computer dialog box, or the
Welcome screen for Windows Vista. Windows 7, Windows Server 2008, and Windows Server
2008 R2 users, (available when users lock their computers with the CTRL-ALT-DELETE key
combination) by including an Account Self-Service button.

Before users can access the self-service features, they must log on to their primary domain
account and register answers to security features. After successfully enrolling, they can use
the self-service password reset and account unlock features.

With automatic key management, users do not have to verify their identities after
unlocking their accounts or resetting their domain passwords.
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Using Provisioning to Automate
Credential Entry

Use the Provisioning Module (also known as credential provisioning) to manipulate user
credentials associated with applications defined in a user configuration. Provisioning
enables you to automate these procedures and apply them to multiple users. For example,
you can use credential provisioning to eliminate the need for first-time plug-in software
users to perform initial credential setup. If you plan to deploy new software to your users,
create an application definition for the application and use credential provisioning to add
the credentials for all users who will use the application.
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Summary of Provisioning Tasks

To manipulate credential information in your central store for SSO-enabled applications
contained in user configurations, you must perform the following tasks:

1. Install the Provisioning Module of the Single sign-on Service.

2. Create a user configuration that uses the provisioning service.

3. Generate a credential provisioning template.

4. Populate the template with user credential data and select a command to run.

5. Process your provisioning data.

Important: The XML file you use to provision credentials contains highly sensitive
user-related information. Consider deleting the file or moving it to a secure location
when credential provisioning is completed.

After the credentials are added, removed, or modified in the central store, the credentials
are ready for use in your environment. When users start the plug-in software, the
credentials updated in the plug-in software and applications are made available to your
users. First-time users of the plug-in software do not need to perform initial credential
setup if you added all credential information to the central store by the process of
credential provisioning.

Adding, changing, or removing credentials from the central store can consume a large
amount of system resources. When possible, perform credential provisioning during
off-peak hours.

The Credential Provisioning SDK
If you need to manipulate the credentials of many users, consider using the Credential
Provisioning Software Development Kit (SDK). The SDK provides a description of the APIs
made available when you install the Provisioning Module of the Single sign-on Service. Use
this SDK and included sample code to create your own provisioning client for use with Single
sign-on.
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Generating a Credential Provisioning
Template

The following procedure assumes that you created a user configuration consisting of at least
one of the following: application definition, application group, password policy (perhaps
including an optional password sharing group) and provisioning is enabled in the user
configuration.

A provisioning template is an XML document that contains information about the
applications included in your selected user configuration:

• Application group

• Application definition name and globally unique identifier number (GUID)

• User information like user name and password

It also includes add, remove, and modify commands that you use when you use the edited
template from the console to run provisioning.

To generate a credential provisioning template:

1. Click Start > All Programs > Citrix > Management Consoles > Citrix Delivery Services
Console.

2. Expand the Single Sign-on node and select User Configurations.

3. Select a user configuration.

4. From the Action menu, click Generate Provisioning Template.

5. In the Generate Provisioning Template dialog box, type a name for the template.

The resulting template includes example command information and specific information
about the selected user configuration.
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Editing the Provisioning Template

Use a text editor or XML file editor to edit the generated template. The provisioning
template uses SPML (Service Provisioning Markup Language), an XML-based standard for
data interchange. As with XML, ensure that each SPML tag or element (for example, the
<add> tag) is well-formed and conforms to XML syntax rules. For example, when removing
comment characters such as !-- and --, ensure that you remove any extraneous angle
bracket characters (< or >) or errors might result during processing of the provisioning
template. For detailed information about XML, see the W3C Web site at
http://www.w3.org/. Ensure that you remove comment characters (!-- and --) where
applicable.

Example Output
The generated template includes the following:

• <user> information about the user who generated the template

• <add> command for the application name in the user configuration

• <modify> command with the application definition name

Near the bottom of the XML file is the specific information about the selected user
configuration that you can copy and use in your template. For example:

<user fqdn=“DOMAIN\Fred-Admin”>
<!--Application Group: PNA-->
<!--Application Definition: Citrix GoToMeeting-->

<!--<add>
    <application name=“Citrix GoToMeeting”>0998ac2c-baa5-4103-809a-b2daeea047f3</application>
    <name>Citrix GoToMeeting</name>
    <description>Citrix GoToMeeting Login</description>
    <hidden-description>Citrix GoToMeeting hidden Description</hidden-description>
    <userID>userId</userID>
    <password>password</password>
</add>-->

<!--<modify>
    <credential-id>00000000-0000-0000-0000-000000000000</credential-id>
    <name>Citrix GoToMeeting</name>
    <description>Citrix GoToMeeting Login</description>
    <hidden-description>Citrix GoToMeeting hidden Description</hidden-description>
    <userID>userId</userID>
    <password>password</password>
</modify>-->

</user>

http://www.w3.org/


For example, you can copy the user information between the <user> and </user> tags,
uncomment it, and edit it for each user whose credentials you wish to add.

Note: In the example above, <user fqdn=“DOMAIN\Fred-Admin”> is the domain and
user name of the user who generated the template. You can comment out this
information or delete it if you do not want to store it in the template.

Editing the Provisioning Template
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The cpm-provision Tag

Note that you must include your desired tags and commands within the <cpm-provision>
provisioning tag (located around line 70 in the generated XML file):

<cpm-provision version=“1.0”
xmlns=“http://citrix.com/Provision/Import”>

insert <user> tag and commands here

</cpm-provision>
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The user Tag

Use the <user> tag to add domain and user name information for each user whose
application credentials you wish to provision. You must provide one <user> tag for each user
to be provisioned. Each <user> tag will also contain the commands to execute on this user
account.

The syntax for this command is as follows.

<user fqdn=“yourDomain\usrid”>
    <command>
</user>

where:

yourDomain Indicates the domain name of the user to be added

userid Indicates the username of the user to be added

command Indicates one or more commands that you can execute on this
user:

• <add>

• <modify>

• <delete>

• <remove>

• <reset>

• <list-credentials>
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The add Command

The <add> command enables you to add a user name and password required for the
applications included in the user configuration.

The syntax for this command is as follows.

<add>
    <application name=“%APPNAME%”>%APPGUID%</application>
    <name>    <description>longDescription</description>%CREDENTIALNAME%</name>
    <description>longDescription</description>
    <hidden-description>%APPNAME% hidden description</hidden-description>
    <userID>userid</userID>
    <password>password</password>
    <custom-field index=“1” label=“%LABELTEXT%”>custom-field1 </custom-field>
    <custom-field index=“2” label=“%LABELTEXT%”>custom-field2 </custom-field>
</add>

where:

<application> Required. The <application> element and its attributes are
typically generated automatically when you generate a
template.

The name= attribute is optional.

• %APPNAME% is the name of the application definition in
the selected user configuration.

• %APPGUID% is the GUID of the application and must
match

<name> Required. The <name> element and its attributes are
typically generated automatically.

• %CREDENTIALNAME% is the name of the application in the
application definition.

<description> Optional. Type text that describes the user configuration.

<hidden-description> Optional. Type any text here.

<userID> Required. userid is the user name of the user to be added.

<password> Required. password is the password for the user to be added.

<custom-field> Required if another field is required for authentication (for
example, for a field where the user must enter the domain).
Use as many custom fields as required by the application.
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The modify Command

The <modify> command enables you to modify a user name and password required for the
applications included in the user configuration.

Important: This command requires the user’s credentials. You can retrieve user
credentials by using the <list-credentials> command before using the <modify> command.

Include only those elements you want to modify:

• To leave a value unchanged, delete the line. For example, delete the <name> element
to leave the application name as is.

• To change a value, specify the value in the template. For example, include the <name>
element to specify a new application name.

• A value is cleared by including the element without a value. For example, use
<description></description> to delete the current description.

The syntax for this command is as follows.

<modify>
    <credential-id>%CREDENTIAL-ID%</credential-id>
    <name>%CREDENTIALNAME%</name>
    <description>longDescription</description>
    <hidden-description>%APPNAME% hidden description</hidden-description>
    <userID>userid</userID>
    <password>password</password>
    <custom-field index=“1” label=“%LABELTEXT%”>
    custom-field1 </custom-field>
    <custom-field index=“2” label=“%LABELTEXT%”>custom-field2 </custom-field>
</modify>

where:

<credential-id> Required. The credential GUID value %CREDENTIAL-ID% of the
user must match the value returned by a <list-credentials>
command.

<name> Optional. The <name> element and its attributes are typically
generated automatically.

• %CREDENTIALNAME% is the name of the application in the
application definition.

<description> Optional. Type text that describes the user configuration.

<hidden-description> Optional. Type any text here.

<userID> Required. userid is the user name of the user to be modified.

<password> Required. password is the password for the user to be
modified.



<custom-field> Required if another field is required for authentication (for
example, for a field where the user must enter the domain).
Use as many custom fields as required by the application.

The modify Command
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The delete Command

The <delete> command enables you to delete a user’s credentials for a specific
SSO-enabled application.

Important: This command requires the user’s credentials. You can retrieve user
credentials by using the <list-credentials> command before using the <delete> command.

The syntax for this command is as follows.

<user fqdn=“yourDomain\userid”>
    <delete>
        <credential-id>%CREDENTIAL-ID%</credential-id>
    </delete>
</user>

where:

yourDomain Indicates the domain name of the user.

userid Indicates the user name of the user.

<credential-id> Required. The credential GUID value %CREDENTIAL-ID% of the
user must match the value returned by a <list-credentials>
command.
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The remove Command

The <remove> command enables you to remove user data and information from the central
store. Use this command when a user leaves your enterprise permanently. The local
credential store on the user device remains intact until it is explicitly deleted by an
administrator or operator.

The syntax for this command is as follows.

<user fqdn=“yourDomain\userid”>
    <remove />
</user>

where:

yourDomain Indicates the domain name of the user.

userid Indicates the user name of the user.

Note: This command is similar to the Single sign-on Delete user data from central store
task carried out from the Delivery Services Console.
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The reset Command

The <reset> command enables you to reset user information in your central store, which
results in the selected user being returned to an initial state. In the case of non-Active
Directory central stores, the user folders are retained, but all user data (such as
credentials, enrollment questions and answers) is deleted. In Active Directory central
stores, the user data is deleted and the user is flagged as having had data reset.

The syntax for this command is as follows.

<user fqdn=“yourDomain\userid”>
    <reset />
</user>

where:

yourDomain Indicates the domain name of the user.

userid Indicates the user name of the user.

Note: his command is similar to the Single sign-on Reset user data task carried out from
the Delivery Services Console.
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The list-credentials Command

The <list-credentials> command enables you to retrieve a specific user’s credentials for
each application in the associated user configuration. The <modify> and <delete>
commands require that you use the retrieved credential GUID as the value for the
%CREDENTIAL-ID% parameter.

The identification number that this command retrieves is a credential GUID; for example,
634EE015-10C2-4ed2-80F5-75CCA9AA5C11.

The syntax for this command is as follows.

<user fqdn=“yourDomain\userid”>
    <list-credentials />
</user>

where:

yourDomain Indicates the domain name of the user.

userid Indicates the user name of the user.
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To process your provisioning template

Use the Single sign-on component of the Delivery Services Console to perform the
provisioning tasks specified in your XML file. Single sign-on validates the syntax of each
command, executes the commands, and adds or modifies the data in the central store.

Caution: Do not close the provisioning process screen until provisioning has fully stopped
or fully completed. Closing this screen does not halt the provisioning process. If the
screen is closed while the previsioning process is running, there is no way to capture any
information or halt the process until it completes.

1. Click Start > All Programs > Citrix > Management Consoles > Citrix Delivery Services
Console.

2. Expand the Single Sign-on node and expand User Configurations.

3. Select a user configuration or application group of a user configuration.

4. From the Action menu, click Run provisioning. The Provisioning Wizard appears.

5. Click Next.

6. Type the name of your provisioning XML file or click Browse to locate it, then click
Next. Single sign-on validates the XML file.

• If no syntax errors are found, a summary of the changes that can be made is shown.
You can save the summary.

• If syntax or other errors are found, an error log appears. You can save the error log
and click Cancel to close the wizard.

7. If no errors were found, click Next to execute the commands in the file. As the
information is changed in the central store, any errors that occur as a result of
provisioning appear. To stop provisioning while it is in process, click Abort. When Single
sign-on reaches the end of the current section of data in process (by default, data is
processed in groups of 50 lines of code), provisioning terminates.

When you finish the wizard, you can save the provisioning results.
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Tuning Credential Provisioning
Processing

Caution: This procedure requires you to edit the registry. Using Registry Editor
incorrectly can cause serious problems that might require you to reinstall your operating
system. Citrix cannot guarantee that problems resulting from the incorrect use of
Registry Editor can be solved. Use Registry Editor at your own risk. Always back up a copy
of your system registry before continuing

By default, if you use Single sign-on for credential provisioning, your information is
processed in batches of 50 commands with a time-out of 100,000 milliseconds. The
following registry keys can be edited to change these default values:

HKEY_LOCAL_MACHINE\SOFTWARE\Citrix\MetaFrame Password
Manager\Console\Provisioning\BatchSize

Type: DWORD

Default value if left blank: 50

HKEY_LOCAL_MACHINE\SOFTWARE\Citrix\MetaFrame Password
Manager\Console\Provisioning\ServiceTimeout

Type: DWORD

Default value in milliseconds if left blank: 100000
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Hot Desktop: A Shared Desktop
Environment for Users

Hot Desktop combines the convenience of fast user switching with security of single sign-on
capability through Single sign-on. Hot Desktop functionality is not installed by default; you
can select it during the initial Single sign-on plug-in installation process. You can also
upgrade existing Single sign-on plug-in deployments to use Hot Desktop. Before you can
implement Hot Desktop, however, you must configure Hot Desktop according to
requirements in your environment and enterprise.

Hot Desktop is supported only on:

• Microsoft Windows XP Professional, Service Pack 2—32-bit

• Microsoft Windows XP Embedded

It is not supported on 64-bit operating systems or any server operating systems.

Hot Desktop is not available when Single sign-on is deployed through Citrix Receiver.

The Single sign-on Hot Desktop feature allows users to share workstations efficiently and
securely. Hot Desktop extends the standard Windows environment by allowing a user to:

• Quickly authenticate to Windows using the standard GINA interactive logon dialog box

• Run SSO-enabled applications in the interactive user shell by using the user’s Single
sign-on credentials

• Log off from the Hot Desktop workstation so that other users can run applications
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Summary of Hot Desktop Tasks

Before you can implement Hot Desktop you must:

• Create a Hot Desktop shared account

• Create user configurations with specific Hot Desktop-related settings to control the Hot
Desktop user experience

• Define Hot Desktop startup and shutdown behavior, including:

• Deciding which applications are launched at startup, and which applications use Hot
Desktop User or Hot Desktop shared account credentials and permissions

• Deciding which applications are persistent and run even when users log off (for fast
user switching) and which applications terminate when users log off, including your
optional cleanup scripts or applications to delete user information from session to
session

Perform the following tasks to configure and enable Hot Desktop:

1. Create a Hot Desktop shared account that is available for each workstation or client
device running Hot Desktop.

2. Decide which of your SSO-enabled applications should run in the Hot Desktop
environment.

3. Decide how applications run in Hot Desktop and configure the Hot Desktop user
environment.

4. Create or modify a user configuration to select Hot Desktop options.

5. Install the plug-in software with the Hot Desktop feature selected.

6. Uninstall Hot Desktop if necessary.
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Hot Desktop Start Up and Shut Down
Process Flow

This process flow describes the events associated with Hot Desktop startup and shutdown.
When the workstation or client device starts, it is logged on automatically to the shared
account, allowing the device to run in shared desktop mode.

Note: The Hot Desktop shared account remains active at all times. Users do not have the
permissions to terminate the shared account.

1. A Hot Desktop user logs on to the workstation and enters a user name and password or
uses a strong authenticator such as a smart card.

2. When the user is authenticated, the Hot Desktop session starts.

3. Single sign-on launches. The plug-in software synchronizes its data with the central
store. This ensures that the user has the most current application definitions, password
policies, and other plug-in software-related settings.

4. The session.xml file is read and any applications that you specified to run under the
shared account or Hot Desktop User account launch. These applications can be local or
remote applications that are published by XenApp. The user accesses the applications
to perform job-related tasks.

5. The Hot Desktop user logs off.

Note: When users leave a workstation idle, Hot Desktop initiates a session time-out
period. Using the Access Management Console, you specify how long a workstation
can remain inactive. When the interval is exceeded, Hot Desktop locks the
workstation. If additional time passes and the user does not return, Hot Desktop
terminates the session.

6. Hot Desktop leaves applications running or terminates them according to settings in
process.xml.

7. Single sign-on exits.

8. Any shutdown scripts specified in session.xml run.

9. The Hot Desktop session terminates.



225

Troubleshooting Hot Desktop User
Startup

When a user logs on to a computer running Single sign-on configured for Hot Desktop, it is
possible that the startup scripts specified in the session.xml file might run before Single
sign-on plug-in software has fully launched.

During its startup, Hot Desktop waits 30 seconds for the plug-in software to start before it
begins running the startup scripts. After 30 seconds, these startup scripts run, even if the
plug-in software is not yet fully launched.

This situation is most likely to occur during the user's initial logon (also known as first-time
user), where the Single sign-on administrator identified a list of applications requiring logon
credential registration or required answers for security questions. The sequence in this case
is:

1. The user logs on to the computer or client device running the plug-in software and a
prompt appears for the user to register logon credentials for the listed applications or
register answers to security questions.

2. While performing these tasks, the 30 seconds pass and Hot Desktop startup scripts run.
A series of windows might open and close, depending on the applications specified in
the session.xml startup scripts.

3. User frustration might result as the computer keeps moving focus to the startup script
windows.

4. When the startup scripts are completed, an error message appears. The error is similar
to “One or more errors occurred. Please consult the Event log for more information.”

While this behavior might cause user frustration, it does not damage the user's data, work
environment, or Single sign-on.

Advise users not to register their logon credentials and security question answers until the
error message appears. Users can then close the error message and complete the
enrollment and registration process.

Following the error message and registration, if any application specified in session.xml
does not open, advise the user to log off and then log back on to the account. This restarts
any Hot Desktop startup scripts, which run uninterrupted because registration is complete
and not delaying the process.
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Creating a Hot Desktop Shared Account

You must create a Hot Desktop shared account for the client devices or workstations on
which Hot Desktop will run. This shared account can be a domain account or a local account
on the device. When you install Hot Desktop on the client device, you provide credentials
for the shared account. When the device or workstation starts, it is logged on automatically
to the shared account, allowing it to run in the Hot Desktop shared workstation mode.

User sessions run “on top” of the shared account Windows session (users cannot make
changes to the shared account unless you allow them to). Users start a Hot Desktop session
by typing their Windows domain credentials. In a Hot Desktop environment, a user’s
Windows account is referred to as the Hot Desktop User.

Organizing Hot Desktop Users
If you plan to deploy Hot Desktop, you might want to set up your user environment first.
For example, you might group Hot Desktop users under one or more Active Directory
organizational units or groups. Also, you can organize users who are Hot Desktop users and
also use their own workstations into multiple groups (and prioritize these groups).

This enables you to apply Hot Desktop settings, application definitions, password policies,
and other user configuration information to multiple Hot Desktop users in those
organizational units.

Restricting User Rights
Because the Hot Desktop device is shared by all Hot Desktop users, it may be necessary to
restrict permissions and set them to a minimum required to use their assigned applications.
For example, Hot Desktop users should not have the right to shut down the device. Restrict
this right to members of the Administrators group.

Hot Desktop, Smart Cards, and Key Recovery
Note: Select the Smart Card Certificate user configuration Data Protection option if users
use smart cards in the Hot Desktop environment.

If you deploy Hot Desktop in an environment where users log on with smart cards, do not
select Prompt user to enter the previous password as the only key recovery and data
protection method for those users. Users in such an environment cannot enter the correct
previous password and, consequently, are locked out of the system. To avoid this problem,
select the key recovery option for automatic key management or make question-based
authentication available as an option.





















http://support.citrix.com/article/CTX110394

















































































































































































































































































































	Single Sign-on 4.8
	Single Sign-on Installation and Upgrade
	Introducing Citrix Single Sign-on
	Identifying the Four Key Components of Single Sign-on 
	Managing User and Administrative Data with the Central Store
	Managing the User Experience with the Single Sign-on Component of the Delivery Services Console
	Interacting with the User with the Single Sign-on Plug-in
	Providing Additional Features with the Single Sign-on Service

	New Features in Single Sign-on 4.8
	Licensing Requirements
	Single Sign-on in Disconnected Mode
	Managing a Mixed License Type Environment
	To employ available concurrent user licenses to be used offline

	Single Sign-on System Software Requirements
	Single Sign-on Software Requirements
	Setting Security and Accounts Prior to Installing Single Sign-on Service
	Accounts Required to Install and Use Single Sign-on

	Installing the Java Runtime Environment

	Planning Your Single Sign-on Environment
	Identifying the Four Key Components of Single Sign-on 
	Central Store Types
	Choosing an Active Directory Central Store
	Choosing an NTFS Network Share
	Using Account Association with Multiple Central Stores and User Account Credentials in a Multiple Domain Enterprise
	Advantages of Using Account Association

	Password Policies
	Password Policy Considerations 
	Default Settings for the Default and Domain Password Policies

	Types of Applications Supported by Single Sign-on
	Collect Information About Each Application in Advance
	Smart Cards
	Requiring Identity Verification
	Verifying User Identity by Using Security Questions (Question-Based Authentication)
	Recovering or Unlocking User Credentials Automatically

	Planning Your Single Sign-on Plug-in User Configurations
	Enabling the Sharing of the Same Resources or Workstation Among Many Users (Hot Desktop)
	Selecting Optional Single Sign-on Service Features
	Enabling Service Modules: Key Management
	Enabling Service Modules: Data Integrity
	Enabling Service Modules: Provisioning
	Enabling Service Modules: Self-Service
	Enabling Service Modules: Credential Synchronization (Account Association)

	Single Sign-on Plug-in Software Deployment Scenarios
	Planning for Multiple Primary Authentication and User Credential Protection 

	Installing Single Sign-on
	Installation Order
	 Single Sign-on Component Installation Configurations
	To create a central store
	Installing the Single Sign-on Console Component
	 Installing and Configuring the Service Modules
	Installing and Configuring the Single Sign-on Plug-in
	Installation Scenarios
	To install the Single Sign-on plug-in on a local device 

	To configure the service for multidomain use

	Upgrading Single Sign-on to version 4.8

	Single Sign-on Administration
	 Enforcing Password Requirements
	Creating Password Policies
	Helping to Increase Password Strength and Security

	Configuring Single Sign-on to Recognize Applications
	Application Templates
	How Single Sign-on Plug-in Identifies Applications and User Credential Management Events
	Collect Information About Each Application in Advance
	Application Definition Wizard Overview
	Form Definition Wizard Overview
	Defining Windows Type Application Definitions
	Identifying Windows Forms with Advanced Matching
	Windows Type Application Definitions
	Window Identifier
	Identification Extensions
	Defining Action Sequences for Windows Forms Using the Action Editor 
	To define an action sequence 
	Action Descriptions
	Considerations for Windows Type Definitions

	Web Type Application Definitions
	Gathering the Information Required for Web Application Definitions
	Name Form
	Identify Form
	Define Form Actions
	Defining Action Sequences for Web Forms Using the Action Editor 

	Configure Other Settings

	Redirect to Windows Application Configuration
	Advanced Settings Dialog Box for Web Applications
	Terminal Emulator Type Application Definitions
	Form Definition Process
	Name Form
	Identify Form
	Set Field Detection Rules
	Configure Other Settings

	Advanced Settings for Terminal Emulator-Based Applications
	Considerations for Terminal Emulator Type Definitions
	Terminal Emulation Support
	Mfrmlist.ini Field Definitions


	Creating User Configurations
	Default User Configuration Properties
	To specify a domain controller for an existing user configuration
	To create a user configuration
	Choose Applications
	Configure Plug-in Interaction
	Advanced Settings

	Configure Licensing
	Select Data Protection Methods
	Select Secondary Data Protection
	Enable Self-Service Features
	Locate Service Modules
	Synchronizing Credentials by Using Account Association
	Choosing and Configuring a Domain to Host the Credential Synchronization Module
	To configure the credential synchronization features in the host domain
	To manually synchronize application definitions among domains
	To configure Account Association user settings in other domains


	To configure Account Association in the plug-in software

	To reset user data
	To delete user data
	To prompt users to reregister
	To set a user configuration priority
	Assigning a User Configuration to Different Users
	Upgrading Existing User Configurations

	User Authentication and Identity Verification
	Overview of Identity Verification Methods
	If Users Switch among Multiple Primary Authentication Methods

	Managing Question-Based Authentication
	Confirming User Identity Using Question-Based Authentication
	Considerations

	Question-Based Authentication Workflow
	Designing Security Questions: Security Versus Usability
	Managing Your Questions
	To create new security questions
	To set a default language
	To add or edit text for existing questions 
	To add, remove, or change the order of the security questions in the questionnaire
	To create a security question group
	To edit a security question group
	To select one or more question for key recovery
	To enable security answer masking
	To make your questionnaire backward compatible
	To check for backward compatibility

	Allowing Users to Reregister Answers to Their Security Questions

	Allowing Users to Manage Their Primary Credentials with Account Self-Service
	Overview of Self-Service
	Using Automatic Key Management with Self-Service
	Summary of Self-Service Implementation Tasks
	To reset self-service user registration
	User Experience

	Using Provisioning to Automate Credential Entry
	Summary of Provisioning Tasks
	Generating a Credential Provisioning Template
	Editing the Provisioning Template
	The cpm-provision Tag
	The user Tag
	The add Command
	The modify Command
	The delete Command
	The remove Command
	The reset Command
	The list-credentials Command

	To process your provisioning template
	Tuning Credential Provisioning Processing

	Hot Desktop: A Shared Desktop Environment for Users
	Summary of Hot Desktop Tasks
	Hot Desktop Start Up and Shut Down Process Flow
	Troubleshooting Hot Desktop User Startup
	Creating a Hot Desktop Shared Account
	Guidelines for the Hot Desktop Shared Account
	Requirements for Applications Used with Hot Desktop
	Controlling How Applications Behave for Hot Desktop Users
	The Session.xml File
	startup_scripts
	shutdown_scripts
	Launching Applications Using Session.xml

	The Process.xml File
	shellexecute_processes
	persistent_processes
	transient_processes

	User Configuration Settings for Hot Desktop
	To install Hot Desktop
	To uninstall Hot Desktop
	To enable terminal services after you uninstall Hot Desktop
	To enable multiple sessions
	To view Hot Desktop profiles
	To disable AutoAdminLogon Support
	To change the Hot Desktop shared account password
	To shut down a Hot Desktop workstation
	Interacting with Other Citrix Products

	Operations
	Logging Single Sign-on Events
	Mfrmlist.ini File
	Single Sign-on Plug-in Does Not Submit Credentials
	Supporting Terminal Emulators
	To configure emulator support
	Single Sign-on Plug-in Software Does not Start
	Creating a New Signing Certificate
	Signing, Unsigning, Re-signing, and Verifying Data
	Signing Data (-s)
	Re-signing Data (-r)
	Unsigning Data (-u)
	Verifying Data (-v)
	Displaying Help (-h)

	Enabling and Disabling the Data Integrity Service on Single Sign-on Plug-in Software
	Removing Deleted Objects from Your Central Store
	Moving Data to a Different Central Store
	Migrating Data to a New Central Store
	Exporting Application Definitions

	To back up the service
	To restore the service

	Single sign-on 4.8 Settings Reference
	User Configurations
	Basic Plug-in Interaction
	Plug-in User Interface
	Client-Side Interaction
	Synchronization
	Account Association
	Application Support
	Hot Desktop
	Licensing
	Data Protection Methods
	Secondary Data Protection
	Self-Service Features
	Key Management Module
	Provisioning Module

	Application Definitions
	Application Forms
	Application Icon
	Advanced Detection
	Password Expiration

	Password Policies
	Basic Password Rules
	Alphabetic Character Rules
	Numeric Character Rules
	Special Character Rules
	Exclusion Rules
	Password History and Expiration
	Test Password Policy
	Logon Preferences
	Password Change Wizard


	Application Definition Extensions
	Plug-in Software Operation
	Identification Extensions
	To define an identification extension
	Action Extensions
	To define an action extension
	Implementer Requirements
	Enabling Logging


	Virtual Key Codes for Windows, Web and Terminal Emulator-based Applications
	Codes for VTabKeyN (Windows and Web)
	Codes for VirtualKeyCode and VKEY (Windows and Web)
	Virtual Key Codes for HLLAPI-Compliant Terminal Emulators


	Account Self-Service
	Using the Account Self-Service Feature
	Using Licenses
	To create an Account Self-Service-Only user configuration
	Preparing the Computer Running the Plug-in Software 
	To update the Single sign-on ssoShell.exe shortcut
	To add a self-service registration shortcut to the Start menu
	To remove the Single sign-on shortcut
	To remove the Single sign-on plug-in shortcut from the Startup folder


	Single sign-on Provisioning Software Development Kit (SDK) 
	The Provisioning Module
	Provisioning and the Single Sign-on Plug-in
	Provisioning Secondary Credentials
	Application Groups
	Error Codes
	Summary of API Functions
	Provisioning a Single Application - addRequest
	batchRequest - Running a Batch
	Deleting a Credential - deleteRequest
	Deleting a User - deleteRequest
	Querying for Targets - listTargetsRequest
	Obtaining a List of Applications Available to a User - lookupApplicationRequest
	Obtaining a List of Applications for which Credentials are Stored - lookupRequest
	Retrieving Secondary Credentials - lookupRequest
	Modifying a Credential - modifyRequest
	Resetting a User - resetRequest

	Namespace Elements
	Authentication-Token Element - ctxs:authentication-token
	Application Element - ctxs:application
	Credential Element - ctxs:credential




